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Disclaimer 
Dieter Spielberg DMS GmbH makes no representation or warranties with 
respect to the contents or use of this help file and specifically disclaims any 
express or implied warranties of merchantability or fitness for any particular 
purpose. Further, Dieter Spielberg DMS GmbH reserves the right to revise 
this help file and to make changes to its content, at any time, without 
obligation to notify any person or entity of such revisions or changes. 

Further, Dieter Spielberg DMS GmbH makes no representations or 
warranties with respect to any ScanFile software, and specifically disclaims 
any express or implied warranties of merchantability or fitness for any 
particular purpose. Further, Dieter Spielberg DMS GmbH reserves the right 
to make changes to any or all parts of ScanFile software, at any time, without 
obligation to notify any person or entity of such changes. 

Copyright 
© 1999 - 2006 Dieter Spielberg DMS GmbH, All Rights Reserved 

No part of this document may be reproduced, transmitted or stored in any 
form or by any means, electronic or mechanical, for any purpose, without the 
express written permission of Dieter Spielberg DMS GmbH. 
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ScanFile Software License Agreement 
IMPORTANT: Read this agreement before continuing with this installation. 
By pressing the 'Yes, I accept the agreement' button, you are deemed to 
agree to be bound by this agreement. 

This license agreement is a legal document between you and Dieter 
Spielberg Document Management Systems GmbH. By pressing the 'Yes, I 
accept the agreement' button, you are deemed to agree to be bound by the 
terms of this agreement. If you do not agree to the terms of this agreement 
press the 'No, I don't want to continue' button and promptly return the 
software CD and  accompanying documentation (the "Documentation") and 
other items to the place from where you obtained them for a refund before 
they are marked or damaged in any way. 

In consideration of the right to use the Software you agree to abide by the 
terms and conditions of this agreement. 

1. GRANT OF LICENSE. 
The Software consists of the software modules by:- 

a) Dieter Spielberg Document Management Systems GmbH, a German 
public listed company having its place of business at Wanheimer Str.593, 
47249 Duisburg , Germany ("Spielberg"). 

b) Microsoft Corp., a Washington Corporation having its place of business at 
1 Microsoft Way, Redmond, WA 98052-6399, USA ("Microsoft"). 

c) Wise Solutions Inc., a Michigan Corporation having its place of business at 
2200 N. Canton Centre Road,  Suite 150, Canton, MI 48187, USA ("Wise"). 

d) Apex Software Corporation, a Pennsylvania Corporation having its place 
of business at 4516 Henry Street, Pittsburg, PA 15213, USA ("Apex"). 

e) Nuance Communications International BVBA, a belgian Company having 
its place of business at Guldensporenpark 32, 9820 Merelbeke ("Nuance"); 

f) Algo Vision LuraTech GmbH, a german Company having its place of 
business at Helmholtzstr. 2-9, 10587 Berlin ("Lura"); 

g) MICROPLEX Trading GmbH, a german Company having its place of 
business at Leipziger Chaussee 191g, 06112 Halle ("Microplex"). 
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h) Stellent Inc., an Illinois Corporation having its place of business at 330 N. 
Wabash Ave., 15th  Floor, Chicago, IL 60611 ("Stellent"); 

i) Desaware, a California Corporation having its place of business at 1100 
East Hamilton Ave., Suite 4, Campbell, CA 95008 ("Desaware"); 

j) Progress Software Corporation, Crescent Div., a Massachusetts 
Corporation having its place of business at 14 Oak Park, Bedford, MA 11730 
("Crescent") 

k) WIBU SYSTEMS AG, a german Company having its place of business at 
Rüppurrer Straße 52-54, 76137 Karlsruhe ("Wibu") 

l) Innovasys Ltd., an english Company having its place of business at 
Westowe, Chelston Road, Torquay, Devon, UK, TQ2 6PU ("Innovasys") 

You understand and acknowledge that any software module included in the 
Software may have utility with or be able to be called by other software 
and/or hardware, which Spielberg considers to be an unauthorised use of the 
Software. Accordingly, you agree that you will use such software modules 
only as part of the Software and not in conjunction with, or as part of, or as a 
component of other software and/or hardware which makes calls to such 
software modules. 

Spielberg grants you the personal non-exclusive rights: 

a) For a single-user version of the Software, to install and use the Software 
for internal purposes only on a single computer (the Software is considered in 
use when it is installed in the temporary memory, i.e. RAM, or the permanent 
memory, i.e. Hard Disk Drive). 

b) For a multi-user version of the Software, to install and use the Software for 
internal purposes only for the number of computers or simultaneous users 
identified in the Installation Configuration sheet of the Software package (for 
example, if you have purchased a 5-User license you may install the 
Software for simultaneous use by up to 5 Users on a network). 

2. BACKUP COPY. 
a) You may make whatever copies you deem appropriate from the ScanFile 
"delivery" Compact Disc, the Programs, Example Files and any other 
promotional material that may be included thereon. The Application Manual, 
or any part thereof, may be reproduced in sufficient quantity to support only 
the number of users licensed to you and no more. You must reproduce and 
include on the backup copy the copyright notice and other ownership or 
proprietary legends that are on the original copy of the Software. 
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b) You may NOT make any copy whatsoever of the License (Dongle). ANY 
ATTEMPT TO COPY MAY CORRUPT THE ENABLING LICENSE. The 
License (Dongle) represents the full purchase value of the license to use the 
ScanFile Software.  

3. RESTRICTIONS. 
a) You may not market, distribute or transfer the Software or the 
Documentation to others, or electronically transfer the Software from one 
computer to another over a network except as expressly provided herein. 

b) You may not de-compile, reverse engineer, disassemble or otherwise 
reduce the code of the Software to a human perceivable form. 

c) You may not modify, adapt, translate, rent, lease or loan the Software or 
the Documentation or create derivative works based on the Software or the 
Documentation. 

4. OWNERSHIP AND COPYRIGHT. 
Spielberg, Microsoft, Wise, Apex, Nuance, Lura, Microplex, Stellent, 
Desaware, Crescent, Wibu and Innovasys reserve all rights to their 
respective software modules of the Software and the Documentation. The 
Software and the Documentation is copyrighted. Unauthorised copying of the 
Software, including portions thereof, or the Documentation is expressly 
forbidden. 

5. EXPORT CONTROL. 
You agree that the Software and Documentation will not be shipped, 
transferred or exported into any country or used in any manner prohibited by 
the United States Export Administration Act or any other applicable export 
control laws, restrictions or regulations of the countries involved. 

6. SUPPORT AND UPDATE. 
a) Spielberg, Spielberg's subsidiaries or affiliates, their distributors and 
dealers are not responsible for maintaining or helping you to use the 
Software and the Documentation, excepting where agreements have been 
entered into between specific parties, i.e. Spielberg:Distributor, 
Distributor:Dealer, Dealer:End User. 

b) No updates, fixes or support will be made available for the Software and 
Documentation other than by publishing such revisions on the Spielberg web 
site: http://www.spielberg.de or http://www.spielbergsolutions.com 
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c) Any updates, fixes or support will be made available on the said web site 
solely at the discretion of Spielberg, who are under no obligation whatsoever 
so to do. 

7. LIMITED WARRANTY AND DISCLAIMER OF 
INDEMNITY. 
Limited Warranty. The Software is provided "as is" without warranty of any 
kind, either express or implied, including, but not limited to implied warranties 
of merchantability and fitness for a particular purpose. The entire risk as to 
quality and performance of the Software is with you. Should the Software 
prove defective you (and not Spielberg, Spielberg's affiliates, their distributors 
or dealers) assume the entire cost of all necessary servicing, repair or 
correction. Some states or jurisdictions no not allow the exclusion of implied 
warranties, so the above exclusion may not apply to you. This warranty gives 
you specific legal rights and you may also have other rights which vary 
according to state or jurisdiction. 

Spielberg, Spielberg's affiliates, their distributors and dealers do not warrant 
that the functions contained in the Software will meet your requirements or 
that the operation of the Software will meet your requirements or that the 
operation of the Software will be uninterrupted or error free. 

However, Spielberg or Spielberg's affiliates warrants a compact disc or 
diskette on which the Software is stored to be free from defects in materials 
and workmanship under normal use for a period of ninety (90) days from the 
date you purchased the same, as evidenced by a receipt or otherwise. Some 
states or jurisdictions do not allow limitations on duration of an implied 
warranty, so the above limitation may not apply to you. 

CUSTOMER REMEDIES 

Spielberg's entire liability and your exclusive remedy shall be the 
replacement of the Compact Disc and/or Diskette not meeting the LIMITED 
WARRANTY and which is returned to Spielberg or Spielberg's marketing 
affiliate, Spielberg Solutions Ltd., with a copy of your receipt or otherwise. 
The LIMITED WARRANTY is void if failure of the Compact Disc has resulted 
from accident, abuse or misapplication of the software. 

No liability for consequential damages. In no event shall Spielberg, or 
Spielberg's affiliates, their distributors or dealers be liable for any damages 
whatsoever (including without limitation, direct or indirect damages for 
personal injury, loss of business profits, business interruption, loss of 
business information, or other consequential or incidental damages) arising 
out of the software, the use thereof or inability to use the software even if 
Spielberg, Spielberg's affiliates, their distributors or dealers has been advised 
of the possibility of such damages. Some states or jurisdictions do not allow 
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the exclusion or limitation of liability for consequential or incidental damages, 
so the above limitation may not apply to you. 

Disclaimer of indemnity. Spielberg, Spielberg's affiliates, their distributors and 
dealers shall have no obligation to indemnify you against any claim or suit 
brought to you by a third party alleging that the Software or the use thereof 
infringes any intellectual property of such third party. 

8. TERM. 
This agreement is effective upon pressing the 'Yes, I accept the agreement' 
button and remains in effect until terminated. You may terminate this 
agreement by destroying the Software and any copy thereof. This agreement 
will also terminate if you fail to comply with any of the terms of this 
agreement. In addition to Spielberg enforcing its legal rights, you must then 
promptly destroy the Software and any copy thereof. 

9. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE. 
The Software is provided with Restricted Rights. Use, duplication or 
disclosure by the United States Government is subject to restrictions as set 
forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer 
Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of 
the Commercial Computer Software Restricted Rights at 48 CFR 52.227-19, 
as applicable. The Software is a "commercial item", as that term is defined at 
48 C.F.R. 2.101 (Oct 1995), consisting of "commercial computer software" 
and "commercial computer software documentation", as such terms are used 
in 48 C.F.R. 12.212 (Sept 1995). Consistent with 48 C.F.R. 12.212 and 48 
C.F.R. 227.7202-1 through to 227.7202-4 (June 1995), all U.S. 
Governmental End Users acquire the Software and the Documentation with 
only those rights set forth herein. Manufacturer is Dieter Spielberg, 
Wanheimer Str. 593, 47249 Duisburg, Germany. 

10. ACKNOWLEDGEMENT. 
By selecting the 'Yes, I accept the agreement' option, you acknowledge that 
you have read this agreement, understand it and agree to be bound by its 
terms and conditions. You further agree that this agreement is the complete 
and exclusive statement of agreement between you and Spielberg 
concerning the subject matter hereof, which supersedes any proposals or 
prior agreements, oral or written, and any other communication between you 
and Spielberg relating to the subject matter hereof. No amendment to this 
agreement shall be effective unless signed by a duly authorised 
representative of Spielberg. 
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Should you have any questions concerning this agreement, or if you desire to 
contact Spielberg for any reason, please write to your authorised supplier 
requesting that they pass your correspondence to Dieter Spielberg Document 
Management Systems GmbH or Spielberg Solutions Ltd. 
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Introduction 
Thank you for purchasing ScanFile, the fast, secure and user-friendly 
solution to your document management requirements. ScanFile offers a 
stable and flexible platform for the storage, referencing and retrieval of your 
organisations documents. ScanFile supports a vast range of black and white 
and colour document scanners, and includes several options to make the 
storage of electronic format documents, such as word processing and 
spreadsheet format files a straightforward task, including integration with 
Microsoft Office. 

ScanFile is a multi-user document management system that uses a 
concurrent licensing system, allowing you to maximize your investment in the 
product. 

What is ScanFile? 
The ScanFile solution incorporates three applications: 

• ScanFile 
• ScanFile WebServer 
• ScanFile RemoteStation 
 
ScanFile is the core application and is a full 32bit application that is optimised 
to run on Microsoft Windows ME, NT4, 2000 and XP Professional based 
workstations. ScanFile can also be installed on Novell Netware and Microsoft 
Windows NT4, 2000 and 2003 servers. 

With ScanFile WebServer, you can give anyone, anywhere in the world 
access to your document libraries. ScanFile WebServer is an Internet server 
based application that allows the retrieval of documents using just a web 
browser. Whether you wish to make documents available over the Internet or 
an Intranet, ScanFile WebServer is the fast, secure, reliable and easy way to 
do it. 

ScanFile RemoteStation is a client-server application that allows you to send 
documents to a central ScanFile store from any location. Using TCP/IP 
connectivity, combined with ScanFile security, client workstations can send 
documents to the RemoteStation server, which will then store them to the 
selected ScanFile document folders. In addition, the RemoteStation Client 
can be used for the retrieval from your ScanFile document store. 
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Important – Please Read 
ScanFile, WebServer and RemoteStation cannot be run without a valid 
software license. The license is contained on a hardware dongle. Once 
ScanFile has been installed, it can be started, and will immediately inform 
you that it is not licensed, and will then open the licensing window. 

Upgrades 
ScanFile 2000 and ScanFile 2002 use a software license called Crypkey. 
This license must not be deleted before installing ScanFile. This also applies 
to WebServer and RemoteStation. 

ScanFile Features 
ScanFile is a very straightforward and easy document management system 
to use and manage, but has all the features required for serious document 
management applications. 

• Intuitive user interface 
• Black & white and colour scanner support 
• Import any electronic format document such as MS Word/Excel files 
• Integration with Microsoft Office 97/2000 and XP 
• Comprehensive document referencing and retrieval features with user-

defined index fields, keywords and full text search. 
• Full document display features including zoom, rotate and enhance. View 

multiple documents 
• Inbuilt document viewer that supports over 200 document types including 

MS Office and PDF documents 
• Automatic barcode indexing* 
• COLD data import* 
• TIFFWriter* 
• Zone and Full text OCR* 
• Forms Recognition* 
• Document Routing* 
• Audit Trail* 
• Full network and jukebox support 
 
* Features marked with an asterix are additional purchases to the ScanFile 
core application 
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ScanFile Options 
The basic ScanFile system comes complete with everything you need to 
create folders and scan and import documents into them. The following 
options can be purchased to enhance the functionality of your ScanFile 
document management solution. 

Global Index 
This adds support for Libraries into ScanFile. 

Barcode 
This allows ScanFile to automatically read and index bar-coded documents 

Keywords 
This allows keyword lists to be applied to ScanFile folders and libraries 

Export 
The Export option allows you to export complete folders/libraries to a 
selected drive and directory. All documents will be exported and a data file 
will be created with the index information associated with the documents 

OCR 
The OCR module has two functions. Zone OCR can automatically index 
scanned documents from data contained within the page of a document. Full 
Text OCR creates a searchable word list from scanned documents, allowing 
you to search the contents of documents 

Forms Recognition 
This option enhances the Zone OCR and allows different forms to be 
scanned into the same folder, and by configuring Forms templates, different 
index zones can be applied for each form. 

Please note: The OCR option is also required if Forms Recognition capability 
is required. 

Seite 18 • Welcome to ScanFile 



ScanFile Benutzerhandbuch 
ScanFile Options 

TIFFWriter 
TIFFWriter is a printer driver that allows you to 'print' from any Windows 
application into a ScanFile folder. The 'print' will be converted to TIFF format 

COLD 
This module adds support for importing computer generated spool data, 
which might otherwise be output to Microfiche, or held in printed form 

Auditing 
With the optional Audit feature, every event performed by all users can be 
logged to a central database and then reviewed and printed. The events to 
be viewed can be selected by folder or library, user and within a given date 
range 

Document Routing 
Documents can be assigned to pre-defined routes that will send documents 
to specific users and/or folders for viewing/commenting and approval. Each 
route can have multiple steps and documents can be sent from route to route 

LuraDocument 
The LuraDocument file format compresses image files to a higher degree 
than TIFF or JPEG, whilst preserving the quality of the document 

Kofax 
With the Kofax option, support is added to ScanFile for any scanner which 
works with the Adrenaline Image processing board and ImageControls V3.0 

Virtual Printing (VNP) 
With ScanFile VNP, you can create up to 8 virtual printers which allow to you 
‘print’ documents, which are converted to TIFF format and saved to specified 
directories, and can then be automatically imported into ScanFile folders 
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New in Version 8 

New Appearance 
A modern toolbar was added as alternate appearance of ScanFile. The 
classic look is still available. 

Impersonation 
ScanFile Account enabled ScanFile to use a windows account for 
impersonation. Data secured with that windows account can be protected 
from illegal access. 

Audit Trail Management 
Audit Trail Management offers an export function for Audit Trail data. The 
exported files can be merged in ScanFile to a temporary search database to 
retrieve exported data. 

View User 
ScanFile View User. It is possible to license an amount of users who are only 
allowed to view documents. These users do not block a full user licence and 
their rights cannot be altered. 

User Time Out 
A Time Out User functionality was added to ScanFile. A user licence can be 
set free after a certain timespan to avoid license blocking by a user who 
doesn’t work with ScanFile for a longer time period while being logged in. 

Field property ‚External list’ 
New field property External list. The property allows you to assign index 
fields from an index file to the folder fields in ScanFile. When typing in index 
information, a list will pop up for fast selection and – when possible – the 
index field used will try to complete the entry with the next matching index 
from the external list. 
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Keyword Export 
Keywords can now be exported as additional index field. If a document has 
more than one keyword assigned to, it will be exported as many times as 
keywords are assigned to it. Every time with a different keyword. 

Mandatory Keywords 
Extended Folder setting Mandatory Keywords forces the user to select 
keywords before an index is successfully saved 

Auto Open 
ScanFile Auto Open allows the user to 

• select a folder or library that will be opened automatically right after 
ScanFile startup 

• select a setting that will automatically reopen the folder or library that was 
open before the program was closed 

Copy Index Information 
The functions Move to and Send to ScanFile folder, as well as the field 
property Copy Index, offer extended settings to change the order of the 
index information in the target folder. 

Input assistance 
A thesaurus list can be updated via file import 

Input assistance for Thesaurus linked index fields: a word list generated from 
assigned Thesaurus will pup up below the index field for fast selection 

Input assistance for Date fields: a calendar will pop up below the index field 
for fast selection 

Advanced Email Support 
Email attachments can be displayed in an additional window 
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Windows Service 
Remote Services: have been split into a RS Configuration Tool and a RS Service 
(true windows service) 
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Operating Systems 
ScanFile is designed to run as a full or client installation on the following 
operating systems: 

• Microsoft Windows ME 
• Microsoft Windows NT4 Workstation 
• Microsoft Windows 2000 Professional 
• Microsoft Windows XP Professional 
• Microsoft Windows 2003 Server 
 
As a network installation ScanFile can be installed on the following server 
operating systems: 

• Microsoft Windows NT4 Server 
• Microsoft Windows 2000 Server 
• Microsoft Windows 2003 Server 
 
Additionally, ScanFile can be installed onto Novell systems with restrained 
capabilities (no Remote Services).  

Service Packs 

Please ensure that you keep your operating system up to date with the latest 
service packs. 

Server 
ScanFile is not a client server application and therefore it normally uses only 
storage resources on a server. All important application files are located on a 
server and shared by all ScanFile clients. The server itself – as long no client 
installation is performed – only provides storage resources. 

If the Remote Services are to be run on a server, an additional client 
installation is needed to register all required files on the server. 

ScanFile Requirements 
ScanFile is a 32 bit application designed to require only the least amount of 
resources on server and workstations. The nature of the application requires 
additional storage space to store your documents. In addition the 
specification of a ScanFile workstation has to meet the requirements of every 
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day use, attached scanners, type of scanning you are performing and the 
type of documents you work with. 

Hard Disk Space 
A full installation of ScanFile will require around 100 Megabytes of hard disk 
space. This will decrease to less than 10 Megabytes if a Client install is 
performed. The majority of the Client install consists of common Windows 
components that may already be installed on the workstation. In this case the 
Client install may take up only an additional 5 Megabyte of disk space. 

Additional to the storage space that is needed for the application itself, 
sufficient storage space is needed for your documents. Please ensure that 
you have the correct amount and type of storage for your documents. The 
storage used may be a mix of hard disk space and CD’s, DVD’s and optical 
disk, either using single drives or jukeboxes. 

The amount of storage you might need is the result of a combination of 
factors, such as 

• Are the documents completed or are they still being updated? 
• How many existing documents? 
• What is the average document size on disk? 
• How many documents are created within a period? 
• At what document age does the retrieval rate decrease? 
• Is there a retrieval time requirement? 
• How many retrievals are required per hour/day? 
• How many different applications does a customer have? 
• What index information is used? 
 
Taking these factors into account you can approximate the amount of storage 
space for a given period and put in place your on-line and off-line storage. 

You need to ensure that whatever method of storage is used, adequate and 
regular backups are taken.  

RAM 
Typically, the ScanFile program itself requires between 30 and 60 Megabytes 
of RAM to run. This is dependant upon what operations are being performed 
within ScanFile. When viewing a document, the amount of memory used will 
increase by the requirements of the document and can differ greatly. 

When viewing a scanned or imported image, the compressed file is read from 
disk and then uncompressed into the workstations memory. For a black & 
white A4 document scanned at 300dpi, the uncompressed size will be about 
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1 Megabyte. For a 24bit colour A3 document, scanned at 400dpi, the 
uncompressed size will be just under 100 Megabytes. 

Electronic format documents, such as MS Word or Excel are displayed with a 
multi functional viewer within ScanFile and the memory that is required is 
depend on file type and size. 

The specification for a scanning workstation will be broadly similar to that 
required for viewing the documents scanned. The way a scanner works must 
be taken into account as they do vary in the way images are presented to the 
workstation. 

As an example, The Canon DR-3020 scans A4 black & white documents at a 
maximum resolution of 300dpi. The DR-3020 has inbuilt image compression, 
and will therefore typically send over 35-50k of information to the workstation 
for each page scanned. The DR-5080c however, can scan 24bit colour 
documents up to a maximum of A3 at 400dpi. As the DR-5080c has no 
onboard compression, this can mean that up to 98MB of information can be 
sent from the scanner to the workstation for each A3 colour page scanned. 
This must then be compressed and saved to disk. The size of the saved 
image can range from 2k to 100Mb, depending upon the type of image, and 
the compression levels that are used. 

When calculating the amount of memory a workstation should have, the 
requirements of the operating system need to be taken into account. 
Additionally, the amount of memory used by other applications that are 
operating simultaneously need to be considered. 

If there is insufficient RAM in the workstation, the operating system will use 
the hard disk as virtual memory. This will dramatically affect the 
performance of the workstation. 

Seite 26 • System Requirements 



ScanFile Benutzerhandbuch 
Minimum Requirements 

Minimum Requirements 
The following workstation specification is recommended as a minimum 
requirement 

• PC using a 2GHz Pentium 4 Processor 
• 256 MB RAM 
• 17‘‘ Display 
• CD-ROM Drive 
• 100 MB Hard Disk Drive 
• MS Windows 2000 Professional 

Dongle 
ScanFile products are protected from illegal use by utilising a hardware 
dongle. The dongle can be supplied as a USB device or one that attaches to 
the workstation or servers parallel printer port. The parallel port must be set 
to ECP. 
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Overview 
ScanFile can be installed as a standalone system or on a network file server. 
Please read the installation instructions carefully before installing to ensure 
that you fully understand what will be installed, and what needs to be 
prepared prior to installation. 

ScanFile is a networkable program, in that each workstation on a network will 
run ScanFile, and can share common data. The workstations will load 
ScanFile from a common directory on a network server drive. This has the 
advantage of making ScanFile easier to maintain when updates become 
available. 

The installation procedure will be dependent upon which network operating 
system, the server ScanFile is to be installed to, is running. ScanFile can be 
installed on to Microsoft Windows 2000 and 2003 servers and Novell 
Netware servers. Additionally, a workstation running Microsoft Windows 2000 
or XP Professional can be used as a small workgroup server serving up to 
ten connections. 

Important 

Please do NOT attach the dongle to the workstation before installing 
ScanFile for the first time. The Installation program will install the dongle 
device drivers and utility software. 

 

Upgrades 

If you are upgrading from ScanFile 2000 or ScanFile 2002 you must not 
uninstall or delete your previous installation or transfer out the existing 
ScanFile license . 
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Standalone Installation 
To install ScanFile, select Run from the Start Menu and then choose 
SetupSF.exe from the Software directory on the ScanFile CD. 

Location 
After you have chosen the language, you will be asked to choose the drive 
and directory that ScanFile will be installed into. A default of 
C:\Programs\ScanFile will be offered and this should normally be accepted. 

The Destination directory selection dialogue will also display the available 
disk space on the chosen drive, as well as the space available after ScanFile 
has been installed. Once you have chosen the drive and directory, press the 
Next button. 

Backup 
You will then be asked whether the install program should backup any files 
that the ScanFile installation process will replace. These can be older 
versions of ScanFile components - if you are installing over an existing 
installation - and common Windows components. If you choose to backup 
these components, you will be offered to create a Backup folder in the 
previously selected installation location. 

Please note that the ScanFile Installation process will only replace older 
versions of common Windows components. 

Components 
The next step is to choose the ScanFile components to be installed. The core 
ScanFile program will be installed automatically, but you must select the 
additional options individually. Please note that if you have not purchased the 
TIFFWriter, OCR or the Virtual printing option, ScanFile VNP, these will not 
function. 
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Option/Module Description 

MS-Office Integration This option will add Send to ScanFile and Print 
and Send to ScanFile options into Microsoft Office 
2000 or XP. The Version Microsoft Office 97 only 
supports Word and Excel. 

To use the Microsoft Office Integration a Version of 
Microsoft Office must be installed. 

ScanFile CD This facility allows you to create data CDs, which 
have retrieval software copied to the CD. This 
allows retrieval of document from the CDs using any 
PC. 

ScanFile TIFFWriter This option installs a special printer driver, which 
allows you to print documents from any windows 
application as TIFF G4 or JPEG files directly into a 
selected ScanFile folder. 

ScanFile OCR This option offers two facilities. Documents can be 
automatically indexed by the Zone OCR function. 
Additionally, Full Text OCR can be performed 
allowing you to search the documents for specific 
text. 

Extensions Currently the Extension consist of an Exception 
Report utility. This can check the existence of 
numbers of a defined range in a ScanFile folder. A 
log will be created reporting missing numbers and 
numbers that are present several times. 

ASPI Layer This option will install the latest release of Adaptec's 
ASPI drivers for their range of SCSI cards. This will 
be required if you intend to perform scanning on the 
workstation using a scanner attached to a SCSI 
card. 

ScanFile VNP With ScanFile VNP, you can create up to 8 virtual 
network printers which allow to you ‘print’ 
documents, which are converted to TIFF format and 
saved to specified directories, and can then be 
automatically imported into ScanFile folders. 
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If TIFFWriter was selected to be installed, and the operating system on the 
PC is Microsoft Windows NT4, you will be asked to insert the NT4 CD. 
ScanFile needs to install files that are on the NT4 disc. 

Personal Hitlist 
You will then be asked to select the directory to be used to store the User 
Personal Hitlist files. The default value will be a directory called Data which 
will be created in the ScanFile program directory. Once the directory is 
selected, press the Next button. ScanFile will now be ready to be installed. 

Licensing 
Once the ScanFile installation is complete, the dongle can be attached to the 
workstation, and then licensed. Please see the Licensing chapter for 
instructions on how to do this. 

Microsoft Server 
ScanFile can be installed onto Microsoft Windows NT4, 2000 and 2003 
servers. Please ensure that the server operating system has been updated 
with the latest Service releases prior to installing ScanFile. 

The ScanFile installation must be performed directly on to the server, not 
from a workstation, as Windows services will be installed. 

Installation 
To install ScanFile to the server select Run from the Start Menu and then 
choose SetupSF.exe from the Software directory on the ScanFile CD. 
Before pressing the OK button, add the switch /U to the end of SetupSF.exe. 
Please ensure that the switch is entered in uppercase: 

<CD-ROM Drive>\Software\SetupSF.exe /U 

The first step is to choose the language that you wish ScanFile to be in. 
Choose the desired language and press OK. 

Location 
After you have chosen the language, you will be asked to choose the drive 
and directory that ScanFile will be installed into. A default of 
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C:\SFNet\ScanFile will be offered, this can be changed to the server location 
you wish to install ScanFile to. Once you have chosen the drive and 
directory, press the Next button. 

When installing to a server drive, ScanFile should be installed to a server 
Applications directory (e.g. SFNET), not to the root of a server drive. The 
Applications directory is subsequently shared for client use. This is so that 
when a server location is mapped by a client, the ScanFile program 
directory is not the root of the mapped drive. 

Backup 
You will then be asked whether the install program should backup any files 
that the ScanFile installation process will replace. These can be older 
versions of ScanFile components - if you are installing over an existing 
installation - and common Windows components. If you choose to backup 
these components, you will be offered to create a Backup folder in the 
previously selected installation location. 

Please note that the ScanFile Installation process will only replace older 
versions of common Windows components. 

Personal Hitlist 
You will then be asked to select the directory to be used to store the User 
Personal Hitlist files. The default value will be a directory called Data which 
will be created in the ScanFile program directory. Once the directory is 
selected, press the Next button. ScanFile will now be ready to be installed. 

Licensing 
Once the ScanFile server installation is complete, the dongle can be attached 
to the Server. The Wibu-Key Server service must then be started. This can 
be done manually, or it will be done automatically when the Server is 
rebooted. If you wish to activate the dongle from the server directly, you must 
perform a Client installation to install the required files. Please see the 
Licensing chapter for instructions on how to activate the dongle. 

After this the server installation is complete and you can go on to install the 
ScanFile clients. 

If you wish to use the Remote Services a client installation has to be 
performed on the server to install the necessary components. 
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Novell Netware Servers 
ScanFile can be installed on to a Netware server, but unlike Microsoft server 
operating systems, it cannot be run on the server. In addition, the Remote 
Services are unable to run on Netware servers, although they can be 
configured to run on a client. The installation must be performed from a 
network client running Windows 98, Me, NT4, 2000 or XP. 

Please also note that the license dongle cannot be activated on the Novell 
server. This can be performed on a client workstation after the server and 
client installation. Once the dongle has been activated, it can be attached to 
the Novell server. 

From a network client with Supervisor rights on the Netware server, select 
Run from the Start Menu and then choose SetupSF.exe from the Software 
directory on the ScanFile CD. Before pressing the OK button, add the 
switches /U /NOVELL to the end of SetupSF.exe. Please ensure that the 
switches are typed in uppercase: 

<CD-ROM Drive>\Software\SetupSF.exe /U /NOVELL 

The first step is to choose the language that you wish ScanFile to be in. 
Choose the desired language and press OK. 

Location 
After you have chosen the language, you will be asked to choose the drive 
and directory that ScanFile will be installed into. A default of 
C:\SFNet\ScanFile will be offered, this can be changed to the server location 
you wish to install ScanFile to. Once you have chosen the drive and 
directory, press the Next button. 

When installing to a server drive, ScanFile should be installed to a server 
Applications directory (e.g. SFNET), not to the root of a server drive. The 
Applications directory is subsequently shared for client use. This is so that 
when a server location is mapped by a client, the ScanFile program 
directory is not the root of the mapped drive. 

Backup 
You will then be asked whether the install program should backup any files 
that the ScanFile installation process will replace. These can be older 
versions of ScanFile components - if you are installing over an existing 
installation - and common Windows components. If you choose to backup 
these components, you will be offered to create a Backup folder in the 
previously selected installation location. 
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Personal Hitlist 
You will then be asked to select the directory to be used to store the User 
Personal Hitlist files. The default value will be a directory called Data which 
will be created in the ScanFile program directory. Once the directory is 
selected, press the Next button. ScanFile will now be ready to be installed. 

Dongle License Files 
Once the installation has completed, you must edit the file WibuNov.ini, 
which is in the Dongle directory, located off the ScanFile program directory. 
This file is used by the dongle NLM when controlling the ScanFile licensing. 

WibuNov.ini contains references to the location of four license files which 
the dongle NLM interacts with. The four Files are: 

These files in the same directory as the WibuNov.ini, the Dongle directory, 
located off the ScanFile program directory. Open WibuNov.ini in a text editor 
and look for the following sections: 

[WkLAN] 
IpPort=22347 
 
[WKNet 818:1000] 
serverFile<ScanFile-Folder>\Dongle\WKNetSF.dat 
RefreshTime=10 
TimeOut=30 
Selection=1234 
 
[WKNet 818:2000] 
serverFile=<ScanFile-Folder>\Dongle\WKNetTic.dat 
RefreshTime=10 
TimeOut=30 
Selection=1234 
 
[WKNet 818:3000] 
serverFile=<ScanFile-Folder>\Dongle\WKNetSWS.dat 
RefreshTime=10 
TimeOut=30 
Selection=1234 
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[WKNet 818:4000] 
serverFile=<ScanFile-Folder>\Dongle\WKNetSRS.dat 
RefreshTime=10 
TimeOut=30 
Selection=1234 

 
The serverFile parameter within each section needs to contain the path to 
the relevant application file. The value of the parameter needs to contain the 
Novell Volume name, and directory name. For example, If ScanFile has been 
installed into a directory called ScanFile, within the Apps directory on the 
SYS volume, then the path would be as follows: 

SYS:\Apps\ScanFile\Dongle\<Filename> 

The section for ScanFile would therefore be changed, as shown below: 

[WKNet 818:1000] 
serverFile=SYS:\Apps\ScanFile\dongle\WKNetSF.dat 
RefreshTime=10 
TimeOut=30 
Selection=1234 

 
Once you have changed the serverFile values in all four sections, you can 
save and close the WibuNov.ini file. 

Dongle NLM 
For ScanFile to be able to find the dongle once it has been activated, the 
dongle Netware Loadable Module (NLM) needs to be loaded. The Dongle 
cannot be activated from the Novell Server, this must be done at a Client, 
before attaching it to the server and starting the NLM. Please see the chapter 
Licensing on how to activate the dongle. 

Before loading the NLM copy it from the Dongle directory into the System 
directory on the Novell server. You can then load the NLM at the Novell 
server Console by typing LOAD WKSVNW.NLM followed by the complete 
path to WibuNov.ini as the parameter: 

LOAD WKSVNW.NLM SYS:APPS\SCANFILE\DONGLE\WIBUNOV.INI 

This should also be add to the servers Autoexec.ncf, so that it will 
automatically load if the server has to be rebooted. 

The Installation will now be complete, and Clients will be able to run 
ScanFile. 
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Network Client Installation 
To perform a Network Client Installation select Run from the Start Menu and 
then choose SetupSF.exe from the ScanFile server installation directory. 
Before pressing the OK button, add the switch /N to the end of SetupSF.exe. 
Please ensure that the switch is entered in uppercase: 

<ScanFile directory on the server>\Software\SetupSF.exe /N 

The first step is to choose the language that you wish ScanFile to be in. 
Choose the desired language and press OK. 

Components 
The next step is to choose the ScanFile components to be installed. The core 
ScanFile program will be installed automatically, but you must select the 
additional options individually. Please note that if you have not purchased the 
TIFFWriter, OCR or the Virtual printing option, ScanFile VNP, these will not 
function. 

Option/Module Description 

MS-Office Integration This option will add Send to ScanFile and Print 
and Send to ScanFile options into Microsoft Office 
2000 or XP. The Version Microsoft Office 97 only 
supports Word and Excel. 

To use the Microsoft Office Integration a Version of 
Microsoft Office must be installed. 

ScanFile CD This facility allows you to create data CDs, which 
have retrieval software copied to the CD. This 
allows retrieval of document from the CDs using any 
PC. 

ScanFile TIFFWriter This option installs a special printer driver, which 
allows you to print documents from any windows 
application as TIFF G4 or JPEG files directly into a 
selected ScanFile folder. 

ScanFile OCR This option offers two facilities. Documents can be 
automatically indexed by the Zone OCR function. 
Additionally, Full Text OCR can be performed 
allowing you to search the documents for specific 
text. 
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Extensions Currently the Extension consist of an Exception 
Report utility. This can check the existence of 
numbers of a defined range in a ScanFile folder. A 
log will be created reporting missing numbers and 
numbers that are present several times. 

ASPI Layer This option will install the latest release of Adaptec's 
ASPI drivers for their range of SCSI cards. This will 
be required if you intend to perform scanning on the 
workstation using a scanner attached to a SCSI 
card. 

ScanFile VNP With ScanFile VNP, you can create up to 8 virtual 
network printers which allow to you ‘print’ 
documents, which are converted to TIFF format and 
saved to specified directories, and can then be 
automatically imported into ScanFile folders. 

 

If TIFFWriter was selected to be installed, and the operating system on the 
PC is Microsoft Windows NT4, you will be asked to insert the NT4 CD. 
ScanFile needs to install files that are on the NT4 disc. 

Personal Hitlist 
You will then be asked to select the directory to be used to store the User 
Personal Hitlist files. The default value will be a directory called Data which 
will be created in the ScanFile program directory. Once the directory is 
selected, press the Next button. ScanFile will now be ready to be installed. 

Remote Service 
The Remote Service is available after a Standalone or Client/Server 
installation on the same machine. The service is not started automatically 
when the installation has finished. If you want to use the functionalities of the 
Remote Service, please go to chapter ‘Remote Services’ for further 
information about setting up and starting of the service. 

Removing ScanFile 
ScanFile can be removed from a workstation or server by selecting ScanFile 
in the Add/Remove Programs option in the Control Panel. 
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If you installed a ScanFile Client and a ScanFile Server on one machine, the 
de-installation from above will only remove the Client. To de-install the 
Server, go to Start -> Run and enter <ScanFile Folder>\Unwise.exe 
<ScanFile Folder>\ScanFile_uninstall.log. 

When ScanFile is installed, whether on a server, or on a networked PC as a 
client, an installation log is either created or updated in the ScanFile program 
directory. This details exactly which elements of ScanFile and common 
Windows components have been installed, as well as any Windows Registry 
entries that have been updated or created. The uninstall program uses the 
information in this file to remove only the elements that were added when 
ScanFile was installed. It is very important that this file is never deleted. 

The ScanFile uninstall program will not delete the following: 

• Folders 
• Libraries 
• User database 
• Audit databases 
• Document routing databases 
• COLD Template database 
• OCR and Forms Recognition template databases 
• Personal Hitlist folders 
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Summary 

Installation Type 
Standalone   SetupSF.exe 
Microsoft Server   SetupSF.exe /U 
Novell Server   SetupSF.exe /U /NOVELL 
Client    SetupSF.exe /N 

Install Location 
Standalone Installation  C:\Programs\ScanFile 
Server Installation  C:\SFNet\ ScanFile 

Backup Location 
For installation rollback 

Components 
Office Integration   MS Office 97, 2000, XP & 2003 
ScanFile CD   CD Folder Retrieval Application 
TIFFWriter   Print to ScanFile Folder 
OCR    Zone, Full Text & Forms Recognition 
Extensions   Exception Report 
ASPI Layer   For Adaptec SCSI cards 
ScanFile VNP   Print to specified Locations 

Personal Hitlist 
Private document store for each user. Used for sending documents to users, 
and by the Document Routing option. 

Remote Service 
Is available after a Standalone or Client/Server installation and has to be 
configured. Please see the Remote Services chapter for more information. 

Installing ScanFile • Seite 41 



ScanFile Benutzerhandbuch 
Summary 

Removing ScanFile 
Always use Control Panel – Add/Remove Programs 
Client and Server on one machine, go to Start -> Run and enter <ScanFile 
Folder>\Unwise.exe <ScanFile Folder>\ScanFile_uninstall.log. 

Removing ScanFile does not delete data 
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Overview 
This chapter describes the necessary steps to license ScanFile. The 
licensing system is a hardware dongle you received with the program. This 
dongle is normally delivered in an unlicensed state, and must be activated 
before ScanFile can be run. 

If you have WebServer and/or RemoteStation in addition to ScanFile, the 
licensing for these is held on same dongle as for ScanFile. When installing 
these applications, you will be asked for the ScanFile application path, and 
from this, WebServer and RemoteStation Server will be able to find the 
dongle 

What is the Serial Number? 
The serial number is needed to identify the dongle. The number is engraved 
on the hardware dongle and is needed to download the license key via the 
Internet. 

No new update request is needed, if you mistype your serial number when 
you try to collect a dongle activation key via the Internet. 

What is the Pick Up Code? 
When a ScanFile system is purchased, or when an update to an existing 
installation has been purchased, a Pick Up code is needed. This code in 
conjunction with the serial number is used to license the hardware dongle. A 
Pick Up code will be issued after you ordered a new license or a license 
update. 

How is the license controlled? 
The way the licensing is controlled will depend upon which operating system 
the server or workstation is using. When ScanFile is installed, a directory 
called Dongle will be created in the ScanFile program directory, holding 
various dongle configuration and information files  

Please note that TCP/IP is the only protocol supported by the dongle, when 
used in a network environment. 

Windows NT4, 2000 and 2003 

When a ScanFile Server installation is performed on Windows NT4, Windows 
2000 or Windows 2003 servers, the service WIBU-KEY Server will be 
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installed, and configured to start automatically. Without this service, Clients 
will not be able to find the ScanFile dongle. 

For standalone installations, no service is installed or required. 

Novel Netware 

The Netware Loadable Module (NLM) WKSVNW.NLM that is supplied with 
ScanFile and copied to the Dongle directory during installation must be 
loaded on the Netware server. This can be copied to the Netware SYSTEM 
directory.  

Without this NLM loaded, ScanFile will not find the dongle! 

Licensing 
When ScanFile is installed and then run for the first time, it will report that it is 
not licensed, and will then open the License Manager. When opened after 
the first installation, the License Manager will only show the dongle serial 
number. 

This can also be run from the License Manager option in the ScanFile 
program group whenever you are updating the license. 
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A
p

The dongle can be ac oft Windows server or workstation 
o
i tivated when connected to a Microsoft 
Windows workstation, after a ScanFile Client install has been performed. 

There are two methods of activating the ScanFile Dongle via the Internet 
using the License Manager when purchasing a new ScanFile system, or 
u ither you update your dongle 
directly via the Internet or you just download a license file. In both cases the 
License Manager is used. 

les you to activate the ScanFile Dongle will have 

fter a successful update or if your dongle is already activated, all licensed 
rograms and options will be displayed. 

tivated on a Micros
nce a ScanFile client has been installed. For Novell NetWare server 

nstallations, the dongle can only be ac

pgrading an existing ScanFile installation. E

A Pick up Code which enab
been issued when ScanFile was purchased, and this allows you to collect the 
license. Please ensure that the Dongle is attached to the server or 
workstation that you are using, and then run the ScanFile License Manager. 

After the start of the License Manager a password is required unless the 
user login has been switched off. A user needs ScanFile administrator 
rights to be able to update the license. 

If you start ScanFile for the first time and haven’t setup any users yet enter 
the default ScanFile user login: 

User name: admin 
Password: admin 
 
Please note: the password is case sensitive! 

Internet Licensing 
If you have started the License Manager you can start a license update via 
the internet by clicking on the button Internet License. For this option to 
work the server or workstation you started the License Manager on must 

ternet License option, you will be asked to enter the 
Pick Up Code that you have been supplied with. 

have Internet access. 

After selecting the In
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Once you have entered this and pressed OK, the License manager will 
connect and verify the dongle and pickup code. A confirmation screen will be 

 these are 
r

, 
and the programs and program options will be listed. The License Manager 

a  
disk and then uploaded to the ScanFile Li  
le en be returned, which can be loaded, and the dongle activated.  

displayed showing your details and the options purchased. If
co rect, press the Activate button to license the dongle. 

Once activated, the License Manager will return to the main License Screen

can then be closed. 

Save to / Load from File 
If n Internet connection is not available, a dongle status file can be saved to

cense site, and a dongle activation
will thfi

After starting the Licence Manager, click to Save to file. You will be asked to 
enter the Pick-Up code you have been supplied together with your company 
details .A screen appears, where the Pick-Up code and the contact details 
should be entered: 
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Once you have entered this and pressed OK, the License manager will open 
a window, allowing you to save your license file. The name of the file is your 
serial number, the file extension is .dsc. 

• Transfer the .dsc file to a workstation that has internet access 
• go to the following site using your internet browser: 

www.scanfile.com/dongle  
• Enter or browse to the path where you saved the .dsc file and then click 

on OK. 
• An activation file with the extension .dsl will then be returned to you. 

Select the Save option and then browse to the location where you wish to 

he .dsl file, Highlight the file and then click 
OK. 

save the file 
• Transfer the .dsl file to the workstation connected to the dongle 
• .In License Manager, select the Load from File option and then browse to 

the location where you saved t

 
Now the License Manager updates the dongle with the latest license 
information. Once activated, the License Manager will return to the main 
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License Screen, and the programs and program options will be listed. The 
License Manager can then be closed. 

Upgrades 
I
v
d rior to licensing your ScanFile dongle. 

When you attempt to license your ScanFile dongle, the License Manager will 
search for your existing Crypkey License, and if this is not found, the license 
attempt will fail. In addition, the Crypkey license serial number will be 
validated against the dongle upgrade information, and if these do not match, 
the dongle licensing will fail. 

If the License Manager finds the Crypkey license, the dongle will then be 
activated, and the Crypkey license will be deleted, and your previous 
installation removed. 

A running ScanFile 2003 installation has to be completely uninstalled before 
installing ScanFile V8. The license is updated with the Pick-Up code after 
installing ScanFile V8. 

Dongle Applet 
When a Server or Client installation is performed, a dongle applet will be 
added to the Windows Control Panel. This can be used to check that the 
dongle can be found by the workstation or server, and can also be used to 
direct ScanFile to use a dongle attached to a specific server or workstation. 

To start the applet open the Windows Control Panel, and select the Wibu-
Key applet, and the following screen will be displayed. 

f you are upgrading from ScanFile 2000 or ScanFile 2002 to ScanFile, it is 
ery important that your existing ScanFile installation is NOT uninstalled, 
eleted or the license transferred out p
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Selecting the Scan option on the default Wibu-BOX Content Tab will scan 
the workstation or the network for dongles, depending upon whether My 
Computer or Network is selected. This enables you to confirm that the 
workstation is finding the dongle. 

You can force ScanFile to only look for a dongle on a specific workstation or 
server by selecting the Network tab and entering the Computer Name or IP 
address of the dongle server in the Server Search List. In the example below, 
ScanFile will use the dongle attached to release-server. 
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Please note: 

On a server in a network installation the WIBU KEY Subsystem “Local” 
should be switched off. Otherwise the server could approach the dongle via 
local drivers and block the network clients. In this case the network clients 
could report “No valid license file”. 
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T
y
y

Starting ScanFile 
 process a ScanFile program group is created in the 
y selecting Programs -> ScanFile –> ScanFile. The 

verview 
his section describes the first steps after the installation of ScanFile. It leads 
our through the first start-up of ScanFile, the licensing process and informs 
ou about important general settings. 

During the installation
start. Start ScanFile b
login dialog of ScanFile is displayed on the screen. 

 

Enter your user name and password in order to continue. The first time you 
start ScanFile login as the pre-installed user admin, password admin. With 
this pre-installed user you can enter all necessary settings and have full 
access to every licensed option. 

Login at first start: 
 
User name: admin 
Password: admin 
 
The password entry is case sensitive! 

The user admin has all rights within ScanFile. Therefore the pre-installed 
password should be changed after the first start, in order to prevent 
unauthorized access. 
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ScanFile Main Screen 
After logging in successfully, the main window will be displayed. If you 
haven’t licensed ScanFile yet, the License Manager will open automatically. 
Please see the Licensing chapteron how to activate your ScanFile dongle 

 

This window will have a standard Windows Menu bar and Toolbars for quick 
access to the applications functions. 

When running ScanFile for the first time, default settings should be applied to 
enable the application to know what input device to use, and where you want 
to store the documents. A short description how to apply these settings 
follows.  

Search Drives 
Before folders and libraries can be created, search drives for ScanFile to 
work on have to be defined. Selecting Choose search drives from the File 
menu allows you to specify the locations which can be anywhere on the 
workstation, mapped drives or UNC paths. Within the Search Drives window, 
a list of drives and paths that have been added will be displayed. When 
ScanFile is first started, the Search Drives selection screen will be 
automatically displayed, and will list the available drives on the workstation. 
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The list of search d
a user does not ha

rives is stored centrally and shared with all workstations. If 
ve rights to access certain paths defined, then those paths 

ighlight it on 

S

 from the File Menu, and select the appropriate scanner. 
Then select Scanner Settings from the Options menu to apply default 
settings for the selected scanner. These can be for scan resolution, paper 

anning, brightness, contrast etc.  

A full description of the options for all scanners is given in the 

will appear empty. 

To add a storage location to the list, press the + button on the top right of the 
display. A window will then be displayed where you can select the drive or 
UNC path that you want to add. To remove a storage location, h
the list and press the – button on the top left of the display. 

canner Selection & Setup 
Before any scanning can be done, the scanner must be selected. Select 
Choose Scanner

size, single/double-sided sc

Scanner 
Setup chapter. 

The scanner settings are saved for every single user and folder. Please 
note: by selecting Options -> Scanner Settings the settings for the opened 
folder are changed. If no folder is open, the scanner settings are saved as a 
default for the logged in user. This default will be copied into every new 
folder that is created by the logged in user. 

Next Steps 
Before you can store any documents to ScanFile you must first create 
ScanFile folders to store the documents in your selected locations. Creating 
folders is fully described in the Folders chapter. Once you have created a 
folder and stored your documents the searching and viewing options are 
described in the chapter named Searching & Viewing. 

Please also read the General Settings chapter, as this describes the options 
available that will affect how the ScanFile main screen, ScanFile folders and 
libraries will be displayed as well as affecting the actions of keyword 
searches and the display of hit lists. Many other settings influencing the 
behaviour of ScanFile are described in that chapter, too. 

It is very important that you read and understand the General Settings 
chapter to ensure that you get the best from your ScanFile solution. 
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Folders • Seite 57 



ScanFile Benutzerhandbuch 
Overview 

Overview 

hold the images, but also the indexing 
information and annotations associated with the images. If using the optional 

 the OCR full text tables are also held in the folder. 

. When creating a 
folder, you can give it a name of up to 32 characters, and specify up to ten 

um length of 255 characters per field. Field functions can 
e fields providing rapid automatic indexing during scanning 

Create Folder 

All documents either scanned or imported into ScanFile will be held in 
ScanFile Folders. Folders not only 

OCR module,

Folders can be created on any rewriteable media available to the PC as a 
drive reference. This includes network drives. It is always a good idea to 
have separate drives for storing folders and for programs

fields with a maxim
be applied to thes
or post-indexing. 

To create a folder, select Setup Folders from the File menu, and the Folder 
configuration will be displayed. 

 

From the Setup folders screen, a folder can be created or modified. First of 
all, you must choose which drive or UNC path the folder is to be created in, 
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and you can then give the folder a name. You can also specify a capacity for 
the folder. In this example, it has been set for 600Mb for a CD. 

O
a
u for 
various other media types. An unlimited option is also available for network 
Drive or RAID arrays. 

der can have up to 10 
d Field properties and 

Field Properties 
Each field can be set with a property value, depending upon the entry 

that field. The available properties are listed below. 

be kept and passed on to all subsequent 
mended. 

The fi nt is automatically incremented by one (digit or character). The 
“ “ option will left fill the field with blanks, the “0” will left fill with 0’s. 

D
The system date will be entered into the field automatically. Please note that 
t t will 

nce this has been reached, no further scanning into the folder will be 
llowed, and you will be prompted to archive the folder to CD’s or DVD. A 
ser-defined capacity can be defined in megabytes, as well as options 

The fields for the folder can then be defined. A fol
fields, with a maximum length of 255 characters, an
Extended Field properties can be applied to them. The field names, lengths 
and functions can be modified at any time without any loss of existing data. 

requirements for 

None 
No auto indexing or field formatting property has been applied. 

Duplicating 
An entry typed into the field will 
records created until the entry is a

Counting 
eld conte

ate 

he date forma be taken from the operating system Short Date Format. 
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Long Date 
The system date will be entered into the 
f  Lon

B
A barcode will be re
The type of barcode

A predefin  synonyms can be applied to a 
field. If the the word will be shown. 

Externa
nal List allows you to connect ScanFile index fields 
file. Later on you will be able to fast index your 

From the Field property combo box, select External list, and then select the 
x information. Then a window is displayed, where 

ber of fields, field separator, field delimiter and the 

 are saved. 

field automatically. This is taken 
g Date Format. rom the system

arcode 
ad from the scanned document and entered into the field. 
 must be set from the options menu. 

Checksums 
These options will check entries for errors via the use of check digits included 
in the value being entered. 

Thesaurus 
ed list of words and their associated

 in synonym is typed  when indexing, 

l List 
The field property Exter
with fields in an index 
documents with index data from this file.  

data file that holds the inde
you have to enter the num
text mode. Click on Read line to read the first line of the file. The index fields 
from the file will be displayed on the left, and the fields from the folder can be 
matched to these. It is very important that the settings are correctly set. Once 
the field assignment has been set up, click on OK and the settings

The folder field that is set to External List will be the connect field for this 
functionality. 

If you open a folder, the connect field will be equipped with a list containing 
data from the index file. If you start to enter characters into the index field, the 
list will appear below the field. Additionally the function tries to complete your 
entry with matching index data from the list. 

You can either select the new index with a double click on the list item or 
confirm the data in the index field with the return key. This will automatically 
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fill all connected folder index fields wit
The list will disappear and the focus wi

h index information from the index file. 
ll be set on the next field. 

If one of the fields in the index file contains no value (““), existing index 
information in the connected index field will remain. If one of the fields in the 
index file contains a blank (“ “), existing index information will be deleted. 

E

 Ext. 

xtended Field Properties 
Extended properties can also be applied to each field, which can dictate what 
is allowed to be entered into a particular field. These properties are 
accessible by selecting the button on the extreme right of the field to 
which you wish to apply them. 

 

Input Mask 
 in the type of character you wish to be typed in for 

Mask box. The character types are 

en typing into 
a field, the cursor will automatically jump over these characters. You can test 

box. 

To set an input mask, type
each of the field character positions in the 
listed. As can be seen in the example above, entering dashes and slashes 
within the mask will force those characters to be in the field. Wh

the format of the input mask within the Test field 
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Duplicate Index Action 
The Duplicate Index Action list offers options that will determine what action 
should be taken if the same index information as an existing record is 

e options are: entered. The availabl

Action Description 

None Duplicate Index Action is disabled 

Append The document/pages will be appended to the existing 
record 

Append with The user will be prompted whether to append the 
prompt document/pages to an existing record. 

Reject The index information will be rejected 

Prepend The document/pages will be inserted at the beginning of 
the existing record 

Prepend with 
prompt 

The user will be prompted whether to insert the 
document/pages at the beginning of the existing record. 

Copy index This option is the same as the field property Duplicate 
Index Action. If you use the Copy Index property in the 
Extended Field Properties you are able to use another 
field property like Barcode for the index field. 

Date Validation 
Validation of a user entered date can be performed by selecting the Check if 
Valid Date option. This will ensure that incorrect dates are not accepted. In 
addition, you can set the format in which the date has to be entered by the 
user by selecting the New Date Format option, and entering the required 
format in the field provided. Some Examples: 

Date   Format 

If this option is selected, an entry must be made into the field when indexing. 

23.06.03  DD.MM.YY 
2003-06-23  YYYY-MM-DD 
06/23/2003  MM/DD/YYYY 

Mandatory Field 
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Field Must be Full 
This option, when selected, will force the user to enter index information in 
the field, to the full length of the field. For example, if the field length is set to 
10, then 10 characters must be entered by the user into the field. 

Right Align 
lues, the contents of the field can be automatically 

right aligned with leading 0's or blanks by selecting the appropriate option. 

A

Job Separation Sheet 

 in the scanner feeder at the same time with the job separation sheets 
placed between them. The files will be automatically divided and records 

n sheet is to be used when batch scanning documents within the 
Folder. 

Import Compression Format 
f ScanFile is support for the LuraDocument compression 

at. 

When entering numeric va

dvanced Settings 

With the optional Forms Recognition enabled, ScanFile can use job 
separation sheets during batch scanning. This enables several files to be 
placed

created in the ScanFile folder. 

From the drop down Job Separation Sheet list, you can select which 
separatio

Please see the Job Separation Sheets chapter for a full description on 
configuring the separation sheets. 

An optional feature o
format. This offers far greater levels of image compression without any 
significant loss of quality, allowing you to store many more documents per 
megabyte than standard compression formats. 

Using this option in Setup Folders, you can set the default image 
compression format to LuraDocument or to TIFF G4/JPEG form

Please see the chapter on LuraDocument for more details. 
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Duplicate Index Action 
This option Execute after Zone OCR reading allows you to assign whether 
the duplicate index action will be executed after a zone OCR. 

Index information 
With the option Clear fields the contents in the index fields within the toolbox 
will be deleted by changing the category in the folders toolbox. 

Document Retention Recording 
Document Retention control is a setting that enables you to perform an action 
on the contents of a folder after an allocated amount of time. This is useful, 
for instance, if you want to clear a backlog of documents from a folder that 
are no longer needed, to save space. 

Thesaurus 
The Thesaurus field property can be used to cut out repetitive indexing, and 
to ensure that index data such as names are typed correctly. A list of words 
can be defined, and multiple synonyms - or short codes - can be set for each 
word. For example the short code 'dsp' can be applied to 'Dieter Spielberg 
DMS GmbH', and when indexing, if 'dsp’ is typed in, it will be replaced with ' 
Dieter Spielberg DMS GmbH '. 
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To create or edit a Thesaurus list, from the Options menu, choose Edit 
layed screen, choose Thesaurus New/Open to 

a new one. The Thesaurus files are 

r the selected word are displayed. 

To add a word, choose Add Word and then type the word. To add a 
synonym for a word, select the word then choose Add Synonym, and then 

hen finished, choose Close and the changes will be 

Thesaurus. On the disp
open an existing Thesaurus, or to create 
given the extension '.THE', so are easily identifiable. 

The words are displayed in the left column, with their associated synonyms in 
the right column. Only the synonyms fo

type the synonym. W
automatically saved. 

The same Thesaurus can be applied to as many folders as you wish. They 
are not specific to a folder. 

Thesaurus Import 
A new button was added to the Thesaurus window: Import Thesaurus. This 
function allows you to automatically fill or extend a Thesaurus file. 

Folders • Seite 65 



ScanFile Benutzerhandbuch 
Keywords 

After clicking on Import Thesaurus, you are asked to select a file containing 
update information. Then following window is displayed: 

 

Enter field separator, field delimiter and text mode and click on Start Import. 
The file will be imported. The first field of a line will be considered to be a 
word, all following fields will be interpreted as synonyms belonging to the 
word. 

in a ScanFile Thesaurus, it will be created. All 

Close  an open folder, the new entries 

Keywords 

s multiple keywords to be attached to a 
particular document. To attac
K
y

To create a keyword list, or to edit an existing one, choose Edit keyword 

If a word is not found 
synonyms belonging to this word will be added, as long as they are not 
already in use. Synonyms have to be unique, so double entries are not 
allowed. 

After a successful import you can return to the Thesaurus window by clicking 
on . If you opened the Thesaurus from
will be immediately at your disposal. 

A predefined list of keywords can be created and assigned to a folder. This is 
an extra level of indexing, and allow

h a keyword list to a folder, click on the 
eyword List button in the Setup Folders dialogue, and then select the list 
ou wish to apply. All keyword lists have the extension '.KEY'. 

lists from the Options menu. 
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Click on the New/open list button to open or create a keyword list. To add 
words to a list, click on the Add Word button, and type in the words you wish 
to enter. 

To make words visible/invisible, click on the column headed Visible next to 
the word, and either a red cross or a green tick will be displayed. If a keyword 
is not visible it will not be displayed when the folder is opened. 

Once you have finished, click the Close button, and the changes will be 
saved. 

Working with folders 
To open a folder, go to the File menu and select Open Folder. Only one 
folder can be open at any one time. From the displayed screen, you can 
select the drive the folder is on, and then select the folder you wish to open. 
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Whenever a folder is open the folder toolbox will be available, allowing you to 
access the majority of functions that need to be carried out within a folder 

ng and searching. such as scanning, indexing and editi

 

The structure of the folders to nd may 

Toolbox – Scan 
e available if the Scan option is selected in the folder 

age files, select manual or 
d to rows throu

olbox depends on the folders setup a
vary from the picture above. 

The following tools will b
toolbox. These allow you to scan single or multi-p
auto feed, an  b e gh the current file. 
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Toolbox – Search 
This selection allows you to specify the required search criteria for 

rch. This will result in a list of the files found documents, and perform a sea
being displayed. 

 

Toolbox – Edit 
From this the indexing information for a document can be changed. You can 
also amend the document itself by inserting, appending, revising and deleting 
pages. 

 

Toolbox – Postindex 
Post-indexing allows you to scan documents that are to be indexed at a later 
date. The images scanned are stored in a separate area of the folder, and 
are not divided into files. When going through the post-index pool, the images 
can be separated into files by using the available tools. They can also be 
appended to existing files. 
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Keyword Display 
If a keyword list has been assigned to a folder various options as to how and 
whether the keywords are displayed are available. 

In the Keywords Search Mode of the General Settings screen, the 
keyword list preferences can be set. 

You can choose not to display the keyword list at all by selecting Hide 
Keyword list. The Display keywords as Text option will display the 
keywords in a column format, but if this is not selected, the keywords will be 
displayed in a cell format. 

You can also choose whether, when doing a multiple keyword search, the 
records displayed will show records that have keyword 1 AND keyword 2, or 
that have keyword 1 OR keyword 2. 

To select multiple keywords when either indexing or searching, hold down 
the CTRL key when clicking on the words you wish to select. 

Document Retention Recording 
Document Retention control is a setting that enables you to perform an action 
on the contents of a folder after an allocated amount of time. This is useful, 
for instance, if you want to clear a backlog of documents from a folder that 
are no longer needed, to save space.  

This action can only be performed on folders created in version 6.0.0 or 
later of ScanFile. 

Setup 
Once a folder has been setup to activate the recording of the Document 
retention information you must select Document retention from the Options 
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menu and click on the Activate checkbox. You are then required to select a 
time you wish to start recording the retention information for that record, here 
you have four options: 

Setting Description 

Document Open 
Date 

Set by the user 

Document Close 
Date 

Set by the user 

Last Addition Date Set pages were last added to the Document. 

Last Retrieval Date Recorded from when the Document  was last retrieved.

 

Once you have selected the time at which the Retention Recording will start 
you must select how long the data will be held for, this is done by monthly 
periods. 

 to export, destroy or 
Finally you must select what action you wish to be performed once the 
Retention Time has expired, here you have a choice
move the documents. 
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F
or all documents held in a ScanFile system. 

l tain the index data associated with those documents. 

o ication 
32 Characters 
10 Maximum 

 32 Characters 

Thesaurus   1 per Field 

 Clears the index information within the folders 
Toolbox when changing the category 

uler Adds a folder to the Document Retention 
Scheduler 

Duplicating   Field retains previously entered value 
 Puts leading blanks in front of numeric values 
 Puts leading 0's in front of numeric values 

records 
Mod 2    Customer checksum 
Mod 10.1    Customer checksum 
Mod 11.1    Customer checksum 
Mod 11.2    Customer checksum 
Verify 11    Customer checksum 
ISBN    Customer checksum 

olders Summary 
Folders are the storage location f
Fo der can also con

F lder Specif
Folder Name   

 Fields   
Field Name  
Field Length   255 Characters Maximum 
Keyword List   1 per Folder 

Extended Settings 
Compression Format  TIFF/JPeg or LuraDocument 
Job Separation Sheet  None/Job Separation Sheet/Named Sheet 
Duplicate Index Action  Sets the action for duplicate index information 
Clear Fields 

Retention Control Sched

Field Properties 
None    No Property 

Counting " "  
Counting "0"  
Date    Current Date 
Long Date    Current date in format eg. '07 October  2003' 
Barcode    Accept barcode value while scanning 
Thesaurus   Assign Thesaurus to field 
Copy Index  Duplicates index information of existing 
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External List  Reads index information from an external file 
for fast indexing 

Extended Properties 
Mask    Only accept input in pre-defined format 
Duplicate Index   Allow/Not allow Duplicate index 
Check Valid Date  Checks entry for valid date & specified format 
Mandatory Field   Field must contain data 
Must be Full  Field must contain data to maximum field 

length 
Right Align 0's   Sets leading 0's in front of numeric values 
Right Align " "'s   Sets leading blanks in front of numeric values 
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Editing Documents 
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Editing Documents 
There are several options that allow you to change a document after it has 
been scanned. These are: 

• Append Pages 
• Insert Pages 
• Delete Pages 
• Revise Pages 
• Split File 
• Change the Page Order 
• Save Rotation 
 
The first four options are available in the Folder Toolbox from the Edit option. 

Append Pages 
Once you have selected the file you want to append to on the Hitlist, choose 
the Edit option in the Folder Toolbox, and press the append icon. The pages 
to be appended will then be scanned. After all the pages have been scanned, 
you will be prompted to save the pages, continue scanning, or to abandon 
the append 

Inserting Pages 
To insert pages into an existing file, select the file on the Hitlist, then go to the 
page that you want to insert pages before. Click on the Insert pages icon in 
the Edit option of the Folder Toolbox. Once the feeder is empty, you will be 
prompted to save or discard the pages just scanned. 

Delete Pages 
There are several choices when deleting pages from a document. First of all, 
display the page at which you wish to start deleting, and then select the 
Delete icon from the Folders Toolbox. You will then be prompted on what 
you want to delete. Select the appropriate option and the file will be updated. 
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Revise Pages 
An original document can be revised by clicking on the Revise Pages button 
in the Folder toolbox Edit menu. This will scan in an amended copy of the 

o browse through the revised and original pages. 

Split File 
This option enables you to break apart a single file in to two files with 
identical index information. To do this, select the file you wish to break apart 
from the Hitlist, and then display the page of the file that you wish to become 
the first page of the second file. Select Split File from the Edit menu. After 
confirming that you wish to proceed, a second file will be created. If required, 
you can then edit the index information of the files to reflect the changes. 

Change Page Order 
Once a document has been scanned, you may find that you wish to change 
the position of a page within the file. This can be achieved in one of two 
ways. 

Image Display Menu 

While displaying the page of the file that you wish to move, pressing the right 
mouse button in the image display window will show the right click menu. 

By choosing Change Image Position you will then be prompted to enter the 
number of the page you wish to move the currently displayed page to. 

document and allow you t
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FastPics Drag & Drop 

Within the FastPics window, by holding down the left mouse button on the 
g that page to the 

on for. You can then choose to 
set the rotation for the displayed page, all pages of the record, or all selected 
records. 

page of the document you wish to move, and then draggin
position within the file you wish to move the page to, the page will be moved 
and the file reordered. 

Save Rotation 
The orientation that a scanned image will be displayed can be set and saved 
so that it will always be displayed in the chosen orientation.  

To do this, set the currently displayed image to the rotation you wish to save 
and from the View menu, select Save rotati

The image rotation setting is saved in the Folder database, and does not 
affect the original scanned image. 

Annotations 
These can be used to mark or highlight part of a page that is of particular 
interest. The annotations are specific to the page on which they are created. 
Different annotations can be added to different pages within the same 
document. The annotation types are: 

• Text annotation 
• Line 
• Highlight 
• White-out Area 
• Black-Out Area 
 
If a file has annotations attached to pages, this will be signified by a pencil 
symbol in the top-left corner of the image display window. This will also be 
shown in the FastPics. 
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Please note: Annotations cannot be applied to native format documents. 

H
s the 

 
press the e Record tool, or select Hid Options menu. If 
a record has been marked as hidden to V r groups., an X will be 
s the Not
r lect the 

idden Records 
A user within a default security level group of Trustee or above ha
option of hiding records within a folder. Hidden records will not be shown on 
the Hitlist to users within the View security level group. 

To hide a record, highlight the record you wish to hide on the Hitlist, and then
 Hid e Record from the 

iew level use
hown in 
ecord, se

es column of the Hitlist against the record. To unhide a 
record on the Hitlist, and select Hide Record. 
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O

 library is a collection of the indexing information from ScanFile folders. 
ibraries allow you to search across all the folders that have been added to a 

library. 

Due to the construction of a ScanFile library, it is possible to have folders 
with completely different field structures within the same library. However, to 
ensure that you find the documents you want, you would have to make sure 
that a name field, or customer number field, for example, is always in the 
same position within the folder, since the library search is based on index 
field positions rather than index field names. 

Create / Edit Libraries 
Selecting the Setup Libraries option from the Libraries menu will display 
following screen: 

verview 
The Libraries feature is a purchasable option of ScanFile. 

A
L

 

A list of the libraries already created is shown on the left side of the dialogue. 
To create a new library, click on the New Library button, and then type in the 
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name you wish to give the library. You can then choose which folders you 
wish to add to the library. 

First, select the drive reference the folder(s) is on, and then highlight the 
folder name in the top list. To add that folder to the library, click on the Add 
button. 

Prior to pressing the Apply button to add the folders to the library, you can 
choose to select the Automatically Update Library option. With this option 
selected, every time a library is opened, the folders imported into the library 
will be checked for updates. If a folder has been updated, the changes will 
automatically be carried over to the library. 

The Scheduler option is used with the ScanFile Remote Services, which is 
described in the chapter Remote Services.  

Once you have added all the folders to the library, the library will be created 
by clicking on the Apply button, which will show a progress dialogue while 
importing the index information into the library. 

Please note that each drive a folder resides on will be given a media ID, so 
that ScanFile can identify the correct drive for that folder. In the case of CDs, 

 be set automatically, by 
p Libraries dialogue, or 
edia ID's manually, an 

alphanumeric reference can be given. 

Conditional Import 
Conditional Library Import is a feature that allows you to limit and specify 
which documents from a folder you wish to import into a Library. This is 
useful especially if there is information in a folder that you do not want in a 
specific Library. 

To setup a Conditional Import, click on the button of the same name on the 
Library Setup window and the Conditional Import window will be 
displayed. Here you have three options; Field, Condition and Value.  

Under Field you must select which field is to be used as the conditional field 
from the fields available in any of the selected folders. Secondly you must 
select the Condition to be applied; here you are given a number of options: 

each disk will be given an ID. The media IDs can
selecting Auto increment Media IDs on the Setu
can be entered manually. When entering the M

Option Description 

Greater This is used usually for numerical or date fields, should a 
number be entered and any numbers in that field be 
greater, the records will import. 
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Smaller This is us
number be entered and any

ed usually for numerical or date fields, should a 
 numbers in that field be 

smaller, the records will import. 

Equals This can be used for numeric or alphabetic text, should 
any record match exactly what is entered in the value box 
then is will be imported. 

Not Equal This can be used for numeric or alphabetic text, should 
any record not match exactly what is entered in the value 
box then is will be imported 

Greater or 
Equal 

This will typically be used for numeric but can also be used 
for alphabetic text. Should any value entered be Greater 
than or Equal to the number entered then it will be 
imported. 

Smaller or This will typically be us
Equal 

ed for numeric but can also be used 
for alphabetic text. Should any value entered be Smaller 
than or Equal to the number entered then it will be 
imported. 

Like This option is used in conjunction with wildcards. If you 
type the value as part of a word but use a wildcard for the 
rest of it should import all matches E.g. Scan* will import 
Scan, Scanner, ScanFile etc. 

Finally you must enter the value that the condition must adhere to whether it 

to be valid, OR connected only either one of 
the conditions have to be valid. 

allowing 
you to select an index field that is used for access verification. This field has 
to contain the name of the user to connect the logged in user to the 

rary is performed using WebServer. 

hat contains Customer Invoices, and 

be numeric or alphabetic text. 

The Conditional Import can be setup to perform the checks for import on up 
to two fields at the same time. With the option AND or OR you can determine 
the records that are to be imported by the second field should you wish. AND 
selected both conditions have 

User Dependent Search 
If you select the Setup Libraries option from the Libraries menu and click 
on the button User depended search, a window will be displayed, 

document when a search within the lib

As an example, if you have a library t
you wish to make these available to your customers using WebServer, you 
can create a ScanFile user for each customer, with the user name being the 
Customer number. When creating the Invoices Library, you can then set the 
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library filter to the field number that corresponds to the Customer Number 
field. When a customer logs in to the WebServer system using his customer 
number, it is ensured that he can only access the invoices belonging to him. 

Please note that if a user is a member of the Admin user group, the filter will 
not apply, and that user will be able to view all records within the library. 

S

he Library search screen will then be 

earch in Libraries 
Firstly, you must open a library you wish to search in. To do this, select Open 
Library from the Libraries menu, and then choose the library you wish to 
open on the selected search drive. T
displayed: 

 

The number of search fields depends on the field structure of the imported 
folders. The folder with the largest amount of index fields limits the amount of 
search fields. 

Always the he field names of the selected folder will be shown. If a selected 
folder has less index fields than others, the remaining search fields are 
unnamed. But named or not, any of the fields can be used for searching, 
irrespective of the number of fields a folder has, as other folders may have 
more fields. 

The keyword list of a library is a summary of all imported folder keyword lists, 
and can be used to search for documents in the same way as for folders. 
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Selecting Options -> General Settings -> H
displaying of keywords. 

ide Keyword List will turn off 

esults of the search. 

ent, you must double-click on the relevant document on the Hitlist. 

By pressing the Folders button, you can display or hide the names of the 
folders in the library. You can also highlight a folder name, and choose to just 
search within that folder. 

To search, specify the criteria and then press the Search button. A Hitlist will 
then be displayed showing the r

Unlike a folder, when the Hitlist is displayed and the Image Display window 
opened, the first page from the first file will not be shown, because the folder, 
in which this document is stored, may not be on-line. To show the contents of 
the docum

If the document cannot be accessed directly, ScanFile will prompt you to 
enter a medium with a specific Media ID the document is stored on. In this 
case the search drive has to be listed in the search drive list of ScanFile. 

The headings in the Hitlist show the field names of the selected archives. 
Since the possibility exists that folders with different fields are stored in the 
same library the headings of the columns changes, in order to indicate the 
selected document. 
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Overview 
New documents can be scanned into ScanFile via either the Scan mode of 
the folder toolbox, or by the Post-index mode. 

How the indexing information relating to the document will be entered is very 
much dependent upon the type of document being scanned, and how the 

een set for the folder fields. The 
most basic method is to enter the indexing information into the fields in the 

t the keywords required (if applicable) and then start 
a ents have barcodes, if a field has been set for auto 

ments are to be OCR'd, the index information will be 
e lly after the document has been scanned. 

S

Batch Scan will create will create a multi-page document from the pages 
being fed through the scanner. Once the feeder is empty, you will be 

ame file. 
 file for each page scanned. 

t parameters for the scanner prior to 
starting to scan, this must be done from the Scanner Setup screen. 

P
lity lets you scan batches of documents very quickly, and 

then divide them into files and apply indexing information to them at a later 
date. Documents scanned to this 'Pool' are kept in a special work area until 

folder was set up, and what properties have b

folder toolbox, selec
sc nning. If the docum
increment, or if the docu
cr ated automatica

ingle & Batch Scan 
To add documents to your folder by scanning, choose the Scan option from 
the folder toolbox, select either the Batch Scan or the Single Page Scan 
button to start scanning. 

prompted to save the images or to continue scanning into the s
Single Page Scan will create a new

In both modes the Canon DR-3020, DR-5020 and DR5080c can recognise 
and act upon control sheets, allowing you to change between single & double 
sided scanning, text & photo mode, and also for file separation whilst using 
batch scan. The Job Separation Sheets in ScanFile allow the automatic file 
separation independently from the scanner model. This option needs the 
license for Forms Recognition. 

For scanners directly controlled from ScanFile, scanning can be stopped at 
any time by pressing the STOP button, which will appear in place of the Scan 
icons, while scanning is in progress. 

If you wish to change any of the defaul

ostindex Pool  
The Post-index faci
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they are indexed, whereupon they are added to the main index and file 
storage location within the folder. 

To add documents to the Postindex pool, select Post-index from the Folder 
Toolbox, place pages into the scanner feeder, and then select the Scan 

pool will be displayed.  

To keep adding pages to the new file, just keep on pressing the Append 
s displayed. When a new file needs 
 icon again. 

 then press the 
Append page icon. 

Pages icon. 

Once the documents are in the pool, they can be viewed by using the Next 
page & Previous page icons. 

To create a new file, select the page that is the first page of the file, type in 
the indexing information for the file, and then click on the Save Image icon. 
Once you have pressed the Save Image icon, the next page in the Postindex 

page icon for each page of the file that i
to be created, just press the Save Image

The Append page feature of Postindex can also be used to append pages to 
existing files. Via the search option find the file you wish to append to, go to 
the Postindex pool, display the page you want to append, and

Instead of pressing the Append icon you can also press the + key on the 
keyboard to append pages. This will only work if the first field is in overwrite 
mode. Pressing the - key will bring the appended page back into the 
Postindex pool. Pressing CTRL and + will append all remaining images 
from the Post-Index pool. By pressing ALT and + all remaining pages will 
be imported into the folder as single page documents. 

Function Sheets 
The Canon DR-3020 and the Canon DR-5020/80c scanners support the use 

ction sheet (the sheet is not saved in ScanFile), and to 
either stop or continue scanning when the function sheet is detected. 

The use of the function sheets is selected from the scanner setup. 

of two types of function control sheets. The control sheets can be used to 
change the paper size being scanned, as well as changing from single-sided 
to double-sided scanning. 

Batch detection sheets are used to enable several files to be placed in the 
scanner feeder at the same time with the batch detection sheets placed 
between them. The files will be automatically divided and records created in 
the ScanFile folder. With each type of function sheet, you can elect to either 
keep or discard the fun
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Job Separation Sheets 
From ScanFile Release 7.3, the Forms Recognition option adds support for 
Job Separation Sheets while scanning, which enables several files to be 
placed in the scanner feeder at the same time with the job separation sheets 
placed between them. The files will be automatically divided into documents 
and stored in the ScanFile folder. Sheet templates can be assigned to a 
Folder within the Folder setup. 

Job Separation Sheets can be assigned to a folder in the Setup Folder 
window and can be used with any scanner. Further information about 
working with Job Separation Sheets are given in the chapter Job Separation 
Sheets. 
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Overview 
The correct indexing of documents is very important, as you have to rely on 
the index information to search and retrieve your documents later on. The 
more detailed your index information is, the better you will be able to narrow 
down your search results. 

The following indexing options are available: 

exing 
 Indexing 

needs to be installed and licensed. 

Several methods can be used at the same  are 
f d manually cted field properties or 
by a Zone OCR process. 

Manual Indexing 
When indexing pe in the index information. This 
an be done before documents are scanned or saved to the folder from the 
ostindex pool. The index information of documents in the folder can be 

c m 
w e 

ser can continue with the index entry. 

 as the Duplicating field property and applying a thesaurus to a 
field help to cut out repetitive indexing an at index data such as 
nam ed correctly. Please refe  to read more 
a ut these field p

A ndexin
With area indexing, for each field in
display a specific porti particularly useful when 
i  batches exing information in 
the same position. 

• Manual Ind
• Automatic
• Import of index files 
• OCR Indexing 
 
The first three options are standard features that are described later on in this 
chapter. Please refer to the Import chapter to read more about the import of 
index information from an external file. To index documents with Zone OCR 
recognition, the ScanFile OCR option 

time, so that some index fields
ille  as others are filled automatically by sele

 manually, the user has to ty
c
P
hanged at any time. Enter the information into the text boxes and confir
ith Return. ScanFile will automatically jump to the next index field and th

u

Options such
d to ensure th
r to chapter Folderses are typ

bo roperties. 

rea I g 
 the folder, ScanFile can zoom and 

on of the image. This is 
ndexing of similar documents that have the ind
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To do this, first 
turned on within Settings. Then select the first document you 
want to index from the Hitlist, and choose the Edit option on the Folder 

olbox. 

ingly for the next field. Repeat this for all fields. 
When you press the Enter key in the last field, ScanFile will automatically 

A
ScanFile offers various functions to auto fill index fields, depending on the 
index field and folder settings. Which settings are available and what index 

d in the Folders chapter. 

O
ScanFile’s Zone recognition allows you to read area's of a document, and 
place the result of the OCR in to the folder fields. To use this function an 
installed and licensed ScanFile OCR feature is required. How to set up zones 
and/or forms is described in the OCR & Form Recognition chapter. 

Edit Index 
To edit the index information of an existing document, select the document in 
question in the Hitlist and switch to the Edit mode in the Folder Toolbox. The 
index information of the selected document are displayed and can be 
changed. Save changes by clicking on the Change Index button. The index 
information is saved, the Hitlist is updated. Another option is using the 
Return key in the last index field to save index information. The index of the 
document is saved, the Hitlist will be updated, but then ScanFile will jump to 
the next document on the Hitlist and display first image and index information 
of the new document. 

you must ensure that the Area/PostIndexing feature is 
the General 

to

Place the cursor in the first field, and then zoom and move the image within 
the image display window until the information relevant to the index field is 
being displayed. Type this information into the index field, and press Enter. 
The cursor will automatically move to the next field, and you can then zoom 
and move the image accord

move to the first field of the next record in the Hitlist, and display the area of 
the image relevant to that field. 

utomatic Indexing 

contents they generate can be foun

CR Indexing 
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O
 

S

presented, as well as the 
keywords if used. Just enter your search criteria, and pressing the Search 
button will produce a list of all the documents that matched the search 

e, the first document in the matching list will be 

verview 
Searching for documents within ScanFile is a straightforward and easy task. 
The standard document search tools in ScanFile are comprehensive, 
allowing you to perform range searches with AND/OR properties on more 
information than just the user-defined index fields created within a folder. 

earch 
The primary search screen is available from the Folder toolbox Search 
option, where the fields within the folder are 

criteria. At the same tim
displayed. 

Wildcard Description 

* Denotes a string of any length (even 0) 

? Denotes any single character 

[x,y,z] enotes one character , x or y or z ( [list of characters] ) D

[1-5] Denotes 
be smaller than the second) 

a single character of 1,2,3,4 or 5 (first character must 

 

With wildcards, there is no distinction between uppercase and lowercase. 

 
Examples: 

Wildcard Description 

* Puts all records into the Hitlist 

????? Shows all records with 5 characters in the field selected 

1* Show
100-1

s all records beginning with 1, for example: 1, 11-19, 
99 s.o. 

M??le Shows records with Mable, Mowle etc 
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M*le Show e, 
Module etc. 

s records with Mable , Mayle, Mole, Mowle, Mul

 

U  combi
minimum and targets d
criteria can be combine
logical AND combined, e 
and AND or an OR search. 

Once the search has been performed it will return a Hitlist of the results of 
y h the H lay windows can be sized as 
required. The size of the display on the PC will obviously affect how these 
windows can be shown
indexing information an
the Hitlist. The information shown in the Folder Toolbox will change to reflect 
the record selected. 

Extended Search 
Search option allows the user to find documents using the 

ion, as well as giving a more user-friendly display for range 

se of wildcards ned with other keyword fields reduces the Hitlist to a 
esired records as closely as possible. Several search 
d to narrow down the results. The search entries are 
 apart from keywords, which can be set to produc

our search. Bot itlist and the Image Disp

. The fields within the Folder Toolbox will display the 
d the assigned keywords for the selected record from 

The Extended 
above informat
searches on any field in the folder. 

 

All the user-defined folder fields can have a range search performed upon 
them, as well as the Scan date and Change date fields. When the search is 
performed, the resultant Hitlist can be displayed with or without the additional 
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f
e
scanned on, the name of any user that may have changed that document 
and the date that it was changed on. 

M

 To perform this type of search, select Multiple index 
search from the Search menu. You can then enter the search criteria and 
s
characters, such ‘*’ and ‘?’ can be used in the search criteria. Pressing the 
Search button will then display a Hitlist showing all the documents that 

F
 menu allows you to search the 

word lis g from full text recognition. The search screen will appear 
allowing you to type in the word or words to search for. Searches can include 
m ords 
e

S  to 
in the Hitlist and the pa splayed in the Image window. 

ields, by selecting the View extended Hitlist option. The additions in the 
xtended hitlist show who the document was scanned by, the date it was 

ultiple Index Search 
This feature allows you to search across selected index fields for the 
documents you require.

elect the folder/library fields that you want to search across. Wildcard 

matched the criteria used. 

ull Text Search 
Selecting Full text search from the Search

t resultin

ultiple words, and c
ntered. 

an be set to an AND or an OR search on the w

electing the page view is exactly the same as previously, just highlight it 
ge will be di
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Option Description 

Detailed Hitlist This option, when selected, will show a Hitlist record for 
each page that contains words searched for. 
When not selected, the Hitlist record will correspond to 
the

Ple Detailed Hitlist can take a longer 
period of time to be generated due to each page having 
to 

 the word or 

 file the words were found in. 

ase note that a 

be identified. 

Show number of 
matches 

With this selected, the number of times the word or words 
occur on the page or in the file will be displayed in the 
Hitlist. 

Phonetic Search With the Phonetic Search option words with a similar 
pronunciation to the searched word will be included in the 
search result. 

 

When you select a record on the Hitlist, by single clicking on it with the 

H
The Hitlist, which shows the list of documents that matched the search 
criteria can be altered to show the information in a number of ways. The 

mouse, the document being displayed will automatically change to show the 
selected file. 

itlist 

column width, and the order of the columns within the Hitlist can be 
amended. 
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To alter the column width, move the mouse pointer to the right edge of the 
column, within the column heading, and then hold the left mouse button down 
and drag the column edge to the required width. 

To move a column, hold down the left mouse button anywhere within the 
column heading and then drag the column to the required position. 

You can also select whether the Row Number and/or the Notes columns are 
displayed. This is done from the General Settings Options screen. If from 
this screen you select to save Column Settings, the changes you make will 

H
From the Hitlist menu, several options are available that allow you to alter the 

be saved, and each time you open a Hitlist, those settings will be used. They 
can be changed at any time, with the new settings then being saved. It is also 
possible to set Alternating Row Colours which will display the rows in 
alternate grey and blue lines instead of just grey. 

itlist menu 

display of the Hitlist information, and to also print, export copy and send 
documents. The Hitlist menu is available by pressing the right mouse button 
anywhere within the Hitlist window. The available options are: 

Option Description 

Sort Ascending / 
Descending 

Will s
which

ort the Hitlist by the data in the column over 
 the right mouse button was clicked. 

Print Hitlist Prints the Hitlist record information to the default 
printer 

Export to file Exports the Hitlist record information to a named file 

Copy to Clipboard Copies the Hitlist record information to the Windows 
Clipboard 

Font Select the font and font size the Hitlist will use. 

Move Moves all pages from a record. 

Copy Copies all pages from a record. 

Paste Pastes previously copied or moved pages into the 
selected record. 

Send to… Send selected Hitlist documents to folders, users, e-
mail, route, wallet and export. See below 
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Move to... Moves the selected document into a chosen folder 

Summarise column For Numeric Values: Calculates the total of the 
selected column 

Combine rows Either combines marked records or records with 
same index information. When marked the rows to 
be combined will adopt the index information in the 
row that was first selected by the mouse. 

Delete Deletes selected records and documents 

Filter image(s) Filters selected records 

OCR he selected Performs Full Text or Zone OCR on t
records and also gives option to Copy OCR text to 
the clipboard. 

Select Tool to select documents 

Close Close the Hitlist menu 

Send to… 
T to option fr r 
s ments to s, which are explained below. 

he Send om the Hitlist menu allows you to send a document o
elected docu  a variety of destination

Option Description 

ScanFile Folder Sends selected document(s) to another ScanFile Folder. 

Choose Target Exports selected document(s) and index information. 

User Sends selected document(s) to a user’s Personal Hitlist. 

Route Sends selected document(s) to a pre-defined Route. 

Export to file Exports selected document(s) 

E-Mail Attaches selected document(s) to a new email message 

Wallet Creates a Wallet with the selected document(s). 

EMail Wallet Cre ail ates a new email and attaches the wallet to this em
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When selecting the File or Email option, the images can be saved as PDF 
format documents. This is enabled within General Settings -> Send to 
email. 

Combine rows 
The Combine Rows option on the Hitlist menu either will combine selected 
records within the folder or records with the same index information. When 
marked the rows to be combined will adopt the index information in the row 
that was first selected. 

It is not possible to undo after performing this action. Please use this option 
with caution. 

OCR 
The O from the Hitlist menu allow er Full text OCR, or 
Zone OCR a single document, or selected documents. If you wish to perform 
b l or se the 
options available from the main OCR menu. 

CR Option s you to eith

atch OCR on al new documents added to a folder, please u

Option Description 

Full text recognition ext OCR on selected documents Performs Full T

Zone recognition Performs Zone OCR on Page 1 of selected 
documents 

Copy text Copies the OCR’d text from all pages of the document 
in to the Windows clipboard 

Select Option 
ow keys to scroll 

 the left column of 

When you click on a record on the Hitlist, or use the arr
through the records, the current record will be shown with a dark grey 
background. If you wish to select multiple records, to perform a specific task, 
this can be done in a number of ways. The column at the extreme left of the 
Hitlist is used to select records. 

To select a range of records, press the left mouse button in
the Hitlist next to the first record to be selected, and then, while holding down 
the Shift key, click on the last record in the range. All records in the range 
will be highlighted in yellow. 
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To select specific records, while holding down the CTRL key, click in the left 
column next to each record you wish to select. 

The Hitlist menu Select option can also be used for record selections. 

Option Description 

All Selects all documents in the Hitlist 

Toggle Inverts selection 

Remove Deselects all documents 

Personal Hitlist 
The Personal Hitlist allows a user to build a list of documents that they may 
wish to refer to on a frequent basis, without the need to keep on searching 
folder and/or libraries for them. The Personal Hitlist is totally independent of 
folders, and therefore any document from any folder may be placed in the 
Personal Hitlist 

It is also possible for one user to send a document to another user’s Personal 
Hitlist. The Personal Hitlist can be accessed in one of two ways, by the 
Personal Hitlist option on the File menu, or by clicking on the icon in the 
bottom right of the Hitlist, it you have a folder or library open. To revert to the 
folder/library Hitlist, click on the button next to the Personal Hitlist button in 
the bottom right of the Hitlist. 

 

When you display the Personal Hitlist, the Folder toolbox will be shown, 
allowing you to perform searches within the Personal Hitlist. 

nal 
Hitlist icon. Another method is to right-click on the document and then 

r. A list of all the users will be displayed; choose the 
then click OK. 

ment was added. 

To place a document in the Personal Hitlist, highlight the document in the 
standard Hitlist, hold down the left mouse button, and drag it to the Perso

choose Send To Use
name of the user, and 

From the Send To User, the document can be sent to another user, or to 
your own Personal Hitlist. When the Personal Hitlist is displayed, additional 
fields to the standard Hitlist are shown, which detail the name of the source 
folder, the name of the user who put the document into the Personal Hitlist, 
and the date the docu
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The additional fields shown on a personal Hitlist are From Folder, From 
U ent On. W
row is s
Hitlist. The names of t  documents may have 
c ifferent fo

You can edit the doc  
have any effect to the original docum  
s  the Persona

ocuments placed in a Personal Hitlist will remain until manually deleted, 
unless they are placed there by the Document Routing option, and the user 
selects not to keep a local copy. 

Image Display 
All Documents are shown in the Image Diplay Window. ScanFile has a 
comprehensive set of tools available to change the way displayed images are 
shown. The images can be zoomed, rotated and also fit to the height or width 
of the image window. A file can be paged through by selecting the 
next/previous icons on the toolbar. 

ser and S
hown with a yellow background to

hen the Personal Hitlist is displayed, the Field Name 
 distinguish it from the Standard 

he folder fields are not shown, as
ome from d lders with different fields. 

uments within the Personal Hitlist. The changes do not
ent in the folder. All changes are only

aved in l Hitlist. 

D
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Image Display Menu 
Pressing the right mouse button while in the document display window will 
open the document display menu. This allows you to perform actions on the 
page currently displayed. Several options available are the same as offered 
on the Hitlist menu, but will only apply to the displayed page. Please note that 
these options only apply to scanned documents. 

Option Description 

Image information Show file information about displayed image. 

LuraDocument If the image is in Lura Document Format this will allow 
you to switch between the images layers. 

Print/copy area Select an area on the page and print or copy to 
clipboard. 

Convert to… OCR’s image and converts text to chosen file format. 

Create working 
copy 

Opens a secondary display window with the current 
page 

Fit image Sizes the page to fit within the display window 

Fit width Sizes the page to fit the width of the display window 

1:1 display Maximum zoom level 

Change image 
position 

Reorders the page within the document 

OCR Perform full text or zone OCR on the page, or copy 
the page text to the clipboard 
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Move Moves the displayed image to the clipboard ready to 
paste to another record. 

Copy Copies the displayed image to the clipboard ready to 
paste to another record. 

Send to… Send page to another folder, user, export, email and 
wallet. 

Move to… Moves the selected document into a chosen folder 

Close Closes the document display menu 

Electronic Documents 
ScanFile supports the display of over 200 different electronic document file 
formats, such as Microsoft Office documents, Adobe PDF documents, HTML 
pages and graphic format files, such as AutoCAD and CorelDraw. 

and PowerPoint 
r worksheet to 
g window. For 

Word files and text files, these can be scrolled through 
n the right of the viewing window. 

Electronic Document Display Menu 
The options displayed when you right-click on an electronic document will be 
different to those available when viewing a black & white or colour image. 

When viewing multi-page documents such as PDF files 
presentations, the tools to move from page to page, o
worksheet will be displayed at the bottom of the viewin
documents such as 
using the scroll bar o

Optionen Description 

To the clipboard Copies the selection to the Windows clipboard 

Print Prints the currently displayed document 

Display Selects to display the document in Draft. Normal or 
Preview mode 

Options Settings that affect the copying, display and printing of 
documents 

Launch application Launches the documents associated application 
(if available) 
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Viewing Multiple Documents 

 window showing the 
image currently displayed in the standard display window. 

The secondary display windows are totally independent of the standard 
f the folder, and do not relate to a particular file. It is not 
gh a document from a secondary window. 

Up to three secondary image display windows can be opened in addition to 
the standard image display window. To open a secondary display window, 
right click on the image in the standard display window and choose Create 
Working Copy. This will open a secondary display

display window, and o
possible to page throu

The secondary windows will remain open until they are manually closed, or 
ScanFile is closed. 

 

FastPics 
FastPics are thumbnail representations of the pages within a file that can be 
displayed. The page you then want to view can be selected and shown in the 
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Image window. FastPics will also show whether a page was the front or back 
of a double sided document, and you can also tag pages for printing or 
exporting by clicking when the mouse pointer turns to a tick over the FastPic 
image of the page. 

 

Electronic documents, such as word processing files, will show a page with 
the reference EDOC. COLD information pages will have the word COLD. 

FastPics Menu 
Pressing the right mouse button within the Thumbnail window will open the 
Thumbnail option menu, which allows you to perform actions on the selected 
pages within the document. The options available are the same as offered on 
the Hitlist menu, but will only apply to the pages within the document that 
have been selected. 

Option Description 

OCR Full text or zone recognition can be performed on the 
selected pages. The OCR’d text can also be copied to 
the clipboard 

Move Mark the selected pages for moving to another record 
within the folder 
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Copy Copies the selected pages for pasting to another record 
within the folder 

Send to… Selected pages can be sent to another folder, a user, 
exported, or emailed 

Move to... Moves the selected document into a chosen folder 

Select Selects all or no pages, or inverts the current selection 

Close Close the option menu 
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Overview 
There are several methods for importing and sending documents to ScanFile 
folders. Documents can also be saved in their original format or alternatively 
converted to TIFF format. This chapter describes different methods of 
importing electronic documents into ScanFile folders. 

T
TIFFWriter is a Windows Printer driver that allows you to 'print' any document 
from any Windows application into a ScanFile folder. Each page will be 
analysed by TIFFWriter and will either be processed as a colour or black & 
white page. If a page has ANY colour content, it will be converted to JPEG 

 & white only content will be converted to 

rd options such as 
paper size and orientation single or double sided and resolution can be set. 
Pressin  button of the Print dialogu he Index screen. 

IFFWriter 

format. Pages with black
compressed TIF format.  

TIFFWriter is an option for ScanFile and can be selected for installation 
during the installation process of ScanFile. If the option has not been 
purchased, it will report that it is not licensed. 

To 'print' a document into ScanFile using TIFFWriter, from a Windows 
application, choose the Print option and select the ScanFile TIFFWriter 
printer. From the printer Properties dialogue, the standa

g the OK e will display t
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From this display, you can select which folder you want to put the document 
into. Once you have selected the folder, the folder fields (and keywords if 
assigned to the folder) will be displayed. You can then type index information 
relevant to the document, or you can choos  document into the 
Post Index pool. 

O  indexe
t ex Pool, pr

Collect Mode 
TIFFWriter also has 
documents using TIFF

To activate this featur ted the first document and the 
Index screen has been displayed, press the Collect Mode button. The Index 
display will then change to just show an End Collection button. While this is 
displayed you can print using TIFFWriter from Windows applications without 
having to store each printout at once. 

e to place the

nce you have
he Post Ind

d the document, or selected to put the document into 
essing Save will put the document in the folder. 

a Collect Mode, which allows you to print multiple 
Writer before saving them to ScanFile folders.  

e, once you have prin
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When you have finishe
b d the scree
review the document
Collection button, whi

d printing your documents, press the End Collection 
n will return to the standard Index display. You can 
s held with the collection by pressing the Show 
ch will then open the Collecting pages screen. 

utton, an

 

 the collected documents using the navigation buttons 
review window, and select the document to view from 
t drop down list. 

You can page through
at the bottom of the p
the Jump to documen

Y select to
and pressing the Dele
using the Delete docu ents in the collection will be 
s
P

Explorer Sen
Within Microsoft Win
Windows Explorer pop ->Electronic Document Support 
after the installation of ScanFile. This allows you to highlight files from within 
E n cho

ou can also  delete pages from a document by displaying the page 
te image button, or you can delete a whole document 
ment button. All the docum

aved to one ScanFile
ostindex pool. 

 folder document, or they can be placed in the folder 

d To 
dows, a new option will have been added to the 
-up menu: Send To

xplorer, and the ose the ScanFile folder you wish to put them into. 

Seite 114 • Electronic Document Import 



ScanFile Benutzerhandbuch 
MS Office Integration 

 

document(s) you wish to put into SAfter highlighting the canFile, press the 
r n
E nt
TIFFWriter, but it hand
are not converted to T ed to a ScanFile folder in their 
o

MS Office In
The Office integration tools, which you can select during the installation of 
S llow you 
Microsoft Office. The
Microsoft Word, Excel,
The documents will b
TIFFWriter which conv
will be added to the pro

ight mouse button a
lectronic Docume

d choose the Send To option. Choosing the ScanFile 
 Support option will display the same dialogue as for 
les the documents in a different way. The documents 
IFF or JPEG, but sav

riginal file format. 

tegration 

canFile, a to file documents to ScanFile folders from within 
 tools support Microsoft Word and Excel 97 and 
 Access, PowerPoint and Outlook 2000, XP and 2003. 
e saved with ScanFile in their original format, unlike 
erts the documents to TIFF format.  Two toolbar icons 
grams, and these are shown below. 
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Send To ScanFile 
The Save to ScanFile icon will open the Index screen as detailed in the 
TIFFWriter Explorer Send To 
Index window is the same as described in these chapters. 

Print and Save T
T  performs tw
p  open the 
ScanFile. 

ScanFile VN
he optional ScanFile VNP server application allows you to create PCL5 

compatible printers on servers and workstations, which will be directed to 
up4 

TIF format and saves it to pre-defined locations. 

These files can then be automatically imported into ScanFile using one of the 
S ler applications
which works in conjunc ecognition. 

 

 option and option. The functionality of the 

o ScanFile 
his option
rinter and

o functions: it will print the document to your selected 
Index screen to allow you to save the document to 

P 
T

specific VNP ports, which then takes the printed output, converts it to Gro

chedu  within Remote Services, such as the TIFF Spooler, 
tion with the Forms R
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Overview 
The General Settings
Settings. This allows you to set various options that will affect the quality of 
the displayed image, c
background, and other
print.  

These can be change ilst using ScanFile, but some options 
s additi
restarted. 

 screen can be found under Options -> General 

hange how the Hit List is displayed, the main window 
 options that change the Keywords display and image 

d at any time wh
uch as Show onal Toolbar will only take effect when ScanFile is 

 

Display Mod
The vast majority of P
scanned resolution. As ned at 200dpi results in 
an image 1664 pixels wide by 2532 pixels in length. This means that if the 
monitor resolution is lower than this, information from the image has to be 
'removed' to be able to display it. This can then result in a loss of quality in 

e 
C monitors are unable to display a document at its 
 an example, an A4 page scan
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t . S
applied so that optimum display quality can be achieved: 
he displayed image canFile has three image display modes which can be 

Option Description 

Greyscale Applies 4 levels of greyscale to enhance the displayed 
image 

Bitonal Applies one level of grey to enhance the image 

Black / White Displays the image with no enhancement 

 

When the scanned image is displayed at 1:1 level (one screen pixel for 
each scanned pixel), the Greyscale and Bitonal enhancements are not 
applied. 

There are more setting
table lists the options and gives a brief description: 

s to influence the image display in ScanFile. Following 

Option Description 

Skip back pages When enabled, it will stop the reverse side of a 
double-sided scanned document from being displayed 
when browsing through a file. 

Rotate Back Page 

 all files in the correct orientation. 

If a double-sided page has been scanned, and the 
reverse side of the document is 'upside down' in 
relation to the front side, the option will display the 
reverse side of

Hide Annotations Allows you to hide annotations added to a scanned 
page. A pencil symbol in the upper left corner will then 

 a hidden annotation belonging to indicate if there is
the image. 

Use Stellent Viewer Allows you to switch off the display of electronic 
documents with the Stellent Viewer, which can take 
some time if the documents are large. If this viewer is 
not used, the electronic documents will appear as an 
iconic symbol on the image window. With a double 
click on the icon the documents can be displayed in 
their corresponding applications, as long as they are 
installed. 
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Hitlist 
The Hitlist is used to display the results of a document search. Four options 
are available, to alter its appearance and functionality. 

Option Description 

Display Hitlist 
Numbers 

The records in the Hitlist will be numbered in 
ascending order. This will be in the first column of the 
Hitlist. 

Show Notes 
Column 

Adds a column to the end of the Hitlist. The Notes 
column will show whether records have memos 
applied to them, or that the records are hidden. 
Records with a memo attached will show a 'M' in the 
Notes column. Records hidden for users of the group 
View will have an 'X'. 

Save Column 
settings 

If selected, it allows each user, for each folder they 
have access to, to customize how the Hitlist is 
displayed. The order of the columns in the Hitlist can 

accessed. 

be changed, as well as the column widths. These 
settings will be saved with the folder or library being 

Alternatin
Colours 

g Row The setting changes the view of the hitlist from plain 
grey lines to alternating blue and grey lines, this can 
help when viewing similar index information. 

Printing 
Following settings change the print settings of ScanFile: 

Option Description 

Exact Scale Print When printing documents, pages will be printed at the 
exact scale at which they were scanned. This may 
mean that because a printer has a non-printable 
border, the page being printed will not fit onto one A4 
page. When this option is not enabled, ScanFile will 
ensure that an A4 page will fit on a single printed page 
by slightly reducing the size. 
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Automatic 
Orientation  

When enabled, ScanFile will test and select 
automatically which orientation will be best for the 
document to be printed in. 

Ignore Duplex mode When scanning double sided documents, ScanFile 
records whether a stored page was the front or back 
of a page. When printing these to a double-sided 
printer, if the Ignore Duplex mode is disabled, 
ScanFile will print each page as it was scanned - front 
pages will be printed on the front of a sheet, back 
pages will be printed on the back of a sheet. When 
this mode is enabled the pages will be printed in 
straight sequence. 

User, Date and 
Time 

The option will print the name of the computer, the 
user, and the date & time the document was printed at 
the top of each sheet. 

Page numbering When activated, ScanFile prints the page number and 
the total number of pages at the top of each sheet. 

Text Annotations When enabled, text annotations can be printed on a 
e when this option is separate sheet to the imag

selected. 

Print index 
information 

When enabled, index information of a document will 
be printed at the top of each sheet. 

Keyword Search Mode 
If a keyword list has been applied to a folder or library, you can choose how 
this is displayed, and how the keyword search will operate. 

Option Description 

Clear Selected 
Keywords 

If the option is enabled, when the Clear fields button is 
pressed in a folder or library, the currently highlighted 
keywords will be de-selected. If this option is disabled, 
the keywords will remain selected. 

Hide Keyword List When a folder or library is open, this option, when 
selected, will not show the keyword list next to the 
folder or library fields. 
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Display Keywords
as Text 

 Enabled, the keyword list will be shown in list format. 
Otherwise the text will be shown in the cell box. One 
of the features of the Canofile is index cells, which 
work in the same way as keywords. These cells can 
have graphic images scanned into them and can be 
displayed using cells. 

AND / OR When using keywords to search for documents, 
multiple keywords can be selected. By choosing either 
the AND or the OR option, the search will find 
documents that have had ALL the selected keywords 
applied to them, or will find documents that have had 
ANY of the keywords applied to them. 

Personal Hitlist 
st. This list is a way for each 

user to keep a list of documents together so that they do not need to search 
for them each time they wish to view them. Additionally, users can send 

Every user in ScanFile owns a Personal Hitli

documents to other users' Personal Hitlist. These options allow you to select 
whether users will be informed when another user sends a document to a 
user's list. 

Option Description 

No message If the option is selected, no action will be taken if a 
new document appears. A user will have to manually 
check for new documents in their personal hitlist 

At Login Each time a user starts ScanFile, their Personal Hitlist 
will be checked for new messages if the At login
option is selected. 

Time Interval A user's Hitlist can be checked at specific time 
intervals if the Time interval option is selected, and a 
time period entered.  

 

How a user is informed about new documents can be chosen as follows: 

Option Description 

Beep Will play a sound when a new document was found on 
the Personal Hitlist. 
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Message A message will be displayed. 

Auto open With this option selected, the Personal Hitlist will 
automatically open whenever a new document is 
added to it. 

Library Date Format 
The format in which date fields are displayed in ScanFile Libraries can be set 
from this option. You can select the order in which the days, months and 
years are displayed as well as the separator to be used. The formats are: 

• DD MM YY 
• DD MM YYYY 
• MM DD YY 
• MM DD YYYY 
• YY MM DD 
• YYYY MM DD 
 
Valid separators are '/', '-' and '.'. 

Postindex 
This option sets the mode and storage location for the post index pool. 

Option Description 

Normal Mode There is one post index pool for each ScanFile folder, 
which is physically stored in the subdirectory of each 
ScanFile folder. 

Customized Mode There is one central post index pool for all ScanFile 
folders. The storage location of this central pool can 
be defined by clicking on the button. 

Be aware, that in a network situation this can lead to 
problems, when several people are working 
simultaneously with a central pool. 
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S

o 

end to Email 
This option allows you to select how images are sent to an e-mail message. 
If a document has multiple pages, the images can be put into the new 
message as either single page TIFF files, a multi-page TIFF file or as a PDF 
File. If a document is of mixed format – it also contains colour documents or 
Word/Excel files – these will be separate to the file(s). This setting als
affects the Save to File option 

Option Description 

Normal Mode In this case all files that are sent and automatically 
appended to an Email, remain in there original format. 

Multipage TIFF In this mode the system stores single TIFF files in a 
multipage TIFF files. In case a document contains 
only TIFF files, one multipage TIFF file is appended to 

a mixture of file formats, 
it will still collect consecutive TIFF pages and COLD 

es in one file, all other formats remain in their 
inal format. 

the Email. 

In case a document contains 

pag
orig

Group to PDF In this mode pages in TIFF, JPEG and COLD format 
will be converted into a PDF file containing these 
pages as graphics. 

Electronic documents are appended in their original 
format. 

Other Settings 
Option Beschreibung 

Memo note – view / 
hidden creator 

Automatically enters a short entry into the memo of a 
document, noting who and when locked or unlocked 
the display of a document. 

Use Global Scanner 
Settings 

Activated, all user related scanner settings are ignored 
and the scanner settings of user ADMIN will be 
applied for every folder and user. 
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Display Inactive 
Buttons 

With this option, you can choose whether buttons on 
the toolbars are displayed or not, dependent on 
whether they are applicable to the function being 

is not selected, toolbar 
will be greyed out when not applicable. 

carried out. If this option 
buttons 

Display Additional 
Toolbar 

The toolbar along the top of the main ScanFile window 
will be shown when the option is selected. 

Hide Tooltips Tool tips are short descriptions of the functions of the 
toolbar buttons. They will be displayed if the mouse 

enabling/disabling this option. 

cursor is left over a toolbar button for a moment. You 
can select whether these are displayed or not by 

Automatic Date in 
Memo fie

Enabled, this will add the date and time of a memo to 
ld a memo applied to a document. 

Automatically Clear 
Pooldrive 

The option is used by the Prepare CD function. When 
selected, the existing contents of the pool drive will be 
deleted prior to the new information being written to it. 

Area/Post-indexing 
function 

The Area/Post-indexing function, when selected, 
will allow you to set an area of the image to move and 
zoom to for each field in the folder. This is used during 
index editing, and when indexing documents from the 
Post-Index pool. 

Check Number of When scanning bar-coded d
Barcodes 

ocuments, the contents of 
the barcode can be read during scanning and inserted 

s in the folder. You can select whether 
 will check if the correct number of barcodes 

into field
ScanFile
has been read from the document, in relation to the 
number of fields in the folder that have been set with 
the barcode property. 

Auto Index failed When scanning single page bar-code
barcode read with X 

d documents, if 
ScanFile fails to read a barcode from a page, an 'X' 
can be placed in the folder barcode field, to identify 

for later indexing. The Auto Index 
 read with X option selects this. If this 

option is not selected, and ScanFile was unable to 

the document 
failed barcode

read a barcode, scanning will pause and you will be 
prompted to type in the index information into the 
barcode field. 

General Settings • Seite 125 



ScanFile Benutzerhandbuch 
Choose Background 

Choose Background 

 will be displayed: 

The default display for the main ScanFile window is a grey background. Each 
user can change this by selecting the Choose Background button in the 
General Settings. You can then select whether you wish to choose a colour 
for the background, or to apply an image to the main screen background. 

Colour 
To choose a colour press the Choose Colour button, and the following 
dialogue

 

You can then
returned to the

 choose the colour you wish, and press OK. You will then be 
 Choose background screen shown on the previous page. 

The available colours will be dependent upon the settings of the display 
adaptor. 

Image 
Selecting the Choose Image option will allow you to apply a Bitmap (.BMP) 
file to be displayed in the main image window. The top left corner of the 
selected bitmap will be in the top left corner of the main ScanFile screen. 
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Overview 
By default, each user must log in to ScanFile with a unique user name and 
optional password. Each user created in ScanFile can also be granted or 
denied access to any area or option of ScanFile, ScanFile WebServer and 
ScanFile RemoteStation. 

Groups can also be created to manage the access rights for one or more 
users, inheriting the group’s rights. This is useful, if you have a number of 
users that you wish to assign same rights to. Two types of user groups are 
available for selection, Customised User Groups and Default User Groups, 
which are covered later in this chapter. 

Adding and Editing Users 
To manage user access to ScanFile, select Edit User from the Options 
menu, and the screen below will be displayed 

 

This window lists the currently defined users and groups, and gives 
information about the users that are logged in, what time they logged in and 
the duration they have been logged in the program. 

After the installation you will find here the pre-defined user ADMIN and the 
user groups Admin, Operator, Trustee and View. Here you can select a 
user or group for editing or deletion, or you can add a new user or group. 
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Users/Groups can 
Delete.  

be deleted by selecting the list entry and clicking to button 

The user ADMIN has administration rights. It is important to change the 
default password ADMIN once ScanFile has been set-up. 

The Use login system option allows you to disable the login requirement, so 
that when ScanFile is opened, you will not be asked for a user name and 

 logged in as the Admin user.  password, and will automatically be

Only the user ADMIN or members of the group Administrator have the right 
to enabled/disable the Use login system option. 

Adding a User 
To add a new user, click on the Add User button in the main User 
Management window and the following screen is displayed. 
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You must enter a user name, the password is optional but the use of one is 
recommended. It is also possible to add an e-mail address for the user which 
is used by the RemoteStation client, the use of which is explained later in this 
manual. 

er will only free his 
license by logging out. Every other value larger than zero indicates the time 
in minutes a user is blocking a license before others are able to obtain it. 

You can then select which Folders and Libraries the user has access to. 
Firstly you need to select the location where the Folders or Libraries reside 
and they will then be listed in the top box. To give a user access to a folder or 
library, highlight it in the top list box, and then press the Add button. That 
folder or library will then be shown in the bottom list box. To give a user 
access to all the folders or libraries on the selected drive, click on the Add All 
button. 

To remove folders or libraries from the access list, press the Remove All 
button, or select the folder or library, and then press Remove. 

With the Open library option, you can select whether the Open tool on the 
left toolbar of the main ScanFile window will open folders or libraries. When 
not selected, the Open Folder list (default setting) will be displayed. When 
selected, the Open library list will be displayed. 

Another option in the user setup is to add an individual user to a group of 
users. To do this click on the Member of button and a window will appear 

he user you are editing a member of 
up and click on the >> button to add 

Also from this window you can select ttings, these are 
explained later in this chapter.  

O nished the user 
c  be save

M
To edit an existing user'  the main Users Window 
and select Modify. All options that are available when creating a new user 
w e you ha the OK button, and the user 
configuration will be saved with any changes made. 

In ScanFile Version 8 a license time limit was added for every user. A user 
license can be freed after a certain amount of time. This prevents users not 
working with the program from blocking a user license as long as they are 
logged in. The default value is zero. The logged in us

listing all available groups. To make t
one of these groups, highlight the gro
that user. Then click on Ok to save. ScanFile will return to the Edit User 
window. 

Extended Se

nce you have fi  with all options, press the OK button, and 
onfiguration will d. 

odifying a User 
s rights highlight the user on

ill apply. Onc ve finished this, press 
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User blocking 
I s an inval
Management will block this user. The user is not able to log into any ScanFile 
p that point
this user. Go to Options
The button Unblock will be activated. A click on this button will unblock the 

ser. 

A
It is possible in ScanFile to define User groups and assign access rights to 
them. Groups are especially useful should you have a number of users that 
you wish to assign same rights to. The administration of access rights is 
easier and more efficient this way. 

oup, the user inherits a conjunctive 

levels are: 

Vie Users added t ta 
reco s t  ar ot h ify 
them.  

Trustee: us s are allowed to edit memos and to hide and reveal index 
cords. 

Ope tor d to scan, edit, and prepare for CD writing, 
rena e a  p t-inde ete 
folders. 

Admin: m s of in group have full access in the ScanFile 
system. T

gin/password system.  

f a user enter id password three times in a row, the ScanFile User 

rogram from  on. Any user with administrator rights can unblock 
-> User management and select the blocked user. 

u

dding and Editing Groups 

If a user is member of more than one gr
combination of all group rights. 

Default User Groups 
Four different levels of User Group have been included by default in 
ScanFile. These can be seen when entering the Edit User area of ScanFile 
from the Options menu. The groups that are created by default all have 
default security levels associated with them. The 

w: o this group are allowed to retrieve and view da
idden. The users may also view memos but not modrd hat e n

Tr tee
re

ra
m

: Operators are allowe
nd os x. Operator level users cannot create, edit or del

the AdmMe
hey can create, edit and delete folders and switch off the 

ber

lo

To setup a Default user group highlight the group required and click on 
Modify. A window will open, that you know from creating and editing users. 
You can modify the group settings the same way. 
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User Defined Groups 
Additionally to the pre-defined groups you can create new groups and assign 
folder, libraries and menu rights matching your requirements to them. Click 
on New Group and the User Setup window will be displayed. Creating a 
new group requires the same steps as creating a new user. 

Extended Settings 
When creating or editing a user or group you need to assign the rights that 

window will be displayed after you clicked on the Extended 

user or group will have within ScanFile for the folders/libraries they have 
access to. The Extended Settings screen allows you to define exactly which 
functions, or groups of functions a user or group will have access to. The 
functions are displayed in groups which mirror the ScanFile menu options. 
Following 
Settings button: 

 

To select which options you wish to allow or prohibit for the user or group, 
click on the corresponding tab on the left hand side of the window and then 
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select the options required. A Tick in the checkbox means that option is 
allowed; a blank checkbox will mean that option is prohibited. The selected 
options are then the only options viewable when that user or group member 
logs into ScanFile. Included are three options at the top right hand side of the 
window to allow you to select all or deselect all options listed against one tab 
and to select the default options available for the whole menu listings. 

Use Select All or Deselect All to select/deselect every displayed menu 
option. 

The General Tab at the top left hand side of the window will display the 
Administrator selection next to it. When ticked it will automatically give the 
currently selected user or group full administrator rights to the ScanFile 
program which will limit no options. 

If a user is a member of more than one group, and different settings have 
been applied to these groups, the menu options available to a user will be 
inherited from the group the folder or library the user has open is a member 
of. 

nt 
 run ScanFile with a windows user 

account. ScanFile folder and libraries, protected with this windows user 
account are protected from unauthorized access. 

ScanFile 
To enter a windows user account, open Options -> Edit User and click und 
ScanFile Account. Following window is displayed: 

ScanFile Accou
The ScanFile Account allows you to
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Select . The fields will be enabled. Enter 

Remote Service 
ase note that the Windows service has to 

run under the same domain account as ScanFile. 

Display Start -> Settings -> Control Panel -> Administrative Tools -> 
 to ScanFile Remote Service. If the service has already been 

the service. With the right mouse button, select Settings 
le Remote Service Properties. Select the tab Log On 

d from Local System account to Log On As. Enter the same 
nt as in ScanFile. Close the settings window and start the 

rv

 Activate „RunAs Account“
domain, user name and the password. Please enter the password a second 
time to verify your first entry and to avoid mistyping. Save the new settings, 
close all windows and restart ScanFile. After the restart, ScanFile will run 
under the entered windows user account. 

If you use the Remote Services, ple

Services. Go
started, please stop 
to display the ScanFi
an  change 
domain accou
e ice. s

ScanFile Account doesn’t work with Windows Workgroup accounts. 

Please note that the domain account has to be at least entered as a Power 
user on the machine! 
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Overview 
Further settings are available within ScanFile that allow you to select the 
language ScanFile uses, which barcode to read, and other scanning related 
functions. These are described below. 

Choose language 

Before the new language will take effect, ScanFile must be closed down and 

When installing ScanFile, you will be asked to select the language required, 
but this can be changed at any time by selecting Choose Language from the 
Options menu. Available languages are: 

restarted. 

The Far East languages Japanese, Korean and Chinese are available in 
special setups. 

C
Select Choose brightness from the Options menu to assign predefined 
brightness levels used during scanning to the function keys F2 – F6. Where, 
for example, documents have different background colours, and the scan 

et 
the appropriate function key, that 

hoose brightness 

quality using the automatic mode of the scanner is insufficient, manually s
values can be applied. By pressing 
brightness level will be used during scanning. 

 

Obviously, the setting of these values is a matter of trial and error, but once 
the correct values are found, they need not be changed. This can be 
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overridden by using either the automatic mode or by selecting the brightness 
level using the control on the toolbar. 

A function key value of zero will, when that key is pressed, reactivate the 
scanner's automatic brightness function. 

Setup Filter 
This option enables you to enhance the quality of a scanned page by 
applying predefined filter options, or by creating your own filter settings. 
These settings can be entered when selecting Setup Filter. from the 
Options menu. The filter can be applied either after scanning by selecting 
Edit -> Use Filter, or during scanning if the Use Filter option is selected. 

Up to three user defined filter settings can be created and saved. These can 
then be applied by selecting them from the drop down lists on the right side 
of the Filter Settings wind90ow. Up to six filters (standard or user defined) 
can be applied at any time, and they will be actioned in the order – from top 
to bottom – that they are selected in the drop down lists. 

 

Pre-defined Filters 
There are six pre-defined filters that can be applied, and these are described 
below. 
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Filter Description 

Noise Removal This will remove single black & white pixels 

Horizontal line 
removal 

This will remove horizontal lines 

Vertical Line removal This removes vertical lines 

Brighten page This will brighten the page 

Darken page This darkens the page 

Complete Lines Attempts to complete horizontal & vertical lines 

Softer edge Will soften edges of words and graphics, blending 
them with their surroundings 

Harder edge More clearly defines the edges of graphics, boxes 
and text. 

 

The following example shows the result of filtering using Noise removal. 
This filter favours white or black areas and removes isolated white and black 
pixels. As a result the contrast and readability is improved whereas the 
storage space is reduced. 

 

User Defined Filters 
The filter algorithm calculates the brightness of each pixel of an image. With 
black and white images, the brightness value of each pixel is binary: the 
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value of a black pixel is 1 and of a white pixel 0. The brightness value to be 
allocated to a pixel is calculated by the weighted sum of the neighbouring 
pixels. These weighting factors give a ‘coefficient’ to a filter. Since the 
calculated brightness values have to be assigned either to black (1) or white 
(0) a threshold for the decision must be defined. 

1 1 1 

1 1 1 

1 1 1 

 

1 2 1 

2 2 2 

1 2 1 

 

The setting of these p
i.e. the image resolu
Filtering generally en

Fast Search

field
substantially reduce s
o
i

folder or libr
menu, and the followi

microfilm images and

Please note, it is poss
document completely
NEVER turn the Us
settings are correct fo
scanning an example
Image from the Edit 
the filtered image. 

With the option Fast
against specific 

f index records, wh
ndexing. 

To set a binary index 
that the 
With his filter parameters and a threshold of e.g.3
an isolated white (black) pixel will be automatically
converted to black (white). 
With these parameters and a threshold of 4 thin
interrupted horizontal and vertical lines will be
closed. 
arameters depends on the quality of scanned images, 
tion, the zoom factor and the brightness of the image. 
hances the screen display readability of low contrast 

er function on until you are sure that the filter 

 This option will ask for confirmation before saving 

 

s within a folder or library. A binary index can 
earch times on folders and libraries with large numbers 

ary is open. Then select Fast Search from the Edit  
ng screen will be displayed.  

 reduces storage requirement dramatically. 

ible, with the incorrect use of the filter to turn a scanned 
 black, or completely white. When working with filters, 
e Filt
r the documents to be scanned. This can be done by 

, amending the filter settings, and then selecting Filter 
menu

 Search you can set what are called Binary Indexes 

en the search is performed on the field set for binary 

for a field within a folder or library, first of all make sure 
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Select the field to set a binary index on, and then press OK. A binary index 
will then be created for that field. 

A field set with a binary index can adversely affect the import of new 
records. This is especially so when importing folders into libraries. It is 
therefore wise to switch the binary index OFF before importing folders into 
libraries, and then to switch the binary index back on. 
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Overview 
Documents containing barcodes can have the value of the barcodes inserted 
into index fields in the folder either during scanning or by performing zoned 
barcode reading as a batch process after scanning. The barcode function is 
an option of ScanFile, and must be purchased to enable it. ScanFile can read 
up to 10 barcodes at a time in either reading mode. 

Barcode Formats 
Five barcode formats are supported by ScanFile. The supported formats are: 

• Code 39 
• Extended 3 of 9 
• 2 of 5 interleaved 
• Codabar 
• Code 128 
 
The barcode type can be selected from Choose Barcode from the Options 

le menu. Additionally you can select settings to influence the way ScanFi
reads barcodes. 

 

With the Fields 1 to 5 up to 5 barcode types can be set to be read 
sequentially. This assigns the priority to the chosen barcode types. Referring 
to the settings in the screenshot above the whole page would be scanned for 
possible barcodes. After this every barcode found in the page is proofed for 
his validity as Barcode 39 (3 of 9). If the barcode is a valid the value is read 
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and saved. After pr
9) the barcodes fo

oofing all barcodes for their validity as a Barcode 39 (3 of 
und in the page will be proofed for their validity with the 

ing field. This sequence is repeated until all selected 

next barcode type. With the given settings this would be the Code 128 
barcode type. If a barcode is a valid Code 128 barcode the value is read and 
saved to the correspond
barcode types were read. 

The priority of the barcodes also sets the order in which the read values are 
pasted into the index fields. The following example shows the order to insert 
the index values referring to the configuration above. 

 

When using more than one barcode type on the same page there are some 
consideration that need to be taken into account. 

When using Barcode 3 of 9 and Extended 3 of 9 these barcodes have the 
same symbologies and can lead to barcodes being recognized twice when 
both uses on the same page. 

Barcode 2 of 5 interleaved by design is a simplistic barcode, which can 
result in other barcode results that are not 2 of 5 interleaved being read. To 
remedy this then the hierarchy of the barcodes used needs to be 
considered and if 2 of 5 interleaved is to be used then this barcode should 
be the last barcode on the document. 

Barcodes • Seite 143 



ScanFile Benutzerhandbuch 
Reading while Scanning 

The barcode reading module can also recognize a barcode checksum, 
which checks for the validity of the barcode. The checksum number is not 
added to the index field.  

The Enhance barcode option can improve the reliability of reading barcodes 
from poorly printed documents, such as those produced by dot-matrix 
printers. 

The Rotate Barcode 90 ° will read barcodes that are printed down a page, 
rather than across.  

Reading while Scanning 
There are two ways for reading bar-coded documents while scanning, as 
follows: 

ndex record is created. If there are 
no barcodes on the next page being scanned, this page will be appended to 

 scanned that contains 

 can be set 
for ea  the example below, the f o and Pick-Up Code 
have the Barcode property applied to them
i  Sca d barcodes from the scanned 
pages, and insert the result into these fields 

Single page Scanning will create a new index record for each page 
scanned. The contents of the barcode on each page will be inserted into the 
barcode fields applied to the folder. 

With Batch Scan, the barcodes can be used as file separators. If a barcode 
is found on a page being scanned, a new i

the previously created file. The next page to be
barcodes will create a new index record. 

Folder Configuration 
ScanFile can read up to ten barcodes at one time, and place the results in to 
the folder fields. When setting up folders, a property of Barcode

ch field. In ields Serial N
. When documents are scanned 

n to the folder, nFile will attempt to rea
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Reading Barcodes 
The location of barcodes on a form does not have to be specified for this 
mode of reading. If there is more than one barcode on a page, the data held 
in the first barcode found on the page will be placed in the first field in the 
folder with a barcode property. The data held in the second barcode found 

d barcode field, and so on. will be placed in the secon

In the example shown below, the data held in the first barcode, Project 
Number, will be placed in the Project No field in the folder, which is the first 
field with a barcode property. 

 

In General Settings, the following options can be set: 
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You can select whether ScanFile will check if the correct number of barcodes 
has been read from the document, in relation to the number of fields in the 
folder that have been set with the barcode property. The Check Number of 
Barcodes option controls this. 

When scanning single page bar-coded documents, if ScanFile fails to read a 
barcode from a page, an 'X' can be placed in the folder barcode field to 
identify the document for later indexing. The Auto Index failed barcode 
read with X option selects this. If this option is not selected, and ScanFile 
was unable to read a barcode, scanning will pause and you will be prompted 
to type in the index information into the barcode field. 

You can also read a documents barcodes after it has been scanned by 
displaying the page, and then pressing the F12 function key or selecting 
Edit -> Recognise barcodes. 

Z
This method of reading barcodes allows you to specify the field to which the 
barcode value will be placed. Up to ten zones can be defined and linked to 

m scanned pages at 
ed for this 

feature 

Defining Zones 
To define the zones, from the OCR menu select Setup zones and the OCR 
image window will be displayed, which will show the first page of the first file 
in the folder, or the currently displayed page from the folder. 

one Barcode Reading 

fields in the folder. Zone barcode reading can also be combined with zone 
OCR reading, allowing you to read barcodes and text fro
the same time. Please note the ScanFile OCR option is requir
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You can navigate through the files in the folder by using the available tools 
until the page you wish to define zones is displayed. 

Please note that the zone recognition will always be carried out on the first 
page of a file! 

To ensure that when drawing the zone the correct part of the page is within 
the zone, you can zoom and rotate the im
Once you have displayed the area of the page you wish to create a zone for, 
right-click on the Indexfiel
Add Field. 

A crosshair cursor will then be displayed in the image window, and by moving 
t ou wa
mouse button and moving
the left mouse button will then fix the zone, and the Connect zone to screen 
will be displayed. 

age within the display window. 

ds option under All unknown forms, and choose 

he cursor to where y nt the zone to start, and then holding down the left 
 the mouse, you can define the zone. Releasing 
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On this screen, you can select which field within the folder you wish to 
associate the zone with, and you can also specify the content type of the 
zone. In this example the zone is associated with the field ‘Project No.’ with a 
content type of Barcode.’ 

The Recognize draft printing option will assist in reading faded or dot 
matrix printed documents. 

Press OK to return to the Setup Zones window. 

Once you defined a zone, it can be changed at any time. Right-click on the 
field name under Index fields you have two choices: 

The Edit option allows you to resize a zone and also to change the field 
association and the content type setting. Zones can be deleted by selecting 
the Delete option 

Ensure that the zones are a little bigger than necessary, to compensate 
small differences between scanned pages. 

After all the zones have been created, press OK to close the Setup zones 
window. 
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 will be displayed: 
To perform the zone recognition, select OCR -> Zone recognition and the 
Zone Recognition screen

 

Selecting the Read all pages option will perform the recognition on all the 
files in the folder. The Read new pages option will perform the recognition 
on the files that have been added since the last recognition was performed. 

The folder you wish to perform the recognition on must be open. 

Reading Selected Documents and Pages 
The process described above will read all the records within a folder, or the 
records added to the folder since zone recognition was last run. Alternatively, 
you can read single or selected records within a folder. In order to do this, 
use the OCR menu option, which is shown when right-clicking in the Hitlist or 
Image Display window. 
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O
This is an option for ScanFile, and has two methods of OCR. Full Text OCR 
and Zone Recognition. 

reates a searchable database, allowing to find pages of 
documents that specific words appear on. Electronic documents containing 

sed, the fulltext reading is very fast and reliable. 

Zone recognition allows you to read area’s of a document, and place the 
result of th

The Forms Recog
option of ScanFile. Its purpose is to recognise a form by means of defined 
identifiers and then index records with data read from the contents of zones 
that have been created for each form. 

From ScanFile Rel
for Job Separation 
on how to configure

Full Text R
U
r  w
the folder, and can be searched by anyone who has ScanFile. 

verview 

Full text recognition c

text and COLD documents can be read as well. Since COLD data are 
already text ba

e OCR in to the folder fields. 

nition option works in conjunction with the OCR zone 

ease 7.3, the Forms Recognition option includes support 
Sheets. Please see the according chapter for information 
 and use these. 

ecognition 
sing this option 

ecognised words
every scanned page of a ScanFile folder is read, and 
ill be saved in a database. This database is attached to 

You do NOT need the OCR module to do a Full Text Search; you only 
need the OCR module to perform the recognition in the first place. 

o do a fulltext recognition, ope
OCR -> Full text recognition. 

n the relevant folder and click to menu  

You can select whether you wish to OCR all pages in the folder or just the 
new pages – the pages added since the OCR was last run. 
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Once the recognition starts, the progress can be monitored. The information 
displayed includes a recognition ratio, showing the perceived reliability of the 
process. Obviously, the OCR recognition will have problems with bad quality 
documents, so always ensure that the documents to be OCR’d are of decent 
quality. It is also wise to have scanned them at a minimum of 300x300dpi for 
best results. 

Read Selected Documents or Pages 
The process described above will OCR all the pages within a folder, or the 
pages added to the folder since Full Text OCR was last run. Alternatively, 
you can OCR individual or selected pages of a record, or single or selected 
records within a folder. To OCR records or pages, use the OCR menu option, 
which is shown when right-clicking in the relevant window. 

Window Description 

Hitlist Window Selected record or records 

Image Window Displayed page 

FastPics Window Selected page or pages 

 

Edit Wordlist 
When performing a full text OCR, there will be some words that you would 
not wish to search on, and that just take up space within the OCR database. 
These are generally words such as 'that', 'the', 'and' etc. These can be set to 
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be ignored by adding them to the OCR wordlist, which you can open by 
selecting the Edit wordlist option on the OCR menu. Per default this wordlist 
is empty and no words are filtered from the text read. 

 

 

How to perform a full text search is described in chapter Searching and 
Viewing Documents. 

Zone Recognition 
This method allows you to specify parts of a document to be OCR’d and the 
results put into specific fields within the folder. Up to ten zones can be 
defined and linked to fields in the database. 

Setting up Zones 
To define the zones select Setup Zones from the OCR menu and the zone 
configuration screen will be displayed, showing the first page of the currently 
selected Hitlist. 
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You can navigate through the files in the folder by using the available tools, 
until the page you wish to define zones for is displayed. Then you define the 
zones and link them to the index fields of the folder. 

Please note that the zone recognition will always be carried out on the 
FIRST page of a file. 

To ensure that when drawing the zone, the correct part of the page is in the 
zone, you can zoom and rotate the image within the display window. Once 

ng down the 
mouse button, you can define the zone. 

T
t r slight differences and 
skewing during the scanning process. 

you have displayed the area of the page you wish to create a zone for, right 
click on Index fields on the OCR tree under the All Unknown Forms branch 
and select Add Field. 

This will then display a crosshair cursor in the image display window, and by 
moving the cursor to the beginning of the zone, and then holdi

he example below shows several zones already created. Always ensure 
hat there is sufficient space around the zone fo
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The zone has been defined once you released the mouse button. Then you 
can relate the zone to a particular field within the folder. 

 

lder fields, a zone can be associated to the Memo for 
ere, you can also specify the characters allo

In addition to the Fo
each record. From h wable for 
that field: 

Option Description 

All characters This is to be used if the characters are a 
combination of any keyboard character, including 
punctuation marks etc. 

Numbers & Prices This is to be used if the characters are a 
combination of numbers and currency symbols 
such as £ or $. 

Numbers Only This is to be used if the characters are numerical 
characters only. 

Characters Only This is to be used if the characters are 
alphabetical characters only. 
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Only Uppercase Letters This is to be used if the characters are Uppercase 
alphabetical characters only. 

Only Lowercase Letters This is to be used if the characters are Lowercase 
alphabetical characters only. 

Barcode This is to be used if the characters are Barcodes. 
Please note: the barcode format must be selected 
beforehand in the Options -> Choose Barcode
menu from the main ScanFile Desktop. 

For more information see chapter Barcodes 

Check Mark This is used to determine a number of values on 
forms with check boxes such as survey forms. 
Further information later in this chapter. 

Graphical Element (Identifier Only) This is to be used if the identifier 
is a graphic or picture on a form. This could be 
used if the identifier is a company logo for 
example. 

 

The selection of the characters allowed for a zone increases the reliability of 
the results of the OCR reading. If you assign Numbers only to a field, the 
amount of possible characters is significantly reduced and a zero will not be 
mistaken as an O. 

The options Barcode, Check Mark and Graphical Element are extended 
functions. They are needed for reading barcodes and forms recognition. How 
to configure and perform Barcode recognition is described in the chapter 
Barcodes. Forms recognition will be described later on in this chapter. 

The Recognize draft printing option will assist in reading faded or dot 
matrix printed documents. 

After a zone is defined, it can be edited any time by right-clicking on the 
corresponding index field and selecting Edit. This allows you to resize a zone 
and also to change the field association and the content type setting.  

Zones can be deleted by right-clicking on the field name under Index fields 
and selecting the Delete option 

Ensure that the zone is large enough to compensate size differences of 
scanned pages. 
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When all required zones have been setup, the Zone OCR reading can be 
started. Just like fulltext OCR reading you can select between Reading All 
and Reading New pages. 

All & New Pages 
To perform zone recognition, open a folder and then from the OCR menu, 
select Zone recognition. 

Selecting the Read all pages option will perform the recognition on all the 
files in the folder. The Read new pages option will perform the recognition on 
the files have been added since the last recognition was performed. 

Read Selected Documents or Pages 
You can OCR individual or selected pages of a record, or single or selected 
records within a folder. To OCR records or pages, use the OCR menu option, 
which is shown when right-clicking in the relevant window. 

Please note that the zone recognition will always be carried out on the 
FIRST page of a file. 

Forms Recognition 
This option works in conjunction with the OCR zone option of ScanFile. Its 
purpose is to recognise a form by means of defined identifiers and then index 
records with data read from the contents of zones that have been created for 
each form. 

The normal Zone OCR will apply the defined zone from All Unknown Forms 
on each page. This is not a problem if you only have one type of document 
per folder. But if you save different types of documents, you need a different 
set of zones per document. This can be achieved by using the ScanFile 
option Forms Recognition. 

The Forms Recognition allows you to specify identifiers for a document, 
giving ScanFile the opportunity to identify a document and apply the zones 
belonging to a certain document type. Identifiers can be a graphic or picture 
on a form, this could be used if the identifier is a company logo for example, 
or a unique identifier text. 
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Setup Form 
The first part of the forms recognition process is to setup zones on the 
different forms that are to be identified and indexed. To do this you must first 
scan in some good examples of the forms to a ScanFile folder. Then to begin 
the zone setup select Setup Zones from the OCR menu on the main 
ScanFile Desktop and the Forms configuration screen will be displayed that 
you already know from setting up OCR zones. 

t first click with the right hand mouse button on All 
unknown Forms and select Add Form. You will be asked to give the new 

After creating a new form, the zones for the index fields can be setup. The 
zones are setup the same way as in the Zone Setup window. For more 

is chapter. 

An Identifier is a part of a form that distinguishes it from other forms, so that 
the Forms Recognition can tell the difference between two or more types of 

ct Add 

which identifier you wish to use, the selection you make here depends on the 
 have selected to use for that form. 

arcode, 
ext box 

 t ld Properties window the text, (in which format 
s the Identifier. For example if the 
lect Numbers Only and then type in 

n sible to test the reliability of 
e 

Setup Zones window. This will give a percentage of recognition next to the 
name of the form in the OCR tree. The recognition rate will be 100% for the 
form you used to setup the identifiers. The recognition rate of other scanned 
pages of the same form may vary. 

To create a form you mus

form a name. Once you have named the form it will appear in the OCR tree 
on the right hand side of the setup zones window. Also in this tree, under the 
form name, there will appear three additional options explained below. 

Index Fields 

information see Setup Zones in th

Identifier 

form that may be scanned in one folder. 

To create an identifier, right mouse click on Identifiers and sele
Identifier. Similarly to the zone setup, a crosshair will appear over the image 
display, use this crosshair to draw a box around the identifier you wish to 
use. Once you release the mouse button a window will appear asking you 

type of identifier you

Should you select any of these options, with the exceptions of B
Check Mark and Graphical Element, you must type in the Identifier T
at he bottom of the Set ID-Fie
you selected) that should be used a

you seidentifier is form number 12345 
12345 in the identifier text box.  

ce the identifiers have been setup it is now posO
the Forms Recognition by clicking on the Test Recognition button from th
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Keywords 
To speed up retrieval once a form has been recognised and indexed it is 
possible to add Keywords to a form. In order to do this, right mouse click on 
Keywords and select Add Keyword. A keyword list will then appear. Select 

u wish to add from the list and then click on OK. Repeat this the keyword yo
for every keyword you wish to add. 

A keyword list must be added to the folder you are working in before you 
attempt to add keywords to a form setup. 

Check Marks (OMR) 
ition. This is 

e xes such as 
These values can then be entered, once the Forms 

s been performed, as index information. 

 the checkbox zones for recognition. Once you 

ou will be 
prompted which field you wish to attribute that zones information to, select 
the zone you wish and then select Check Mark Recognition. To adjust the 
settings for the way the index information is entered click on the ‘...’ box. 
Here you will be given a number of default choices for indexing: 

Another option of the Forms Recognition is Check Mark Recogn
s d to determine a number of values on forms with check bou

survey forms. 
Recognition ha

To set up Check Mark Recognition you must first scan in a form that has 
checkboxes on it to prepare
have scanned the page, select OCR -> Setup Zones. From the OCR tree in 
the Setup zones window, right click on index field and select Add Zone. 
Draw a box using the crosshair around each checkbox on the form that you 
wish to be recognised. When you release the mouse button y

Option Description 

Mark Set This setting determines the index information that is 
entered if a checkbox is marked. 

Mark Not Set This setting determines the index information that is 
entered if a checkbox is not marked. 

Separator This setting determines the separator that is entered 
between index values on the hitlist. 

 

The Mark Set and Mark Not Set settings have a number of default entries 
that can be entered as index information: Yes & No, True & False, On & Off 
and Keywords assigned to the folder. However it is possible for you to enter 
your own information to be applied as index data. 
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With selecting a Separator, 
ltiple index entries in one index field. You can choose from predef

you specify the character that will separate 
mu ined 
characters, but you also have the possibility to enter your own separator. 

On  and 
the  filled. 

P o
At  OCR tree in the Setup Zones window you will find 

ree options: 

ce this is all set up, perform a zone recognition from the OCR menu
 index fields will be

r perties 
the very top of the

th

Option Description 

Threshold The threshold is the setting that determines whether a 
forms data will be recognised by the reliability of that 
form. 

Example: 

ny forms which have 

rs 
will score below 60 and be rejected as that form. 

If the threshold is set to 60 then a
matching identifiers will return higher than 60 and be 
recognised, any forms that don’t have matching identifie

Skew Correction This setting will straighten or un-straighten any images 
that have been scanned to assist with a more successful 
OCR.  

Border Removal This setting will remove or add the borders that may 
appear on a document once it has been scanned. 

 

F r
The forms with the relevant index field setup and the identifiers are stored in 

e is stored in the ScanFile 
application path as file default.sff. The file is displayed above the OCR tree 

. All changes to the forms database will be saved 
. 

o ms Database 

a forms database. The default forms databas

in the window Setup Zones
when clicking on OK
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Overview 
ScanFile can use job separation sheets during batch scanning, which 
enables several files to be placed in the scanner feeder at the same time with 
the job separation sheets placed between them. The files will be 
automatically divided into documents stored in the ScanFile folder. The job 
separation sheets are user defined. 

Only users with Administrator or Operator status are given permission to 
configure Job Separation Sheets by default. This applies to new installations. 
For upgraded installations, Operators will have to be assigned permission 
manually. Please see the Security chapter. 

Setting Up Job Separation Sheets 
To create a separation sheet template, you must first scan a sample of the 
sheet to a ScanFile Folder. It is good practise to create a Folder to hold all 
the different separations sheets that you wish to use, and from this you can 
create the templates. The templates you create can be applied to any 

open select Setup job 
separation sheets from the Options menu. This will open the separation 
sheet setup screen. You can then select the separation sheet image that you 
want to create the template for. 

ScanFile Folder. 

With the Folder that has the sample separation sheet 
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To create a sheet you must first click with the right hand mouse button on 
Job separation sheet and select Add Form. You will be asked to give the 
new form a name. Once you have named the form it will appear in the Sheet 
tree on the right hand side of the setup window. Also in this tree, under the 
sheet name, there will be a sub node called Identifier. This node contains all 
identifiers that are used later on to identify the separation sheet. 

If you do not intend to use more than one job separation sheet, you do not 
need to create a new sheet as described above. You can create the 
Identifier within the default Job separation sheet. 

Identifiers 
An Identifier is used to distinguish the separation sheet from all the other 
documents being scanned. To create an identifier, right-click on Identifiers 
and select Add Identifier.. A crosshair will appear over the image display, 
use this crosshair to draw a box around the identifier you wish to use. 

You can create multiple Identifiers by repeating the process described above. 

Once the identifiers have been setup it is now possible to test the reliability of 
the sheet recognition by clicking on the Test Recognition button from the 
Setup window. This will give a percentage of recognition next to the name of 
the form in the tree. 
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During a scan process all scanned images are compared with the saved job 
separation sheets. If the threshold is reached, an image is considered to be a 
job separation sheet and therefore isn’t saved. At the same time the current 
document is closed and a new document is created. Further scanned images 
are saved into the new document. 

Properties 
Additional settings can be applied to influence the recognition. These 
properties are also used in the Zone OCR setup. The following table gives a 
short overview: 

Option Description 

Threshold The threshold is the setting that determines whether a 
sheet will be recognised by the reliability of that sheet. 
When you run the Test Recognition a percentage will be 
marked against the sheet. Example: If the threshold is 
set to 60 then any sheets which have matching 
identifiers will return higher than 60 and be recognised, 
any sheets that don't have matching identifiers will 
score below 60 and be rejected as that sheet. 

Skew Correction The setting will straighten or unstraighten any images 
that have been scanned to assist with a more 
successful recognition. 

Border Removal This setting will remove or add the borders that may 
appear on a document once it has been scanned. 

U
Each ScanFile Folder can have a Job Separation Sheet template associated 

down list. 

sing Separation Sheets 

with it. This is configured in the Setup Folder window by selecting the folder 
you wish to configure, go to Extended Settings and select the template to 
use within the Job separation sheet drop-
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Overview 
The Canon microfilm
a roll film retrieval FS C  scanning of the documents 

eld on the film or fiche. 

F
After the user has entered the index information and positioned the fiche 
carrier to the relevant frame on the fiche, the scanning process is started by 
clicking on either Batch scan or Single page scanning. Using a fiche 
carrier, the Feeder/manual button is ignored. 

When a scan is finished (the scanned pages and the relevant data record 
have not yet been saved), the user must decide on the step required next. 

FS Controller III 
The FS Controller II is an automatic roll film carrier that can be directly 

Single Page Scanning – Microfilm 
Single Page scanning d. You can 
s ween man

Fiche Carrier 
Using the fiche carr

• Insert fiche to be scanned 

barcode, counting or duplicating index fields) 

 scanners can be equipped either with a fiche carrier or 
ontroller III. to allow batch

h

iche Carrier 

controlled from ScanFile. 

 will create one record for each page scanne
witch bet ual or automatic mode, dependent on the carrier. 

ier, you need to go to the page to scan manually. 

• Position to the relevant fiche frame 
• Set zoom and focus properly 
• Key in index for the frame to be scanned (if not created automatically by 

• Start scanning process by clicking on the Single page scanning button 
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FS Controller III 
The FS Controller III c
can be switched b

an scan in a given number of frames automatically. It 
etween automatic and manual feed. 

the frame to be scanned (with keyboard or turning 
I) 

 

Manual Mode 

In this mode the pages are manually selected via the keyboard or knob of the 
FS III and scanned as single page records. 

• Insert the film to be scanned 
• Position the FS III to 

knob of FS II
• Set zoom and focus properly 
• Key in index for the frame to be scanned (if not created automatically by 

barcode, counting or duplicating index fields). 
• Start scan by clicking on the Single page scanning button
 
Feeder Mode 

In this mode a user-definable number of frames is scanned automatically and 
saved as separate records. 

With this option automatic indexing (barcode, counting or duplicating fields) 
should be set, as it is not possible to key in index information during the 
scanning process. The index can also be keyed in or edited later. 
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•

rs entered) 
• Group pages by File (F) 

h blip 
numbers entered) 

 

 Group pages by pages (P) 
(scans and stores images as single page records between Page blip 
numbe

 (scans and stores images as single page records between File blip 
numbers entered) 

• Group pages by File (F und B) 
(scans and stores images as single page records between File-and batch 
blip numbers entered) 

• Group pages by Batch (B) 
(scans and stores images as single page records between Batc

Be sure that the mode of the FS Controller III for blip reading is set properly. 
For more information on the FS Controller III, see the MS300 / MS350 / 
MS400 / MS500 / MS800 Scanner Configuration manual, or the FS Carrier 
III manual. 

Batch Scanning - Microfilm 

e 
several images into a batch record 

ecessary and click on Continue scanning. Repeat 

Feeder Mode 
In this mode a user-definable number of images is scanned sequentially and 
stored as one batch (document). 

Batch scanning will create a document containing multiple scanned pages. 

Manual Mod
Using manual mode, the user can scan 
from roll film. ScanFile will combine these single images to one document. 

• Insert the film to be scanned into the FS Controller III 
• Set roll film retrieval to the first image (by the keyboard or knob of the FS 

III) 
• Set Zoom and focus 
• Key in the index information (if not created automatically by barcode or by 

duplicating or counting fields). 
• Start scanning by clicking on the Batch Scan button. 
• Select next frame if n

this step until end of batch 
• To end batch click on Save scanned pages 
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The index is either entered
counting or duplicating fiel

 manually or created automatically using barcode, 
ds. The index can also be keyed in or edited later. 

(scans and stores images between File blip numbers entered into 

• Group pages by Batch (B) 
(scans and stores images between Batch blip numbers entered into 

The images to be scanned can be selected according to the blips (B,F,P) on 
film: 

• Group pages by pages (P) 
(scans and stores images into one batch between Page blip numbers 
entered) 

• Group pages by File (F) 

batches) 
• Group pages by File (F und B) 

(scans and stores images between File blip and batch blip numbers 
entered into batches) 

batches) 
 

Be sure that the mode for blip recognition on the FS Controller III is set 
properly. For more information on the FS Controller III, see the MS300 / 
MS350 / MS400 / MS500 / MS800 Scanner Configuration manual, or the FS 
Carrier III manual 
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Overview 
The ScanFile module Document Routing allows you to assign documents to 
pre-defined routes that will direct the documents to users and/or archives in 
an order that has been defined within the route. 

The Document routes consist of separate steps, which can vary depending 
on selected options. At each step the document can be assigned to a specific 

rs. Until each user at each step within a route has performed 
tion, such as viewing or approving, the document will not 

in the user’s personal hitlist. 

C n
t d if the user wishing to setup a Document Route has 
m to ScanFile. To define a route along which to send 

oute 

number of options that need to be 
defined to create a working Document Route. Firstly you will need to give the 
route a name and then you can continue onto the next stage. 

folder and/or use
the required ac
move onto the next step in the route. 

If a document routed to a user, it will appear 

o figuring Routes 
Se up can only procee

d inistration rights A
documents, firstly click on Options and select Document Routing from the 
menu, this will return an Edit Process window. Here you will find a number 
of options including a list of any routes that have been defined previously. 
From here select New and you will be presented with the Create R
window. 

In the Create Route window there are a 
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Steps 
Steps are different stages that can be setup within a route. At each of these 
stages you can define a number of users and/or folders that you wish the 
sent document to go to. When sending to users you can also decide what 
those users do with the document after they view it. 

To create a step, click on the Add button on the right side of the tree view. 
Select a target for the documents. This can be a user or users of the 
ScanFile system and/or ScanFile Folders. 

If you want to select ScanFile users as step target, click on “…” in the user 
section of the target frame. A window Send to user opens. 
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All available ScanFile users are listed here. 

 version 8 a new user has been added to the user selection of the route: 
[Originator]. This user is a placeholder for the creator of a route in the 
running program. This way you can integrate the creator of a route into your 
route setup without knowing the user. 

In

If you display a route later on in the Remote Service Configuration Tool, you 
will never see the placeholder [Originator] As soon as the creator of a 
route is known to Document Routing, the process will work with the real 
user name. 

Choose the target user or users for the current step. Additionally assign user 
actions that the users have to perform, once a routed document arrived on 
their personal hitlist. Following user actions are available: 

Option Description 

View The View option the user that receives that document 
will only need to view it and confirm the image display 
before it continues on to the next step in the Route 
(Steps are explained above). This is confirmed by 
clicking on the eye symbol on the document. 
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Comment This option then the user that receives that document 
will be prompted to comment on it by means of a 
clipboard button that appears on the document when it is 
viewed. To comment on the document the user must 
click on this button and a text box will appear that should 
be filled out. Any comments they make are attached to 
that document and will continue onto the next step in the 
route. The following users on that Route can then view 
these comments. 

Approve/ Reject The Approve/Reject option allows the user two 
possibilities. He can approve or reject the document by 
clicking on the Approve or Reject button displayed in 
the image window. Where the document is sent to, 
depending on the choice, will be selected when setting 
up a Route. 

View (Password) This option is identical to the action View, but this will 
force the user to enter their ScanFile password to signify 
that the step has been completed. 

Comment This option is identical to the option Comment, but this 
(Password) will force the user to enter their ScanFile password to 

signify that the step has been completed. 

Approve/Reject 
(Password) 

This option is identical to the Approve/Reject 
(password) option, but this will force the user to enter 
their ScanFile password to signify that the step has been 
completed. 

 

If you select the Approve/Reject or Approve/Reject (Password) option, 
there are three actions that can be set to take place when the user either 
accepts or rejects the document. You can apply the action in the window 
Action, opening directly after you chose Approve/Reject. 
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Following options a
or rejects a docume

re selectable to define the action when the user approves 
nt: 

Option Description 

Continue This option will mean that the document will continue to 
the next step of the defined route. 

Jump to The document will jump to the specified step, bypassing 
steps if required. The step you wish the document to 
jump to must be selected here. 

Continue with The document will continue on a different predefined 
Route from the beginning. This route must also be 
selected here. 

Confirm your selected ac
Send to user window. Re

tion by clicking on OK and ScanFile returns to the 
peat this for every user in one step, whose action is 

 document can proceed to the next step, the user or users assigned 
to a step must perform the action assigned to them. If you have assigned 
more than one user to a step on the route, you can select that the document 

 

Send To Folders 

s as step target, click on “…” in the 
Folder section of the target frame. A window  opens. In 

Another option of Document Routing is the Timeout Action; this option 
determines the length of time a Document is retained within a single step of a 
Route. This can be extremely useful, for example: 

A route has been setup with one user on step one and another user on step 
two. A document is sent to that route by a third party user however, User One 
is not available to view the document. This would mean that User Two does 
not get to view that document until it has eventually been viewed by User 
One. 

different than View. Return to the window Create Route by clicking on OK.  

Before a

can proceed to the next step if one of the users has performed the action 
assigned to them. This can be done by ensuring the All users must perform 
action option is not selected. If this option is selected, all users assigned to a 
step must perform their action before the document can progress.

If you want to select ScanFile Folder
Available Folders

here are folders that have been previously set up on the system. Select the 
target folder or folders for the current step. Once you have selected one or 
more folders from the list click on OK and they will be entered as part of a 
step on the route in the window Create Route. 

Timeout Action 
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To avoid this happening you need to define a time limit that a document can 
reside in one step of the Route. By selecting the Use Timeout Action it is 
possible to define a Retention Time Limit, this can be done in units of Days 
and Hours in the boxes on the Create Route window. There are 3 directions 
available, per step that a document could take should the retention time have 
elapsed: 

Option Description 

Route to Next Step Once the defined Retention Time has elapsed it will 
move the Document onto the next step of the Route. If 
there is no next step defined then the document will 
remain at that step until it is viewed. 

Route to Previous 
Step 

Once the defined Retention Time has elapsed it will 
move the Document back to the step before it. If there 
is no previous step defined then the document will 
remain at that step until it is viewed. 

Route To Sender Once the defined Retention Time has elapsed the 
document will be moved into the personal hitlist of the 
user who originally sent that document to the Route. 

 

The Timeout Action is only valid if that particular step of the Route 
includes a user. Timeout Actions do not have any bearing on Folders as 
targets.  

After creation of one step, click on the Save button. The step will appear as a 
tree node in the tree view of the Create Route window. In this tree view you 
can see all steps and their assigned targets and user actions. If you wish to 
edit a step, select the node and edit its settings. You can discard your 
changes by clicking on Cancel. If you click on Save, your changes will be 

move any of the steps 
lete button. 

O

m setting up Routes there are two settings for the general Routing 
process. 

saved and the tree view is updated. If you wish to re
defined, highlight the required step and click on the De

ther Routing Options 
Selecting Options -> Document Routing opens the Edit process window. 
Apart fro
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Save Job Reports 

g file in the Save job 

on is kept within ScanFile when a 

nformation 
 

 to zero will retain that information 
until a higher value is entered. 

c g 
he ent Route actions that are 

ry of actions that 
ill also show the document 

Sending to a Route 
s  a route is done by clicking with the right mouse 

utton on the document(s) you wish to send in the Hitlist and select Send To 

Details of the actions performed by the Document routing can be saved to a 
text file. This will record information on all the steps for each defined route. 
You can specify the name and location for this lo
reports in field. 

Clear Completed Jobs 
In addition to the Timeout Action there is another time related option. 
Database, Image and instruction informati
document is sent to a Route, even when the Route has been completed and 
the document has reached its final destination. Clear Completed Jobs will 
clear all of this information from within ScanFile after a specified time limit 
entered in the box on the main Document Routing window. If this i
is not cleared additional hard drive space can be taken up by this, usually
unwanted, information. 

Setting the Clear Completed Jobs time

A tive Route Lo
T
currently in progress, listed in here you will find useful information regarding 
the current stages of a document that has been sent to a Route: 

Route Name, the name of the user who sent the document to the Route, the 
Status of the document, the active user or user who currently needs to action 
that document, the time it was sent to that Route, and the time remaining 
before the next step of that route times out. 

To view any of the Route information in more detail, highlight the required 
Route and click on View. This will give a more in depth histo

 Active Route Log is a report of all Docum

have been progressed for each document, and w
index details and any comments that were made on the document. 

As igning a document to
b
Route. This will display a window listing all Routes that have previously been 
setup. Select the Route you wish to send the documents on and confirm you 
selection by clicking on OK. 
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Also on this window is an option called Split Records, this is used if multiple 
documents are being sent to the Route. If selected, each document will be 
treated separately on the route. All required user actions along the route will 
be requested independently from each document. 

If Split Records is not selected then multiple documents that are being sent 
will be batched together, and treated as one route task. All required user 

s have been 
processed. 

Viewing Routed Documents 
Any documents sent to a route will appear in users Personal Hitlist. They can 
be identified by the name of the sender being SFROUTE'. 

Local Copy 
By default, once the action has been performed and the document 
progresses to the next step of the route, it will be deleted from the Personal 
Hitlist. You can however choose to keep a copy of the document by clicking 
on the Keep local copy checkbox before performing the action. This copy 
will not be updated with the changes done to the document while it is sent 
along the route. 

Actions 
When the document is displayed, action icons will appear corresponding to 
the actions assigned for that step of the route. The three actions are View, 
Comment and Approve/Reject. 

For Comment and Approve/Reject actions, a window will pop up to allow 
you to add comments concerning the document. The comments associated 
with a document can be view by pressing the Route icon, which is displayed 
in the top right corner of the document display window. 

Before the document can progress to the next step of the route, the action 
assigned to the user must be performed. To do this, click on the action icon. 

actions along the route will only take effect, when all document
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R
e Service is part of the ScanFile Remote Services. Its 

a r the current routes and to send on documents, 
 of these routes. 

outing Service 
Th  Document Routing 
m in task is to monito
depending on the settings

The Document Routing Service in ScanFile Remote Services must be 
running to allow the Documents to move from step to step within a Route. 
This is described in the Remote Services chapter. 

For more information, please refer to the corresponding chapter in this guide. 
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Printing, Email and Export 
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Overview 
ScanFile has comprehensive facilities for the printing of scanned documents 
as well as for exporting both indexes and documents for use outside of 
ScanFile. 

P

• Currently displayed page of a document 
• All pages in the selected document 

a range of pages from the currently selected file. It 
he opportunity to choose the printer you wish to print to. 

 in the toolbar has different functions depending on which 
n at the time it is pressed. 

rinting 
With ScanFile, you can choose from several options for printing: 

• Range of pages from the selected document 
• Selected pages from the selected document 
• Selected documents  
• Hitlist 
• Audit Trail Events 
 
Selecting the Print Image option from the File menu allows you to print the 
currently selected file, or 
also gives you t

The Print button
ve wi dow is acti

Window Action 

Image Window Displayed image is printed 

Hitlist Window The selected hitlist documents are printed 

Fastpic Window The selected images from the current document are 
printed 

 

Selecting Print Hitlist from the File menu will print the Hitlist. 

 

When printing scanned images, various options are available. These can 
be selected from the General Settings dialogue. The options and their 
explanations are listed in the chapter General Settings. 
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Email 
Use the pop-up menu of the hitlist to create an email with the selected 
document attached. Therefore right-click on a document in ScanFile, choose 
Send To -> E-mail option and ScanFile opens a new message window in the 
PC's default e-mail software, and attaches the selected document(s). 

l 
Settings. Electronic documents will be copied in their native format. 

E
It is possible to export the contents of a folder for use with other systems. An 
ASCII file will be created with the index information and references to the 
exported image files. 

Selecting Export Folder from the File menu will display the following 
dialogue: 

Scanned, multi-page documents can be converted to single page Tiff, multi-
page Tiff’s or PDF file, depending upon the option selected in Genera

xport 
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Before starting the export, the directory the information will be exported to 
must be selected. The number of TIFF images to be written to each directory 

ate TIFF files for each page 
of a document. 

 is selected, ScanFile will export keywords as additional 
document index. If a document is not connected to a keyword, the index will 

re than one keyword is assigned to a document, the 
ted as many times as it has keywords assigned to, 

every time with a different one as additional index. 

the selected export directory, and these will contain the TIFF 
images. The number of TIFF images in each directory is dictated by the 
Images per Folder parameter. Each subdirectory created will also have an 
INDEX.DAT file, which holds the index information related to the images. 

The result is shown in the example below. 

can also be set, as well as the field delimiter for the data file. The delimiter is 
the character within a record line used to separate the index records. A 
comma is normally used for this purpose. Multi-page documents can be 
exported as either a multi-page TIFF file, or separ

If Export keywords

be left empty (““). If mo
document will be expor

Pressing the OK button starts the Export. Subdirectories called ASCII_xx will 
be created off 
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Overview 
D d in
folder in a number of ways 
i lder
earlier in this Guide  options. This 
chapter describes the import features available. There are three choices for 
i

• Files only 
• Index 
• Index information only 

I

ocuments an dex information can be imported or sent to a ScanFile 
and formats. Any format of document can be held 

n a ScanFile fo  and viewed from either the folder or a library. Explained 
 were TIFFWriter and the Send to ScanFile

mporting: 

 Files and information 

mport Files 
Select Import -> Files from the File menu, and the import screen will be 
shown. 

 

Any format file can be selected for import,.Select the drive and directory 
where the files to be imported are, highlight the file or files to be imported, 
and then click on OK. The files will then be placed in the Postindex pool. 
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In
T index records in existing folder 
d
m
An external can have that number in it plus the Document Name, Document 

o etc. The Project Number can be set to be the Connect field, and the 
mation will then be imported to the appropriate records. 

dex Information 
he Import index function is used to fill 
ocuments with additional information. As an example, bar-coded documents 
ay have been scanned, with the barcode representing a Project Number. 

N
additional index infor
To open the Import select the File –> Import -> Index menu. 

 

Th  example text file shows e 10 records, with the index information within the 
c  by commas. The first field is the Project Number – 

information. 

From the File menu, select Import Index, and then select the data file that 
ove will be shown. The Folder 
ields from the import file can be 

matched to these. It is very important that the No. of fields, parameter is 

re ords being delimited
the Connect field – which already exists in the folder. The Import will use this 
to search for matching records, and then fill the other folder fields with the 
additional 

holds the index information, the screen ab
fields will be displayed on the left, and the f

correctly set, as well as any field separators and delimiters. Once the import 
has been set up, the import can be started by pressing the OK button. 
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F
Files and their associated index information can be directly imported into a 
ScanFile folder. An ASCII file may hold the index details for project 
information, and will also hold references as to which TIFF files belong to a 
particular record. This can be read into ScanFile, the index records created 
automatically, and the images imported and associated with the correct index 
record. 

iles & Index Information 

 

This option is also used to import index information with no associated files. 
This allows you to create 0 page records in a folder to add documents to at 
a later date. 

F
It is very important when importing index information from a text file that the 
index records are formatted correctly within that file. 

rt on a new line within the text file. This can be 
easily verified by opening the file in a text viewer such as Notepad. When 

ne Feed) ASCII characters to the end of 
each record. 

ile Format 

Firstly, each record must sta

exporting data from other applications, most of the applications will 
automatically start a new record on a new line. They do this by adding the 
CR (Carriage Return) and LF (Li
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The format of each record within the import file is also very important. When 
importing multiple index fields into each record, ScanFile expects each field’s 
index information to be separated by a character. The most common 

• Field #1: 12345 

e index information correctly. 

r characters, even a character that is 
used as Field separator, will be used as index information. 

Y“,“Phase X,Y“,“Customer Y “ 

The comma (,) separates the four fields: 

 field content would be divided into two different fields. 

of an 
import file to import index information and their related files. 

character used for this is a comma (,). See the following example: 

12345,Project XY,Phase X,Customer Y 

The comma (,) separates the four fields: 

• Field #2: Project XY 
• Field #3: Phase X 
• Field #4: Customer Y 
 
These four fields can be assigned to the index fields in the import folder. The 
options No. of fields and Field separator must be filled with a 4 and a 
comma (,) so that ScanFile is able to import th
As a Field separator every character that is not part of the index information 
itself can be used. If the Field separator occurs in the index information a 
Field delimiter can must be added to separate the fields. The Field 
delimiter must be the first and the last character in each field. If so all 
characters between the field delimite

“12345 “,“Project X

• Field #1: 12345 
• Field #2: Project XY 
• Field #3: Phase X,Y 
• Field #4: Customer Y 
 
The example uses a quote sign (“) as Field delimiter. Without the Field 
delimiter the comma (,) in field #3 would also be interpreted as Field 
separator and the

In addition to the import of index information ScanFile is also able to import 
index information and related files from. In this case the index file must 
contain the index information and the document filenames. All files must be 
located in the same path as the index file itself, or have the path to the file 
location as part of the filename. The following example shows a line 

“12345 “,“Project XY“,“Phase X,Y“,“Customer Y“,”01.tif”,”02.xls” 
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ScanFile would find the following information: 

• Field #1: 12345 
• Field #2: Project XY 
• Field #3: Phase X,Y 
• Field #4: Customer Y 
•  
• File #1: 01.tif 
• File #2: 02.xls 
 
The example shows the index information and tow related files. The file 
named 01.tif is a TIFF file that is directly imported to the chosen folder. When 
importing TIFF files, these can be either single or multi-page Group 4 TIFF 
files. The second file named 02.xls is a Excel file that will be appended to the 

f the TIFF file. document after the last page o
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Overview 
The optional ScanFile COLD (Computer Output to Laser-Disc) module allows 
the import of computer generated spool data into ScanFile folders. This data 
can be combined with scanned or other imported documentation to give a 
complete, comprehensive document storage system. 

ted 
invoices, and automatically create index records to the appropriate pages. 

res required by the COLD 
 data formats. 

Supported File Formats 
must be 

 into the following formats, although 

The ScanFile COLD module supports the above formats, although other 
ta within the file to act as 

The COLD module will take the spool data, such as mainframe-genera

This manual explains the setup and import procedu
module, and details the supported import spool

A spool file can contain many thousands of pages of data, which 
divided into pages and have index data associated with those pages. 

Generally, spool data can be divided
other formats are in use: 

• Spool Files 
• COM 1 Files 
• COM 2 Files 
• Text Files 
 
Spool files will have the 'FF' character (Hex OC) to signify page breaks within 
the file. 

COM 1 files use the first column of the file (the first character in each line) to 
specify page breaks and other formatting. 

COM 2 files use the first 4 columns to control page breaks. 

Text files generally should have a fixed number of lines allocated for each 
page. 

format files can be imported by specifying other da
page break characters. 
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T

 and 
 

character spacing. 

ed to import spool data from 
mplate was created from. 

he Import Template 
For each spool data format, an import template must be created. The 
template specifies the import file type, the indexing information location
the display formatting such as overlays and font, font size and line and

Once a template has been created, it can be us
any file that has the same format as the file the te

Creating a Template 
To create an Import template, choose the COLD -> Open/Import and the 
Template list will be displayed. 

 

From this screen, select New Template, and you will ed to give a 
name to the template. This name should be associated with the data format 

ame you wish to give to the template, press the 
be asked to choose the spool file to be used to 

ALL Files option 
from the List of File Types drop-down list. Select the spool file you wish to 
use from the list and then click on the OK button. 

Once the spool f  
Edit Template window within ScanFile. This window is where all the 
parameters associated with the template can be set. 

 then be ask

being imported. Type in the n
OK button, and you will then 
design the template. 

By default any file with the extensions *.TXT, *.DAT and *.ASC will be listed, 
although if the file has a different extension, choose the 

 ile has been chosen, the data will be displayed within an
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If he spool t file has no page break character (Hex 0c) within it, a message 
e displayed. If this is the case, the file must contain a fixed 

page, or must have a unique value within it other than 
 be used to signify a page break. 

lso, the Hex 0c filters must be removed. See the section on Filters for 
n on this. 

To ensure that the COLD module pages the file correctly, choose Edit -> 
Page Settings within the Edit templates  the Setup screen will 
be displayed. 

stating this will b
number of lines per 
Hex 0c that can

A
informatio

Spool File Type 

 window, and
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From this screen you can attempt to automatically detect the file type by 
e Auto Detect button. This option will detect whether the file is a 

COM1 or COM2 format, and show the file type accordingly. If it is not one of 

ither manually or by the Auto Detect function, 
click the Apply button, and then choose OK. You will then return to the Edit 

 specify the actions to be carried out, when a certain 
character or sequence of characters within the spool file is encountered. By 

ge break filter is created for each new template. For spool files 

The Filter parameters screen will be displayed, showing the pre defined 
page break filters. 

pressing th

those, the Auto Detect will attempt to find a non-standard page break within 
the file. If it cannot do this, the parameters must be set manually. In the 
Lines per page field, specify the number of fixed lines allocated to each 
page within the spool file. 

To set the options chosen, e

template window. 

Filters 
Filters are used to

default, a pa
with no page break characters, these must be removed. To do this, choose 
Edit -> Edit Filter within the Edit templates window. 
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Highlighting a filter and pressing the Delete button will remove it.  

The options that can be performed against a sequence of characters are 
shown below, and can be accessed by clicking in the CharOption column in 
the row of the sequence you wish to set an option for. A drop down list will 
become available, allowing you to select the required option. 

Option Description 

Cut Out This option will remove the selected sequence, and 
move any text to the right of the sequence, to the left 

Blank Out This will replace the selected sequence with spaces 

Page Start This action can be set to identify the selected sequence 
is useful if 

 character, 
of characters as the start of a new page. This 
the import file has no identifiable page break
and does not have a fixed number of lines per page 

0 is option is normally used with COM1 and COM2 
ny 

line feeds Th
format files. The sequence selected will not evoke a
line feed. 

One line feed The sequence selected will be replaced by one line feed 

Two line feeds The sequence selected will be replaced by two line 
feeds 

Three line feeds The sequence selected will be replaced by three line 
feeds 
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Additionally to the CharOption the Valid Range drop down list is used to 
identify the area of the import file that the filter should look and act upon the 
selected sequence. The options available are described below. 

Option Description 

This Position Will only perform the action upon the sequence at the 
position in the import file where the text was highlighted 

Start to Here Will perform the Action from the start of the import file, to 
the selected sequences position in the file 

Here to End Will perform the action from the location of the selected 
sequence to the end of the file 

Entire Text Will perform the action upon the entire file 

 

Once the Filter Parameters have been set, the spool data should be 
displayed, and you should be able to page through the file correctly. 

rmation such as printer control codes 
whether text should be in bold or underlined. These 
ifferent ways in the spool file, but they should not be 

shown when the file is imported into ScanFile. 

As an example, the code '#BLD' is shown in the spool file at the start and end 
of a piece of text. This signifies that when printed, that text should be printed 
in Bold. This code needs to be hidden or removed when the file is imported, 
and the filter can be used for this purpose. 

This can be done by highlighting the code in the Edit template window, and 
then choosing New Filter from the displayed menu. From the CharOption 
column within the Filter Parameters window, the Cut out option can be 
chosen. Select Entire Text from the Valid Range drop down list to filter the 
code from the text. 

Repeat this for every control code. 

Index Fields 
The COLD module, when importing the spool data into a ScanFile folder will 
not only import the page information, but will also create the index records 
associated with the pages. To do this, the location of the index information on 
the spool data page must be specified. 

To add an index field record, highlight the text to be used for indexing in the 
Edit Template window, and a pop-up menu will be displayed. Choosing the 

Some spool files may contain other info
that are used to specify 
codes will be shown in d
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New Index Field option then allows you to ent
can be repeated f

er the index field name. This 
or each index field you wish to create. 

A very important point is that the location of the index data MUST be 
consistent across each page of the spool data file, the location of the index 
data cannot be varied from page to page. 

The index fields MUST be created in the same order as the fields within the 
folder the data is to be imported to. 

 

To view the fields created, choose the Edit -> Edit Field option from the 
menu. From this screen, you can see exactly what has been specified for 

n be edited. For example, you may 

adjusted from this window.

ages. These pages can be grouped into one 
index record in the ScanFile folder, by setting the Group Pages if option. 
This will be displayed if the page grouping data in the Edit Template window 
is highlighted, and the Connect pages option is selected from the pop-up 
menu.  

Any relevant data can be used to group pages together, such as an 
increasing page number, or the same data on following pages as on the first 
page. The required option can be selected by choosing from the drop down 
list, and the available options are: 

• No grouping 
• Increasing Number 
• Empty on next page 
• Not empty on next page 
• As preceding page 
 
Once these options have been set, the raw data is ready to be imported into 
ScanFile. 

Importing Spool Data 

same order. If 
this is the case, choose COLD -> Open/Import, and the Open Template 
dialogue will be displayed. Select the template to be used for the import, 

each index field, and this information ca
not have highlighted sufficient characters for a name field, and that can be 

 

Some spool data files may contain multi-page records, such as an invoice 
being continued over several p

Before you can import spool file data into ScanFile, the folder the data is to 
be imported into must be open. It is also important that the fields specified in 
the import template are the same as in the folder, and in the 
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ensuring that it is the correct template for the open folder, and then press the 
Start Import button. You will then be asked to select the spool data file to be 
imported into the folder. 

Select the correct spool file for the template and the import screen will 
appear. 

 

During the import the screen displays all index fields defined for the current 
template and their processed contents, the amount of imported records and 

 

All the standard image rotate and zoom controls will function with COLD 

the total amount of imported pages. Pressing the Start Import button will start 
the import. 

Viewing COLD Data
Searching for and viewing COLD data is achieved in the same way as for any 
other document stored in a ScanFile folder. A folder may be opened, the 
search criteria entered, the Search button pressed. A Hitlist will then be 
displayed, and the first document shown in the image window. 

data. 
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P
 default paper size, font and font size and line and character 

s will then allow 

w, select Page Settings from the Edit menu, and 
the Settings screen will be displayed 

l options apart from the file type 
t the Graphic option is selected, 

the correct paper size can be set, as well as the font and font size to be used 

Also in the pages settings dialogue you will find a checkbox option called 
OEM Chartable, this, when checked, ignores generally foreign characters 

O

ta headings. Without these 
forms, the data can be quite hard to read, and can easily mislead. For this 
type of spool data, the ScanFile COLD module allows a scanned image of 
the form to be specified for a template, and when the imported data is 
displayed, it will be overlaid on the image of the form. Two separate overlays 
can be specified, for the first page of a record, and for any subsequent pages 
of a record. If it is the same form for every page the Following pages field 
can be left blank. 

When using overlays, it is critical that the text will line up in the correct 
position relative to the overlay form. It is therefore important that an original 
form is scanned to be used for the overlay, and that this is not scaled in any 
way. The form can be scanned using ScanFile or any other program. The 
image file of the scanned page can be used in ScanFile as an overlay.  

age Settings 
It may be that the
spacing are incorrect for the spool data being imported. These can be 
amended in one of two locations. 

After the spool data has been imported, choosing General Settings from the 
COLD menu will display the Settings dialogue. 

When creating or editing a template, choosing the Graphic option from the 
View menu will display the spool data in graphic format. Thi
you to edit the page settings for the spool data. 

In the Edit Template windo

If the Graphic option is not selected, al
selection options will be greyed out. Whils

for displaying the data. 

Please note that although any font can be selected, even TrueType fonts, 
most spool data is printed in a fixed width font. 

from a COLD template, E.g. ã,é,ì,ö,û. If you wish these characters to be 
recognized then uncheck this option. 

verlays 
When spool data - such as invoices - are printed, they are usually printed 
onto prepared forms with named columns and da
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The other options that can affect the alignment are the Overlay Settings. 
Firstly, adjust the linefeed setting, and this will normally ensure that – if the 
correct font and font size have been selected - the data will fit the overlay. If 
any other adjustments need to be done, the horizontal and vertical 
adjustment options can be used for minute changes to the character 
positions. 

The Linefeed setting adjusts the number of pixels between each line of text. 

The Horizontal and Vertical settings move the page of text x number of 
pixels left, right, up or down. 

After changing any of these settings, by pressing the Apply button, you 
should immediately see the effect the settings have had. 

An example of COLD information overlaid on a scanned image is shown 
below. 

 

Imported Files 
For each folder, a list of the files imported into that folder, and the name of 
the template used to import the data can be displayed by choosing the List 
Imported files from the COLD menu while the folder is open. 
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Overview 
LuraDocument®, an option of ScanFile, is a document compression 
procedure which preserves text legibility together with high visual and colour 
quality. The basis of the LuraDocument procedure is the analysis and 
segmentation of documents. 

Mixed documents are segmented to generate the following three images: 

•
•
•
 
The three images are then individually compressed using the most 
appropriate efficient techniques. 

ticularly suited to documents scanned at a resolution of 

xt is removed from the original document to generate a colour or 
greyscale image containing the image regions and text background. This 
image is compressed using a specially adapted version of the "LuraWave" 

remely difficult 
ificantly higher 

compression performance to be achieved. 

The removal of image regions from the Bitonal text image makes high 
d with a 

ata 
10%-40% smaller than that achieved by CCITT Fax Group 4. 

e Bitonal text image is 
compressed with the original document resolution while the background and 

Selecting LuraDocument 
L
folder when creating or editing a folder. Select File -> Setup Folders and go 

ion 
the 

 a binary image containing text 
 a foreground image preserving the text colour  
 a background image with the text removed 

LuraDocument is par
300 dpi or higher, containing large image regions together with text. 

The separation stage uses the segmentation to separate the document into 
three images of different resolutions:  

The te

wavelet based image coder. The removal of text regions - ext
structures for image coders to compress - enables a sign

compression rates possible. The Bitonal text image is compresse
LuraTech developed context-based coder, generating compressed d

A third image, containing colour for text regions, is generated and 
compressed using the "LuraWave" wavelet coder. Th

text colour images are coded with a reduced resolution. 

uraDocument can be made the default image compression format for a 

to the Extended settings tab. On the tab you find the Import compress
format field, which represents the default image compression format of 
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folder. You can choose between LuraDocument or TIFF G4/JTIF format. 
This can be changed any time. 

Additionally you can use the LuraDocument compression within the scanner 
setup for the DR-5020/5080c, DR-3060/3080c, DR-5060F and MS-800. 

LuraDocument Settings 
The settings can be viewed and amended from two places in ScanFile. In 
Scanner Setup for the Canon DR-5020/5080c, DR-3060/3080c, DR-5060F 
and MS-800 when you select LuraDocument as the compression format, a 
tool icon will be displayed. Clicking on that will display the settings screen. In 
addition, you can select it from the Options -> Compression menu. With 
either option, the configuration screen will be displayed. 

 

Predefined Settings 
 pre-defined settings that can be used that for differing types There are three

of documents to be scanned. Additionally, these formats can be optimised for 
Internet retrieval using ScanFile WebServer. 

Option Description 

 

This will set the compression to the optimum settings for 
graphic only images 
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The compression will be optimised for images that are 
mixed text and graphics 

The compression w

 

ill be set for text only images 

 

There are also 5 quality levels that will affect the compression levels of the 

es. An interrupt 
of the transmission results in a smoothed but full-size image 

Expert Settings 
The Expert mode allows you to alter the compression and quality levels of 
the image segments. These are divided into: 

• Bi-tonal 
• Foreground 
• Background 
• Thumbnail 
• Miscellaneous 
 
Bi-tonal 

The Bi-tonal settings are for the text part of the image and can determine 
how the text is segmented and stored, and the compression level. Following 
options are available: 

foreground and background images, but will not affect the text compression. 

The Internet optimised storage will change the storage mode to 
Embedded. The image can then be displayed progressively. The quality 
becomes continuously better during loading over telephone lin

Option Description 

Mode This sets the compression format in which the text is 
saved. This can be (LuraDocument) LDF, TIFF G4 or no 
compression 

Segmentation This defines whether the image is all text, a mix of text and 
graphics, or all graphics. An auto mode is also available 
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Mask The mask sets how LuraDocument processes the image 
text. It can adapt it's processes dependant upon specific 
parts of the image, or process the whole image using the 
Constant setting 

Quality The quality can be set from 1 to 100 

 

Foreground 

The foreground image saves the text colour information, and can be set for 
differing levels of compression and quality thresholds. 

Option Description 

Mode This sets the foreground image to Baseline or Embedded. 
You can also select no (None) settings. 

Sample The value is the down-sample rate. The higher the value, 
the higher the compression and lower the image quality 

Min. Quality This sets the threshold for the minimum image quality,
which if not achieved , can

 
 override the compression level 

 

Baseline 

This mode does not consume as much working memory as the embedded 
mode. It is the only available mode if you compress very large images. The 
resulting image is partly embedded. The compression is a little bit faster than 
in embedded mode. If you display a baseline compressed image in your 
homepage and you have a bad transmission capacity the image will be 
displayed in top-down mode. 

Embedded 

This allows the image to be displayed progressively, and is optimised for 
internet delivery. The quality becomes continuously better during loading 
over telephone lines. An interrupt of the transmission results in a smoothed 
but full-size image. 

Thumbnail 

These settings affect how the thumbnail is generated and stored. 
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Option Description 

Mode This sets the thumbnail image to Baseline or Embedded 

Min. Quality This sets the threshold for the minimum image quality, 
which if not achieved, will affect the thumbnail generation. 

 

Miscellaneous 

You can set a compression factor that LuraDocument will attempt to achieve. 
The factor can be set from 1 to 100. 

The compression that can be achieved using LuraDocument depends on 
m
n
influenc
text layer is always compressed lossless. For the background image and the 
text colour image the quality or compression ratio can be chosen. 

can be controlled via the size of the text layer 

If a compression factor set during compression, the system will try to achieve 
this compression exactly. However it is possible that the text layer is too huge 
or that in order to guarantee the minimal requested image quality the actual 
rate may be higher. 

To reach maximum compression two things should be observed: 

• As the text layer is compressed lossless, the text layer has to be kept as 
small as possible: 

• Automatic text detection will always result in smaller text sizes that the 
setting "everything is text". However if the text sensitivity levels is too low 
some letters may not be detected. 

 
High compression ratios may also be obtained by lowering the minimum 
image qualities. Another way to increase compression is to lower the 
resolutions for text colour image and the background image. This can be 
done if the document has a simple structure. 

 

any factors. In general are documents with higher resolutions (high dpi 
umber) easier to compress. The complexity of the document has a major 

e. If the amount of text is very high compression is very difficult as the 

So the total compression ratio 
(dependent on the settings of quantization and segmentation) and the quality 
of the fore- and background images. 
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O

 WebServer events are also 

A
ed report, options have to be selected to determine which 

events are to be recorded. Select Audit Trail Report from the Options menu 

verview 
The Audit Trail option in ScanFile tracks and records any event performed in 
the application. This is used primarily by system administrators and can be 
customised to track a number of different events.  

The Audit Trail option will display the recorded event information in an event 
viewer format, which can also be printed. 

In addition to recording ScanFile events,
recorded within the Audit system.  

udit Configuration 
To create the requir

to open the following window: 

 

Click on the button Audit Trail Configuration  from the main Audit 
Trail Report window and this will display the configuration window. 
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The option Activate audit trail allows you to switch the auditing of events on 
or off. If the option is checked, the events selected are recorded. 

In the configuration window there are a number of tabs, each headed for 
various areas of ScanFile where events can be recorded. An example of this 
is the Folder tab, where it is possible to select from a number of events that 
can be recorded when working with Folders. If you wish to record the event 

 have been defined click on OK to save the 

Displaying events 
Once any of the events selected have been activated or modified in the main 
ScanFile program, a list of up to 100 events can now be displayed. To do this 
click on the Filter List button. If the event list that is returned is not specific 
enough there are three ways to narrow down the results so that only the 
events that are currently required are displayed. 

The first option is to select which folders and libraries you wish to display 
events from; these are selected by means of checkboxes on the main Audit 
Trail Report window. Click again on Filter List. The new list contains event 
actions recorded from all users that are related to the selected folders and 
libraries. 

that a folder is opened, closed, modified or deleted and so on then these 
options must be selected by means of the checkboxes. 

Once the required event settings
settings and you will be returned to the main Audit Trail configuration window.  
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The second option to select is the user/s whose event actions are to be 
displayed; this is also done by means of checkboxes in the main Audit Trail 
Report window. 

Thirdly, should you require events to be displayed for a certain date or time 
period this period should be defined by selecting Customized in the 
Duration list and by amending the date boxes labelled From and To in the 
main Audit Trail Report window. Another option here is the ability to define 
pre-determined periods by weeks and months; these are also listed in the 
Duration list. After selecting a time period, click again on Filter List. The 
new list contains event actions recorded in the given period. 

To view an event in more detail double click on it and an Audit Trail Details 
window will be displayed. 

Printing Events Lists 
Once a satisfactory event list has been returned it is possible to print the list 
by clicking on the Print button from the main Audit Trail Report window. At 
this point you will be prompted if you wish to continue and selecting Yes will 

r installed on your system. 

Searching in archived Audit Trail data 

Click on Create Search Pool 

print the report directly to the default printe

 and the window below will open. It 
displays all databases that have been previously exported to ScanFile 
Path\Saveaudit. Select the exported Audit Trail data required for your 
research and click on Create Search Pool. The program will merge all 
selected databases to one temporary database. Return to the Audit Trail 
window by clicking on Close. All Audit Trail functions will now work on the 
temporary database. You can research as usual. 
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If you wish to end your research, click on . The temporarily created 
database will be deleted. The data you are working on afterwards is the 
current Audit Trail database. 

If you close the Audit Trail window, the temporary Audit Trail database is 
also deleted. If you reopen the Audit Trail window again, the current Audit 
Trail data will be displayed. 
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What is Codeless Connector? 

t benefit of 
a Codeless Connector is to take over data from another application for 
indexing or searching with a simple keyboard combination without big 
programming expenses and effort. 

With Codeless Connector a link can be created between ScanFile and fields 
(for data entry/display) in any other windows application. The grea

The principle of Codeless Connector is based on the module name and the 
ID of the control used. Controls are objects like buttons, menus or fields to 
be filled out. The contents of the controls (fields) are read and passed on to 
ScanFile. In this way the retrieving of information is independent of the 
application used. 

Requirements 
A license has to be provided for each user, who wants to use the Codeless 
Connector. The configuration is done via menu Options -> Codeless 
Connector. The windows application you want to transfer information from 
has to be installed on the same machine where you setup the application 
links. 

Configure Codeless Connector 

With selecting Options -> Codeless Connector -> General Settings the 

The following steps must be carried out for configuration: 

• Configuration of keyboard shortcuts for transfer of field contents. 
• Creation of one or more Codeless Connector connections to different 

applications 

Configuration of Keyboard shortcuts 

keyboard shortcuts can be configured. For each function (Search, Edit, Scan) 
the keys Ctrl, Alt or Shift and a character can be selected. Mouse clicks can 
also be used as shortcuts.  

Please note, that the combinations configured must be unique for each 
function and must not interfere with other shortcuts (also from other 
applications). 

The following image shows the window to set up the keyboard shortcuts: 
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Via the tabs Hotk ortcuts are 
setup. The first will trigger the actions only for the active field, the latter will 
trigger the actions  party application. 

Configuratio
Select Options ->
new connection to
be taken. Select a
the content of the urce application should be imported. 

eys (single) or Hotkeys (all) the keyboard sh

 for all defined fields of the third

n of a Codeless Connector link 
 Codeless Connector -> Create Link in order to create a 
 a field. A dialogue window is displayed, where actions can 
 target folder or library and a target index field, into which 
field from the so

Folders and/or libraries and index fields have to be created beforehand to 
be selectable here. 

Clear fields 

If this option is se  ScanFile are cleared before the new 
inde
s  new info
ScanFile. 

ApplicationID 

T  crosshair

Open a windows a
on the crosshair in
drag the crosshai
the mouse button
the ApplicationID 

Example with Windows calculator: 

t, all index fields in
x information is r

et, the
etrieved and filled in by a shortcut. If this option is not 

rmation is overwriting the existing index information in 

he little  icon on the left is used to link the fields. 

pplication from which a field entry should be retrived. Click 
 Codeless Connector, keep the mouse button pressed and 

r to the relevant field in the windows application. Release 
, when you have selected the field you wish to link. Next to 
appears a unique application/field identifier. 
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Connections with fields are possible with any windows application using 
controls. Fields ot be linked because the from JAVA applications cann
controls cannot be read separately. 

Use Codeless Connector 
In order to retriev
relevant applicatio
application and a
The content of the  in ScanFile 
and the predefined

 

e field entries and trigger an action in ScanFile, start the 
n and ScanFile. Display the linked fields in the windows 

pply the configured shortcut to retrieve the field contents. 
 field(s) are now passed on to the linked fields
 action (Search, Edit, Scan) is performed. 
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O

ave built-in CD Writing software, and therefore a 
ird party application is required. Normally, this will be supplied with the CD 

al method of CD writing is to specify within the CD writing 
tten to CD and then choose the write to 

verview 
Once a folder has been completed, and is no longer required to be updated, 
it can be archived to other media such as CD. There is also an option to put a 
retrieval only version of ScanFile on to a CD with the folder or folders so that 
the information can be retrieved on any PC running MS Windows, even if that 
PC does not have ScanFile installed on it. A CD Ticker is required for 
preparing such an executable. Ticker will be described later on in this 
chapter. 

ScanFile does not itself h
th
writer. The norm
application the information to be wri
CD option within the application. 

Form Windows XP on it is possible to burn data on a CD without third party 
software. For more information refer to your Windows Help. 

CD Preparat
To select CD Preparation enu, or click on 
the toolbar button and the D

ion 
, choose that option from the File m
 C  Preparation screen will be displayed. 
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There are two ways to prepare ScanFile Folders for archiving. Either you 

Standard Preparation 
By dropping down the CD Pool Drive option in the CD Preparation window, 

 and then 
clicking Add, or by clicking Add All, which will add all the folders from that 

advisable to 

choose Standard Preparation or Fast Preparation. 

the drive to which the folders will be copied can be selected. Next, select the 
drive(s) containing the folders to be copied. Select the folders you wish to 
add to the CD Pool individually, by highlighting the folder name

drive to the CD Pool. 

Ensure that the maximum capacity of the CD pool doesn’t exceed the 
capacity of your storage media. When writing to CDs, it is 
reserve 5% of the disk space for the CD writing program for creating and 
closing the writing session. 

The only other option to select at this stage is the Bundle TIFF Files option. 
If this is selected, all the separate TIFF files within a folder will be combined 
into one large ‘Container’ file, which has advantages when it is intended to 
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place the CDs into a jukebox. If this is not selected, the TIFF files will be 
copied individually. 

After the folders and options have been selected, click the OK button to start 
the process. A prompt will then appear asking whether a copy of the retrieval 
software is to be copied. If Yes is selected, the application will be copied to 

gle will be 

Y
r a password 

 to be entered twice. 

al file, validating the folder for the 
use with the Retrieval Software. 

te preparation finished, the contents of the CD_TRANS.CD 
e CD. 

With Fast Preparation, the folder is not copied into a CD_TRANS.CD 
 location. The folder will have a special 
it to be used with the retrieval version of 

rchive drive will be 
added, and the retrieval software copied to the CD_TRANS.CD directory of 

p giving you the location of the selected 

the CD_TRANS.CD directory. Such a CD can be used in any PC for retrieval. 
The amount of the CD Tickers stored in the hardware don
decreased by one. Select No to create a CD without retrieval program. In this 
case the amount of CD Ticker isn’t reduced. 

If es was selected, the folders can be secured with a password to stop 
unauthorised access. A prompt will be displayed asking whethe
should be applied. To avoid mistyping, the password has

When Ok is pressed, the CD_TRANS.CD will be created on the Pool Drive, 
the folders will be copied, and, if selected, the retrieval version of ScanFile 
will also be copied. 

The preparation starts. If missing, the folder CD_TRANS.CD on the CD Pool 
Drive is created, and the selected folders and retrieval software will be 
copied. Each folder receives an addition

Af r the CD 
dir ctory can be copied to 

Fast Preparation 

directory, but is left in its original
archive file added to it to enable 
ScanFile. Also, the retrieval software will be copied to the CD_TRANS.CD 
directory of the pool drive. 

The process for selecting the folder is the same as described above, but to 
start the Fast Preparation, click on the Fast Preparation button in the CD 
Preparation dialogue. The folder will be checked, the a

the pool drive. A window pops u
folders and retrieval software. 
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CD Tickers 
If you wish to create a ScanFile Executable CD with a retrieval only version 
of ScanFile, this will require a CD Ticker. These can be purchased in groups 

able CD preparation will use one CD ticker. 
llowing you to put the retrieval only version of ScanFile 

on a CD. You can create as many copies of that CD as you wish. 

ickers can be displayed by 
clicking Options - Display ticker status. 

W

 standard preparation, the retrieval software and all 

With Fast Preparation, the folders are left in their original location and the 
software will be copied to CD_TRANS.CD directory, and they can therefore 
be selected and copied directly. 

Please refer to the manual supplied with the CD writing application for exact 
instructions on using the application. 

from your supplier. Each execut
These are licences a

Each time you purchase a group of tickers, you must give your dongle serial 
number to your supplier, who will then send you a PickUp Code. This PickUp 
code has to entered clicking Internet licence or be loaded via file transfer as 
described in chapter Licensing. The number of T

riting to CD 
How this is achieved, and what facilities are available will be dependent upon 
the software being used to write the data to a recordable CD. 

If you have chosen the
selected folders were copied to CD_TRANS.CD directory. The contents of 
the CD_TRANS.CD directory can be written to CD. 
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Overview 
ScanFile has built

• DR-3020 
• DR-3060 
• DR-3080C MS350 
• DR-3080CII • DR-5010C • MS400 
• DR-5020 • DR-6080 • MS800 

0F • DR-7580 • CR-180 
• DR-5080C • DR-9080C • CF510 

SCSI Connected Scanners 

to must be specified. This can be 

The correct SCSI ID for the scanner can be selected by using the second 
elect Scanner SCSI ID. For any SCSI device attached to 
tor card, a description of what the device is will be 

displayed next to the SCSI ID 

Scanning Resolution 

 of the image that will be 

-in support for the following Canon scanning devices: 

• DR-2050C • DR-7080C 
• DR-2080C • MS300 
• DR-2580C • 

• DR-506

 

Additionally, ScanFile supports the Panasonic KV-S2026C directly, and also 
supports any TWAIN and Kofax device. 

With some of the built-in drivers, if the scanner is using a SCSI connection, 
the SCSI adaptor the scanner is attached 
done by selecting from the top drop-down list in Select Scanner SCSI ID. If 
there is only one SCSI adaptor card installed in the PC, this will be selected 
by default. 

The scanner itself then has to be selected. A SCSI Adaptor can have up to 7 
SCSI devices attached to it. They are each identified by a SCSI ID in the 
range 0-7. Normally, the SCSI adaptor itself will be set to SCSI ID 7. This 
leaves 0-6 for other devices.  

drop-down list in S
the selected adap

Any scanning device has the ability to scan documents at different 
resolutions. These are measured in Dots per Inch (Dpi). In the majority of 
scanners, vertical and horizontal resolutions will be the same, although 
certain Canon DR scanners can scan at split resolutions. 

The resolution that a document is scanned at will have two effects. The 
higher the scan resolution, the better the quality
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produced. Higher scan reso
image. With file compressi

lutions will produce larger file sizes for a scanned 
on which ScanFile utilises, the file size can be 

lity, whether it is to be 'live' 
o

Test Scan 

ee 
whether these settings are correct. 

Place a document in the scanner feeder and then press the Test Scan 
b men
window. 

The image quality can be checked from this window. The Plus (+) and Minus 
(-) signs in the bottom le a w allow you to 
enlarge and reduce the si  m 
- draw a box around the r play the 
complete image in the Test s oved around 
within the window by pres  
cursor is over the Test Scan window, then dragging the mouse around the 
w

Scanner Con
T 20, D
con ol sheets. The fir
sec nd will affect how 
inserted between page
documents are scanne

For each type of control sheet, four options are available 

• • Detect & Scan, Stop Scanning 

reduced. 

The resolution chosen to scan particular documents will very much depend 
upon the type of document being scanned, its qua

r 'archive' filing, and user preference. 

The Test scan function is available within the inbuilt Canon scanner drivers, 
and allows you to scan a document with your selected settings, to s

utton. The docu t will then be displayed in the Test Scan Display 

ft nd right of the Test scan windo
ze of the image. Pressing the O allows a box zoo
 a ea you wish to enlarge. The # will dis

can window. The image can be m
sing and holding the right mouse button, while the

indow. 

trol Sheets 
he Canon DR-30 R5020 and DR05080c are delivered with two types of 

st type can change the scanner settings, whilst the 
the documents are stored. The Control sheets can be 
s/files and, during scanning, will affect either how the 
d or how they are filed. 

tr
o

• • Detect & Scan, Continue Scanning 
• • Detect & Skip, Continue Scanning 

• • Detect & Skip, Stop Scanning 
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If the Detect & Scan option is chosen, the control sheet is stored in the 
ScanFile folder. If the Detect & Skip option is selected, the control sheet is 
not stored in the ScanFile folder. 

Job Separation control sheets are used to divide documents placed in the 

When a control sheet has been detected, scanning can either continue or 

 option. 

The Function Control sheets affect the operation of the scanner. With these 
 scanning mode can be changed from Text Mode 

 a, by the use of the appropriate control sheet. 
ing mode to 

either single or double-sided scanning. 

S

 selected from Scanner Setup. The most 

Canon DR-6080, 7580 & 9080c 
80 and DR-9080c are high performance A3 scanners 

 up to180 images per minute . They 

0 support black & white and greyscale scanning 
whilst the DR-9080c supports several modes up to a maximum 24 bit colour. 

scanner feeder into separate files when scanned. Place a Job Separation 
sheet between each file, choose the required Batch Detection mode, and 
then scan the documents. 

stop. You may wish to stop scanning so as to enter additional indexing 
information. Alternatively, you may wish to scan everything and then index it. 
In this case, choose the Continue Scanning

sheets, during scanning, the
to Photo Mode, or vice vers
Using The Simplex and Duplex control sheets changes the scann

canner Configuration 
There are many options that can be selected for the scanners, and these are 
split over several screens which are
used options are collected together on the first screen displayed when 
Scanner Setup is selected. The options of the different scanners are 
detailed below. 

The DR-6080, DR-75
with a maximum scanning throughput of
are double-sided scanners with automatic paper size and thickness 
detection. Additionally, document skew is automatically corrected during the 
document feed. 

The DR-6080 and DR-758

The maximum scanning resolution is for all scanners 600 dpi. 
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Scanner Configuration 
The following screen shows the first screen displayed when choosing 
Scanner Setup for the Canon DR-6080, DR-7580 or DR-9080C. 

 

Page Settings 
All three scanners are capable of scanning single or double sided 
documents, and different settings can be applied for each side of a double 
sided document. The first option to select is whether to scan single or double 
sided. Selecting Front, Back, or Front/back scanning from the option on the 
screen above can do this. 

The Fit Image option sets the scanner to automatically detect the size of 
each page scanned, and will adjust the page size to the actual size of the 
document. When this is set, the Page Size option is disabled  

If scanning double-sided documents, different settings can be applied for 
each side of the documents. To use the same settings for both sides of the 
documents, click on the Same settings for back side option. To use 
different settings for each side, uncheck the Same settings for back side 
option, and then choose from the drop down list which side you wish to 
choose to set the scanning preferences.  

For each side, or both sides of a document, the following options can be set. 
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Setting Description 

Page Size Select one of the following document sizes: 

• Letter - 8.5 x 11 Inch 
• Legal - 8.5 x 14 Inch 
• A3 - 297 x 420 mm 
• A4 - 210 x 297 mm 
• A5 - 148 x 210 mm 
• A6 - 105 x 148 mm 
• B4 - 250 x 353 mm 
• B5 - 176 x 250 mm 
• B6 - 125 x 176 mm 

 
 Fit Image is enabled, this setting is disabled 

Window Page Size Setting: 

If you select the Window page size option, you can specify 

Please note that when this option is used, only the area of 

If

an area of the document to be saved. To do this, select 
Window as the page size, then perform a Test Scan on a 
sample document. A sizeable box will be overlaid on the 
image in the Test Scan window. Size the box over the area 
of the sample document, and the box size and location will 
then be saved. 

the document inside the box will be saved. All other parts 
of the scanned document will be discarded. 

Resolution You can select one of the following: 100, 150, 200, 240, 
300, 400 & 600dpi 

Dither en scanning in black and white mode. 
This applies error diffusion to simulate greys and half-
Use this setting wh

tones on the scanned document. This is useful when 
scanning photos. 

Mode 

g. All other 
settings are applicable to the DR-9080c. The DR-9080c 

an result in extremely large file sizes. 

This option is used to set the number of colours to be 
scanned. Please note that DR-6080 and DR-7580 support 
black & White and greyscale mode scannin

supports 24 bit colour scanning. The larger the bit value 
selected, the more colour shades will be scanned. Please 
be aware that greyscale and colour scanning, especially at 
high resolutions, c
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Rotation A document can be scanned and then rotated and saved. 
The available rotation options are 0°, 90°, 180° or 270°. 

Compression 

• Group 4 Compressed TIFF 

f compression and file format you select is 
upon several factors including the type of 

d 

F: This format will perform no 

ompression format which means that none of 
the original scanned information is discarded. 

ge 
compression mechanism, which is designed for 

images of 
natural, real-world scenes. Jpeg is a 'lossy' compression 
for  data is discarded from the 
or  achieve the levels of 
compression possible. It is possible to vary the amount of 
data to be discarded, and therefore the quality of the 

main nFile has various quality levels for 

nt is a standardised image 

lso a 
‘lossy’ compression format, however, ScanFile includes 

ScanFile will store images in one of four ways: 

• Uncompressed TIFF 

• Jpeg 
• Lura Document 

 
The type o
dependent 
document to be scanned, and the type of output require
of that document once stored. 

Uncompressed TIF
compression on the image data produced from the 
scanned document, and will result in large file sizes. 

Group 4 Compressed TIFF: This format will compress the 
scanned image data, normally by a factor of 10 to 15. This 
is only used for black & white scanned images. This is a 
'lossless' c

JPEG (JTIFF): JPEG is a standardised ima

compressing either full-colour or grey-scale 

mat, which means that
iginal scanned image data to

re
Jpeg images which will determine how much data is 
'dropped' form the original scanned image, and will 
radically affect the size of the file produced. 

Lura Document: Lura Docume

ing image. Sca

compression ratio which is designed essentially for 
compressing either full colour or greyscale images to 
dramatically smaller files sizes. Lura document is a

extensive options for determining levels of quality for Lura 
Document scanned images. 
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Sensitivity 
These settings al
each side of a 
dependent upon 
Photo Mode. Phot

Text Mode 
In this mode, onl
scanners have a t this can be 
overridden and manually set if necessary. 

When the Auto 
brightness setting

The Brightness se
darkest setting, 2
brightness. To ma e, untick the Auto checkbox 
and select any other value as Auto by using the slide bar or typing in a value 
between 1 and 255. 

Photo Mode 

When the  setting is selected, the scanner will automatically sense the 
r the contrast setting required for each page as it is scanned. 

et a brightness or contrast value, 
untick the Auto checkbox and select any other value as Auto by using the 

wing pages. 

low you to adjust the brightness and contrast settings for 
document to be scanned. Different settings will apply 
whether the document is to be scanned in Text mode or 
o mode applies error diffusion to simulate rescaling. 

y the Text Brightness setting can be adjusted. All three 
n automatic brightness function built-in, bu

is selected, the scanner will automatically sense the 
 required for each page as it is scanned. 

tting can be any value between 1 and 255, with 1 being the 
55 being the brightest. A value of 0 will select Auto 
nually set a brightness valu

In this mode, the Photo Brightness and Contrast settings can be adjusted. All 
three scanners have automatic brightness and contrast functions built-in, but 
these can be overridden and manually set if necessary. 

Auto
brightness and/o

The brightness and contrast settings can be any value between 1 and 255, 
with 1 being the darkest setting, 255 being the lightest. A value of 0 will select 
auto brightness or contrast. To manually s

slide bar or typing in a value between 1 and 255. 

Extended Settings 
The Extended Settings option allows you access to the advanced functions 
of the scanners. Many settings are available from this option, and these are 
explained on the follo

Several of these settings can affect the quality of the scanned image and 
they should therefore be used with caution! 
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Double Feed Detection 

 both. When you next 

Subsequent documents’ measurements will be compared against the stored 

The Filter settings can be used to improve the quality of the scanned image, 
eas where the document will not be scanned. 

There are two methods to set the scanner to detect the simultaneous feeding 
of two or more sheets of paper. The scanner can be calibrated for paper 
thickness and/or length. To set Double Feed Detection tick either the 
Detect by ultrasonic or Detect by Length checkbox or
scan a batch of documents, the first page fed through the scanner will have 
its thickness and/or length measured and the measurement then stored. 

value and if the scanned document is thicker or longer than the stored value, 
an error will be displayed. 

 
Filter Settings 

and to set colour dropout ar

Option Description 

Dropout Colour This function is only available with the DR-9080. It is 
available separately for the front and back page. It will 
disable the scanning of areas of the document of a 
particular colour. The settings are: 

• None: Disables Colour dropout 
• Red: Will not scan red parts of the document 
• Green: Will not scan green parts of the 

document 
• Blue: Will not scan blue parts of the document 
 

Automatic Exposure This sets the Automatic Exposure level and affects 
the brightness and contrast settings for the image. 
This has a valid range of 1 to 9 and can be set by 
moving the slider bar, or using the arrow keys to 
increase or decrease the value. 

Edge Emphasis This can be used to emphasis contour lettering, as 
well as softening scanned images such as photos. 

has a valid range of 1 to 5 and can be adjusted 
by moving the slider bar, or using the arrow keys to 
This 

increase or decrease the value. 

 

Other Options 

Other settings are available and these are detailed below: 
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Option Description 

Verify Count This can be used to ensure that a known number of 

Before scanning, the number of pages to be scanned 
can be set, and if that number of pages is not fed 

pages are being fed correctly through the scanner. 

through the scanner, an error will be displayed. 

Simple Staple 
Detection 

The scanner has a simple staple detection for 
document feeding. When the sensor detects a staple 
in either upper corner, the scanning process is 
automatically stopped. 

Deskew by roll This function activates a hardware based deskew of 
sheets to ensure the correct feeding of pages. 

 

Imprinter Option 

I ptio
configured by selectin Settings 
screen.

The Imprinter option a d symbol 
characters at any position on a back page as it is being scanned. You can 
a  charac

To set the Imprinter to print text on a page as it is being scanned, tick the 
P  
Embed to image checkbox. 

f the Imprinter o n has been installed in the scanner, this can be 
g the Imprinter option from the Extended 

 

llows you to print specified alphanumeric an

lso embed the ters to be printed in the scanned image. 

rint checkbox. To embed the text as part of a scanned image, tick the
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The text to be printed can be specified in the Text field. If the counters are to 
b ust be
used, the values must b

The Horizontal offset
scanned image. You ca  the offset in millimetres from the left edge of 
the page. When printing text, the horizontal offset is applied manually, please 
r r ma

The Vertical offset sp
the paper to start printin

You can select to print the text on every page, on the first page of a new file 
s indicated by the New file key, by setting the Pages drop down list to 

Every or Next page. 

You can set the direction in which the text will print from the Orientation drop 

The default font size the Imprinter uses is 12x12 dots. You can select to use 
a smaller 8x7 font size by ticking the Use small fonts checkbox. 

e used, these m  specified within square brackets. If both counters are 
e separated by a decimal point (full stop). 

 only applies if the text is to be embedded in the 
n specify

efer to the scanne nual for instructions on how this is done. 

ecifies the distance in millimetres from the top edge of 
g the text. 

a

down list. The available values are None, 90, 180 and 270 degrees. 

The Right to left option will set the Imprinter to add characters from right to 
left. 
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The Style of Embedment can be set from one of three options: 

print black text on to the image. 
 

e e configured, and these options apply to 
t f the counter can be set as well as the value to 

e  can be set for the Reset if and Increment if options. 
 the counter to its start value. Increment If will add the 

pecified increment value to the counter. 

 
• Separator 

Canon DR-7080C 
 a document feeder and a flatbed 

e  many options that can be selected for the scanners, and these are 
l ral option screens which are selected from Scanner Setup.  

e  screen is displayed when choosing Scanner Setup for the 
80C. 

• Black on White will print black text on to a white background. 
• White on Black will print white text on a black background. 
• Black on image will 

Th re are two counters that can b
bo h. The Start value o
increment the value for each page.  

Th  following values
Reset If will reset
s

• Never

• New File or Separator 
• New File 
• Each Document 

The Canon DR-7080C can be used with
with documents up to A3. Therefore it is suitable to scan pages automatically 
from the document feeder and to scan single pages for example from books. 
In feeder mode the scanner can scan black and white, greyscale and full 
colour up to A3 size. The maximum resolution is 600 dpi. 

Scanner Configuration 
Th re are
sp it over seve

Th  following
-70Canon DR
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Page Setting
The scanner is ab
settings can be a
option to select is
flatbed without fe
from the option on

The Fit Image op
each page scann
document. When 
double-sided docu
the documents. T
click on the Same rent settings for 
e  unche
choose from the 
scanning preferen

For each side, or b llowing options can be set: 

s 
le to scan single or double sided documents, and different 
pplied for each side of a double sided document. The first 
 whether to scan single or double sided or to scan from 
eder. Selecting Front, Flatbed or Front/back scanning 
 the screen above can do this. 

tion sets the scanner to automatically detect the size of 
ed, and will adjust the page size to the actual size of the 
this is set, the Page Size option is disabled if scanning 
ments, different settings can be applied for each side of 

o use the same settings for both sides of the documents, 
settings for back side option. To use diffe

ach side, ck the Same settings for back side option, and then 
drop down list which side you wish to choose to set the 
ces. 

oth sides of a document, the fo
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Setting Description 

Page Size 

r - 8.5 x 11 In 
• Ledger-R -  17 x 11 In 

10 x 297 mm 

• A5-R - 210 x 148 mm 
• B4-R – 353 x 250 mm 
• B5 - 176 x 250 mm 
• B5-R - 250 x 176 mm 

Window Page Size Setting: 

To do this, select 
Window as the page size, then perform a Test Scan on a 

ple document, and the box size and location will 
then be saved. 

Please note that when this option is used, only the area of 
the document inside the box will be saved. All other parts 
of the scanned document will be discarded. 

Select one of the following document sizes: 

• Lette

• Letter-R - 11 x 8,5 In 
• Legal-R – 14 x 8.5 In 
• A3-R - 420 x 297 mm 
• A4 - 2
• A4-R - 297 x 210 mm 
• A5 - 148 x 210 mm 

 
If Fit Image is enabled, this setting is disabled 

If you select the Window page size option, you can specify 
an area of the document to be saved. 

sample document. A sizeable box will be overlaid on the 
image in the Test Scan window. Size the box over the area 
of the sam

Resolution You can select one of the following: 100, 150, 200, 240, 
300, 400 & 600dpi 

Dither Use this setting when scanning in black and white mode. 
This applies error diffusion to simulate greys and half-
tones on the scanned document. This is useful when 
scanning photos. 

Mode This option is used to set the number of colours to be 
scanned. 

Black & White: The black & white mode scans only in 
black & white. 
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Greyscale: Greyscale mode creates images with 256 
greyscale levels. 

Colour: The DR-7080C supports 24 bit colour scanning. 
The larger the bit value selected, the more colour shades 
will be scanned. 

Please be aware that greyscale and colour scanning, 
especially at high resolutions, can result in extremely large 
file sizes. 

Rotation A document can be scanned and then rotated and saved. 
The available rotation options are 0°, 90°, 180° or 270°. 

Compression ScanFile will store images in one of four ways: 

• Uncompressed TIFF 
• Group 4 Compressed TIFF 
• Jpeg 
• Lura Document 

 
The type of compression and file format you select is 
dependent upon several factors including the type of 
document to be scanned, and the type of output required 
of that document once stored. 

from the 
scanned document, and will result in large file sizes. 

s. This is a 
'lossless' compression format which means that none of 

JPEG (JTIFF): JPEG is a standardised image 

ural, real-world scenes. Jpeg is a 'lossy' compression 

ount of 

Jpeg images which will determine how much data is 

Uncompressed TIFF: This format will perform no 
compression on the image data produced 

Group 4 Compressed TIFF: This format will compress the 
scanned image data, normally by a factor of 10 to 15. This 
is only used for black & white scanned image

the original scanned information is discarded. 

compression mechanism, which is designed for 
compressing either full-colour or grey-scale images of 
nat
format, which means that data is discarded from the 
original scanned image data to achieve the levels of 
compression possible. It is possible to vary the am
data to be discarded, and therefore the quality of the 
remaining image. ScanFile has various quality levels for 

'dropped' form the original scanned image, and will 
radically affect the size of the file produced. 
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Lura Document: Lura Document is a standardised image 
compression ratio which is designed essentially for 

images to 
ent is also a 

, ScanFile includes 
extensive options for determining levels of quality for Lura 

compressing either full colour or greyscale 
dramatically smaller files sizes. Lura docum
‘lossy’ compression format, however

Document scanned images. 

Sensitivity 
These settings allow you to adjust the brightness and contrast settings for 
each side of a document to be scanned. Different settings will apply 

p  upon whether the document is to be scanned in Text mode or 
o hoto mode applies error diffusion to simulate rescaling. 

ness setting can be adjusted. The DR-
utomatic brightness function built-in, but this can be 

overridden and manually set if necessary. 

, the scanner will automatically sense the 
brightness setting required for each page as it is scanned. 

s setting can be any value between 1 and 255, with 1 being the 
darkest setting, 255 being the brightest. A value of 0 will select Auto 
brightness. To manually set a brightness value, untick the Auto checkbox 
and select any other value as Auto by using the slide bar or typing in a value 
between 1 and 255. 

Photo Mode 
I o  adjusted. 

 automatic brightness and contrast functions built-in, but 
ese can be overridden and manually set if necessary. 

The brightness and contrast settings can be any value between 1 and 255, 
with 1 being the darkest setting, 255 being the lightest. A value of 0 will select 
auto brightness or contrast. To manually set a brightness or contrast value, 
untick the Auto checkbox and select any other value as Auto by using the 
slide bar or typing in a value between 1 and 255. 

de endent
Ph to Mode. P

Text Mode 
In this mode, only the Text Bright
7080c has an a

When the Auto is selected

The Brightnes

n this mode, the Phot  Brightness and Contrast settings can be
The DR-7080c has
th

When the Auto setting is selected, the scanner will automatically sense the 
brightness and/or the contrast setting required for each page as it is scanned. 
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Extended Settings 
The Extended Settings option allows you access to the advanced functions 
of the scanners. Many settings are available from this option, and these are 
explained on the following pages. 

Several of these settings can affect the quality of the scanned image and 
they should therefore be used with caution! 

 
Filter Settings 

The Filter settings can be used to improve the quality of the scanned image, 
and to set colour dropout areas where the document will not be scanned. 

Option Description 

Dropout Colour This function is available separately for th
back page. It will disable the scanning of 

e front and 
areas of the 

document of a particular colour. The settings are: 

: Disables Colour dropout • None
• Red: Will not scan red parts of the document 
• Green: Will not scan green parts of the 

document 
• Blue: Will not scan blue parts of the document 
 

Automatic Exposure This sets the Automatic Exposure level and affects 
the brightness and contrast settings for the image. 
This has a valid range of 1 to 9 and can be set by 
moving the slider bar, or using the arrow keys to 
increase or decrease the value. 

Edge Emphasis 

 This has a valid range of 1 to 5 and can be adjusted 
by moving the slider bar, or using the arrow keys to 
increase or decrease the value. 

This can be used to emphasis contour lettering, as 
well as softening scanned images such as photos. 

Canon DR-5020, 5080C & 5060F 

d scanners with automatic paper size and thickness detection. 

The DR-5020, 5080c and 5060F are high performance A3 scanners with a 
maximum scanning throughput of 80 A4 pages per minute. They are all 
double-side
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Additionally, document skew is automatically corrected during the document 
feed process from the 500 sheet paper feed tray. 

The DR-5060F incorporates an inbuilt microfilm camera. 

The DR-5020 supports black & white scanning whilst the DR-5080c supports 
several modes up t a lour. The maximum scanning 
resolution for both t 0dpi. The DR-5060F supports 
black & white scanni  o  scanning resolution of 300dpi. 

Pre and post docum ons which can be added to the 
scanners. A Barcode  as an option. 

Document specific t s

• Width 55mm to
• Length 70mm 
• Thickness 0.06  Manual Feed) 

Scanner Con
There are many o
split over several
The most used o
when Scanner Setup

The following sc
Scanner Setup f
the setup screen for the DR5020/80c, allo
t ld, bu

o  maximum 24 bit co
of hese scanners is 40
ng nly with a maximum

ent endorsers are opti
 decoder can also be included

a

 297mm 

ion  are: 

to 432mm 
mm to 0.15mm (0.05 to 0.2mm

figuration 
ptions that can be selected for the scanners, and these are 
 option screens which are selected from Scanner Setup. 
ptions are collected together on the first screen displayed 

 is selected. 

reen shows the first screen displayed when choosing 
or the Canon DR-5060F. This has an additional option to 

wing the film position to be saved 
o a folder fie t apart from that the screen has the same options. 
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P etting
A ne uble sided 
documents, and different settings can be applied for each side of a double 
sided document. The r hether to scan single or double 
sided. Selecting Fro g from the option on the 
screen above can do i

The Fit Image option sets the scanner to automatically detect the size of 
each page scann
document. When 
double-sided docu
the documents. 

To use the same 
settings for bac
uncheck the Sam
drop down list nning 
preferences. 

For each side, or b

age S s 
ll three scan rs are capable of scanning single or do

 fi st option to select is w
nt, Back, or Front/back scannin
 th s. 

ed, and will adjust the page size to the actual size of the 
this is set, the Page Size option is disabled if scanning 
ments, different settings can be applied for each side of 

settings for both sides of the documents, click on the Same 
k side option. To use different settings for each side, 
e settings for back side option, and then choose from the 
which side you wish to choose to set the sca

oth sides of a document, the following options can be set: 
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Setting Description 

Page Size 

A3 - 297 x 420 mm 

) 
 
If Fit Image is enabled, this setting is disabled 

w Page Size Setting: 

n window. Size the box over the area 
of the sample document, and the box size and location will 
then be saved. 

Please note that when this option is used, only the area of 

Select one of the following document sizes: 

• Letter - 8.5 x 11 Inch 
• Legal - 8.5 x 14 Inch 
• 
• A4 - 210 x 297 mm 
• A5 - 148 x 210 mm 
• A6 - 105 x 148 mm 
• B4 - 250 x 353 mm (ISO) 
• B4 – 257 x 364 mm (JIS) 
• B5 - 176 x 250 mm (ISO) 
• B5 - 182 x 257 mm (JIS

Windo

If you select the Window page size option, you can specify 
an area of the document to be saved. To do this, select 
Window as the page size, then perform a Test Scan on a 
sample document. A sizeable box will be overlaid on the 
image in the Test Sca

the document inside the box will be saved. All other parts 
of the scanned document will be discarded. 

Resolution You can select up to one of the following resolutions : 200, 
210, 220, 230, 240, 250, 260, 270, 280, 290, 300 and 400 
dpi (Dots per Inch) 

With the above settings the horizontal scan resolution is 

al setting, the second refers to the 
vertical setting. These are marked in the Resolution list 

the same as the vertical resolution. There are also 2 high 
speed scanning settings, which have split resolutions. The 
first figure is the horizont

with asterisks (*): 200 x100 and 300x150 dpi. 

Dither Use this setting when scanning in black and white mode. 
This applies error diffusion to simulate greys and half-
tones on the scanned document. This is useful when 
scanning photos. 
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Modus This option is used to set the number of colours to be 
scanned. 

Please note that the DR-5020 and DR-5060F only support 
 All other settings are 

applicable to the DR-5080c. 

 & white. 

value selected, the more 
colour shades will be scanned. 

e aware that greyscale and colour scanning, 

Black & White mode scanning.

Black & White 

The black & white mode scans only in black

Greyscale 

The DR-5080c supports 4, 16 & 256 levels of Greyscale 

Colour 

The DR-5080c supports 3, 6, 12 and 24 bit colour 
scanning. The larger the bit 

Please b
especially at high resolutions, can result in extremely large 
file sizes. 

Rotation A document can be scanned and then rotated and saved. 
The available rotation options are 0°, 90°, 180° or 270°. 

Compression ScanFile will store images in one of four ways: 

• Uncompressed TIF
• 
• 
• 

 
The 
depe
docu
of tha

Unco will perform no 
compression on the image data produced from the 
scanned document, and will result in large file sizes. 

Group 4 Compressed TIFF: This format will compress the 
scanned image data, normally by a factor of 10 to 15. This 
is only used for black & white scanned images. This is a 
'lossless' compression format which means that none of 
the original scanned information is discarded. 

F 
Group 4 Compressed TIFF 
Jpeg 
Lura Document 

type of compression and file format you select is 
ndent upon several factors including the type of 
ment to be scanned, and the type of output required 
t document once stored. 

mpressed TIFF: This format 
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JPEG
comp
comp cale images of 
natural, real-world scenes. Jpeg is a 'lossy' compression 
format, h rded from the 
original sc of 
compre io ount of 
data to be discarded, and therefore the quality of the 
remaini  r 
Jpeg images which will determine how much data is 
'drop
radic

Lura
comp
compressing either full colour or greyscale images
dramatically smaller files sizes. Lura document is also a 
‘loss
exten
Docu

 (JTIFF): JPEG is a standardised image 
ression mechanism, which is designed for 
ressing either full-colour or grey-s

w ich means that data is disca
anned image data to achieve the levels 

ss n possible. It is possible to vary the am

ng image. ScanFile has various quality levels fo

ped' form the original scanned image, and will 
ally affect the size of the file produced. 

 Document: Lura Document is a standardised image 
ression ratio which is designed essentially for 

 to 

y’ compression format, however, ScanFile includes 
sive options for determining levels of quality for Lura 
ment scanned images. 

Sensitivity 
These settings allow you to adjust the brightness and contrast settings for 

ngs will apply 
 Text mode or 

he Text Brightness setting can be adjusted. All three 

When the Auto is selected, the scanner will automatically sense the 
brightness setting required for each page as it is scanned. 

The Brightness setting can be any value between 1 and 255, with 1 being the 
darkest setting, 255 being the brightest. A value of 0 will select Auto 
brightness. To manually set a brightness value, untick the Auto checkbox 
and select any other value as Auto by using the slide bar or typing in a value 
between 1 and 255. 

each side of a document to be scanned. Different setti
dependent upon whether the document is to be scanned in
Photo Mode. Photo mode applies error diffusion to simulate rescaling. 

Text Mode 
In this mode, only t
scanners have an automatic brightness function built-in, but this can be 
overridden and manually set if necessary. 
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Photo Mode 
In this mode, the Photo Brightness and Contrast settings can be adjusted. All 
three scanners have automatic brightness and contrast functions built-in, but 
these can be overridden and manually set if necessary. 

When the Auto setting is selected, the scanner will automatically sense the 
brightness and/or the contrast setting required for each page as it is scanned. 

The brightness and contrast settings can be any value between 1 and 255, 
with 1 being the darkest setting, 255 being the lightest. A value of 0 will select 
auto brightness or contrast. To manually set a brightness or contrast value, 
untick the Auto checkbox and select any other value as Auto by using the 
slide bar or typing in a value between 1 and 255. 

Extended Settings 
The  option allows you access to the advanced functions 
of the scanners. Many settings are available from this option, and these are 
e  the f

Extended Settings

xplained on ollowing pages. 

Several of these settings can affect the quality of the scanned image and 
they should therefore be used with caution! 

 
Double Feed Det

There are two methods to set the scanner to detect the simultaneous feeding 
of two or more she  ated for paper 
thickness and/or len h her the 
Thickness or Lengt c When you next scan a batch of 
documents, the first page fed through the scanner will have its thickness 
and/or length measured and the measurement then stored. Subsequent 
documents’ measurements will be compared against the stored value and if 
the scanned document is thicker or longer than the stored value, an error will 
be displayed. 

 
Manual Thickness Adjust 

The thickness setting can be manually adjusted when the automatic 
thickness detection is not used or when there are frequent double feeds of 
paper. 

The setting ranges from 1 to 13, with 1 being the thinnest, and 13 the thickest 
setting. To adjust this setting, tick the Activate checkbox, and then use the 
arrow keys at either end of the slider bar to increase or decrease the value. 

ection 

ets of paper. The scanner can be calibr
gt . To set Double Feed Detection, tick eit
h heckboxes, or both. 
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Border Removal 

You can set a marg a he value ranged from – 
10mm to +10mm. 

To use this function, tick the e 
the arrow keys or 
the scanning area
value. To reduce 
black border, set a

 
Filter Settings 

The Filter settings age, 
and to set colour d

in round the scanning area. T

Activate checkbox. To adjust the values, us
the slider bar to increase or decrease the value. To enlarge 
, to ensure the document edges are not clipped, set a plus 
the scanning area, so that the image is not framed by a 
 minus value. 

 can be used to improve the quality of the scanned im
ropout areas where the document will not be scanned. 

Option Description 

Erase Black Dots
e. 

 This will automatically erase isolated black dots on a 
white background from the scanned imag

Erase White Dots This will automatically erase isolated white dots on a 
black background from the scanned image. 

Erase Notch This will automatically remove areas that are caused 
by contours 

Complete Thin Lines This will automatically fill in broken or thin faint lines. 

Drop Out Colour 

• 

lues in the Disable Dropout 

he 
value required. 

This function is only available for the DR-5080c and 
will disable the scanning of areas of the document of 
a particular colour. The settings are: 

None: Disables Colour dropout 
• Red: Will not scan red parts of the document 
• Green: Will not scan green parts of the 

document 
• Blue: Will not scan blue parts of the document 

 
Colour Dropout can be disabled for a part of the 
document by setting va
option. This is measured in millimetres, and is applied 
x mm from the top edge of the scanned image to x 
mm from the top edge of the image, where x is t
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Automatic Expos
rightness and contrast settings for the image. 

This has a valid range of 1 to 13 and can be set by 
 slider bar, or using the arrow keys to 

ure This sets the Automatic Exposure level and affects 
the b

moving the
increase or decrease the value. 

Edge Emphasis  emphasis contour lettering, as 
 softening scanned images such as photos. 

e adjusted 
ow keys to 

ease or decrease the value. 

This can be used to
well as
This has a valid range of 1 to 5 and can b
by moving the slider bar, or using the arr
incr

 

Other Options 

Several other settings options are available and these are detailed below: 

Option Description 

Verify Count This can be used to ensure that a known number of 
pages are being fed correctly through the scanner. 
Before scanning, the number of pages to be scanned 
can be set, and if that number of pages is not fed 
through the scanner, an error will be displayed. 

Auto New File This setting can be used when batch scanning to 
automatically create a new file when the feeder 
empties. An option to continue scanning will be 
displayed and when this is pressed, a new file will be 
created. 

Use Front Panel When this is enabled, the front panel of the scanner 
can be used to override certain settings set in the 
scanner driver. In the case of the DR- 5060F the front 
panel enables the user to also control the microfilm 
scanning functions. 

 

DR-5060F Additions 

An additional feature of the Canon DR-5060F is the Save Film Position To 
option on the driver screen. This calculates the position of the film from the 
‘blips’ recorded on the microfilm by the built in camera unit on the scanner. 
When the position of the film has been calculated it can populate an index 
field in folders that have this option set. 
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Function Keys 

This settings screen can be used to set the functions available on the four 
keys on the front panel of the DR-5020, DR-5060F and DR-5080c. The 
available functions are: 

• Manual Thickness Adjustment 
• Scanner Calibration 
• Auto Thickness Detection On/Off 

Gamma 

This option is used to download to the scanner Gamma data settings used to 
e can be set for each of the colours shown. 

barcodes, which can be on the front or back of a scanned page. 

The scanners will recognise the following barcode types: 

Code 128 

t the side of the page that the barcodes are on, choose the 
Side drop down list. 

• Auto Double Feed Detection On/Off 
• Imprinter On/Off 
• Save Settings 
 

express colours and tones. Thes

To select a file, choose the colour from the dropdown list and then press 
Open File. This will allow you to select the Gamma settings file to associate 
with that colour. 

 
Barcode Decoder 

If the Barcode decoder option has been installed in the DR-5020, DR-5080c 
or DR-5060F, the Barcode Setup option will be available from the Extended 
Settings screen. From this screen you can set which barcode types are to be 
searched for, and you can also specify an area of the document to search for 

• EAN 
• Code 39  
• Codabar 
• Code 25  
• UPC 
• UPC-A 
 UPC-E •

• 
 

Up to four barcodes of differing types can be searched for and read from a 
document. The number to read can be set in the Barcodes per page option. 
To selec
appropriate option from the 
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To activate the
checkbox. The 

 barcode recognition, tick the Use barcode recognition 
Activate buzzer option will set the scanner to buzz each time 

Search Area.  

 must be specified in millimetres, and the top left of the 
y putting the appropriate values in the Horizontal and 

a barcode is found and read. 

Additionally you can set a specific an area on a page to search for barcodes. 
To select this option tick the Activate checkbox under 

The area to be read
search area is set b
Vertical offset value fields. You can then specify the width and height of the 
search area in the Width and Height value fields. 

To set the scanner to read a particular barcode format or formats, tick the 
Activate checkbox in each of the barcode formats. 

Barcode Option 

EAN To read the Extended EAN format, tick the Extended
checkbox. 

Code 39 If the barcode has a checksum, this can be recognised by 
ticking the Recognise checksum checkbox. If this is 
selected, the checksum value can be returned by selecting 
the Return checksum option. You can also select to 
include the start and stop characters in the barcode read 
by ticking the Return start/stop checkbox. 

Codabar If the barcode has a checksum, this can be recognised by 
Recognise checksum checkbox. If this is 
 checksum value can be returned by selecting 

heckbox. 

ticking the 
selected, the
the Return checksum option. There are two checksum 
options for Codabar, Mod 16 and DR7, which can be 
selected from the drop down list. You can also select to 
include the start and stop characters in the barcode read 
by ticking the Return start/stop c

Code 25 If the barcode has a checksum, this can be recognised by 
Recognise checksum checkbox. If this is 

e checksum value can be returned by selecting 
the Return checksum option. 

o select UPC-A and/or 
UPC-E. 

ticking the 
selected, th

By selecting UPC, you can then als
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UPC-A Extended UPC-A can be read by ticking the Extended
checkbox. 

checkbox. 

If the barcode has a checksum, this can be recognised by 
ticking the Recognise checksum checkbox. The header 
can also be returned by selecting the Return Header

UPC-E If the barcode has a checksum, this can be recognised by 
ticking the Recognise checksum checkbox. The header 
can also be returned by selecting the Return Header
checkbox. 

Code 128 Code 128 has no options.  

 

Imprinter Option 

If the Imprinter option has been installed in the DR-5020, DR-5080c or DR-
5060F, this can be configured by selecting the Imprinter option from the 
Extended Settings screen. 

 allows you to print specified alphanumeric and symbol 
osition on a page as it is being scanned. You can also 

embed the characters to be printed in the scanned image. 

ned, tick the 
Print checkbox. To embed the text as part of a scanned image, tick the 
Embed to image checkbox. 

The Imprinter option
characters at any p

To set the Imprinter to print text on a page as it is being scan
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The text to be printed can be specified in the Text field. If the counters are to 
be used, these must be specified within square brackets. If both counters are 
used, the values must be separated by a decimal point (full stop). 

 if the text is to be embedded in the 
ify the offset in millimetres from the left edge of 

the text. 

You can select to print the text on every page, on the first page of a new file 
New file key, by setting the Pages drop down list to 

ht to 

7 font size by ticking the Use small fonts checkbox. 

The Horizontal offset only applies
scanned image. You can spec
the page. When printing text, the horizontal offset is applied manually, please 
refer to the scanner manual for instructions on how this is done. 

The Vertical offset specifies the distance in millimetres from the top edge of 
the paper to start printing 

as indicated by the 
Every or Next page. 

You can set the direction in which the text will print from the Orientation drop 
down list. The available values are None, 90, 180 and 270 degrees. 

The Right to left option will set the Imprinter to add characters from rig
left. 

The default font size the Imprinter uses is 12x12 dots. You can select to use 
a smaller 8x
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The Style of Embedment can be set from one of three options: 

• Black on White will print black text on to a white background. 
• White on Black will print white text on a black background. 
•  imag
 
There are two co
both. The Start value of the counter can be set as well as the value to 
increment the value for each page.  

The following valu
Reset If will rese
specified incremen ounter. 

• r 
• Separator 
• New File or Se
• New File 
• Each Documen
 

Options Screen 

The Options scre
installed or availab

The Barcode, Imp icked if the options 
are installed. 

 Black on e will print black text on to the image. 

unters that can be configured, and these options apply to 

es can be set for the Reset if and Increment if options. 
t the counter to its start value. Increment If will add the 
t value to the c

 Neve

parator 

t 

en is for information and will show the attached scanner's 
le options. 

rinter and Endorser checkboxes will be t

Option Description 

CC CC is a special filter option 

YG-LED Will be ticked if the attached scanner is a DR-5020 
or DR-5060F 

Red/Green/Blue-LED Will be ticked if the DR-5080c is attached 

 

The View options are values returned by the scanner. The DR-5080c will tick 
all three checkboxes. The DR-5020 and DR-5060F will return only Black & 
White and Bi-tonal. 
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Canon DR-3060, 3080C & 3080CII 
The DR-3060, DR-30 erformance A4 scanners 
with a maximum scanning throughput of
double-sided scanne  aper size and thickness detection. 
Both scanners inc rp a per tray. 

The DR-3060 sup
the DR-3080c sup
maximum scannin

Post document endorsers are options

Document specific

• Width 55mm to 257mm 
• Length 70mm 
• Thickness 0.06

Scanner Con
There are many o
split over differen
The most used o
when Scanner Se

The following sc
Scanner Setup fo

80c and DR-3080cII  are high p
 40 pages per minute. They are all 

rs with automatic p
or te a 100 sheet pao

ports black & white and 256 level greyscale scanning whilst 
ports several modes up to a maximum 24 bit colour. The 
g resolution for both scanners is 300dpi. 

 which can be added to the scanners. 

ations are: 

to 364mm 
mm to 0.15mm (0.05 to 0.2mm Manual Feed) 

figuration 
ptions that can be selected for the scanners, and these are 
t option screens which are selected from Scanner Setup. 
ptions are collected together on the first screen displayed 
tup is selected. 

reen shows the first screen displayed when choosing 
r the Canon DR-3060, DR-3080C or DR-3080CII. 
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Page Settings 
All three scanners are capabl
documents, and different settings

e of scanning single or double sided 
 can be applied for each side of a double 

 option on the 

Please note that greyscale and colour scanning is only available for single 
sided, front page scanning on DR-3060 and DR-3080C. 

ts the scanner to automatically detect the size of each 

document, the following options can be set: 

sided document. The first option to select is whether to scan single or double 
sided. Selecting Front, Back, or Front/back scanning from the
screen above can do this. 

The Adjust option se
page scanned, and will adjust the page size to the actual size of the 
document. 

For each side, or both sides of a 
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Option Description 

Page Size Se  document sizes: 

 
 

lect one of the following

• Letter - 8.5 x 11 Inch
• Legal - 8.5 x 14 Inch
• A4 - 210 x 297 mm 
• A5 - 148 x 210 mm 
• A6 - 105 x 148 mm 

 • B4 - 250 x 353 mm (ISO)
• B5 - 176 x 250 mm (ISO) 

 
If Fit Image is enabled, this setting is disabled 

Window Page Size Setting: 

If you select the Window page size option, you can specify 
an area of the document to be saved. To do this, select 
Window as the page size, then perform a Test Scan on a 
sample document. A sizeable box will be overlaid on the 
image in the Test Scan window. Size the box over the area 
of the sample document, and the box size and location will 
then be saved. 

Please note that when this option is used, only the area of 
the document inside the box will be saved. All other parts 
of the scanned document will be discarded. 

Resolution You can select up to one of the following resolutions  

• 200 dpi 
• 240 dpi 
• 300 dpi (Dots per Inch) 

 
With the above settings the horizontal scan resolution is 
the same as the vertical resolution. 

There is also a high speed scanning setting, which has a 
split resolution. The first figure is the horizontal setting, the 
second refers to the vertical setting: 300x150 

Dither Use this setting when scanning in black and white mode. 
This applies error diffusion to simulate greys and half-
tones on the scanned document. This is useful when 
scanning photos. 
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Modus 

56 levels of 
Greyscale 

Colour 

ur 
scanning. The larger the bit value selected, the more 

resolutions, can result in large file sizes. 

This option is used to set the number of colours to be
scanned. 

Black & White  

The black & white mode scans only in black & white. 

Greyscale 

The DR-3060 and DR-3080c support 2

Only the DR-3080c supports 3, 6, 12 and 24 bit colo

colour shades will be scanned. 

Please be aware that greyscale and colour scanning, 
especially at high 

Rotation A document can be scanned and then rotated and saved. 
The available rotation options are 0°, 90°, 180° or 270°. 

Compression ScanFile will store images in one of four ways: 

• Uncompressed TIFF 
• Group 4 Compressed TIFF 
• Jpeg 
• Lura Document 

 
The type of compression and file format you select is 
dependent upon several factors including the type of 
document to be scanned, and the type of output required 
of that document once stored. 

Uncompressed TIFF: This format will perform no 
compression on the image data produced from the 
scanned document, and will result in large file sizes. 

Group 4 Compressed TIFF: This format will compress the 
scanned image data, normally by a factor of 10 to 15. This 
is only used for black & white scanned images. This is a 
'lossless' compression format which means that none of 
the original scanned information is discarded. 

JPEG (JTIFF): JPEG is a standardised image 
compression mechanism, which is designed for 
compressing either full-colour or grey-scale images of 
natural, real-world scenes. Jpeg is a 'lossy' compression 
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format, which means that data is discarded from the 
original scanned image data to achieve the levels of 
co possible to vary the amount of 
da fore the quality of the 
remaining image. ScanFile has various quality levels for 
Jpeg images which will determine how much data is 

ropped' form the original scanned image, and will 

compressing either full colour or greyscale images to 

r Lura 
Document scanned images. 

mpression possible. It is 
ta to be discarded, and there

'd
radically affect the size of the file produced. 

Lura Document: Lura Document is a standardised image 
compression ratio which is designed essentially for 

dramatically smaller files sizes. Lura document is also a 
‘lossy’ compression format, however, ScanFile includes 
extensive options for determining levels of quality fo

Skew Correc
This function is a software driver based skew correction facility that can be 
selected by a che
be scanned at an
viewing, this optio
performing other a

Sensitivity 
These settings al
each side of a 
dependent upon 
Photo Mode. Phot caling. 

Text Mode 
In this mode, onl
scanners have a
overridden and ma

When the Auto is selected, the scanner will automatically sense the 
brightness setting required for each page as it is scanned. 

etting can be any value between 1 and 255, with 1 being the 
A value of 0 will select Auto 

tion 

ckbox on the main Scanner Setup window. Should pages 
 angle through the scanner, and not appear straight when 
n will straighten the page and justify it which will help when 
ctions such as OCR. 

low you to adjust the brightness and contrast settings for 
document to be scanned. Different settings will apply 
whether the document is to be scanned in Text mode or 
o mode applies error diffusion to simulate res

y the Text Brightness setting can be adjusted. All three 
n automatic brightness function built-in, but this can be 
nually set if necessary. 

The Brightness s
darkest setting, 255 being the brightest. 
brightness. To manually set a brightness value, untick the Auto checkbox 
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and select any other value as Auto by using the slide bar or typing in a value 
between 1 and 255. 

Photo Mode 

f necessary. 

e as it is scanned. 

a value between 1 and 255. 

tings 

In this mode, the Photo Brightness and Contrast settings can be adjusted. All 
three scanners have automatic brightness and contrast functions built-in, but 
these can be overridden and manually set i

When the Auto setting is selected, the scanner will automatically sense the 
brightness and/or the contrast setting required for each pag

The brightness and contrast settings can be any value between 1 and 255, 
with 1 being the darkest setting, 255 being the lightest. A value of 0 will select 
auto brightness or contrast. To manually set a brightness or contrast value, 
untick the Auto checkbox and select any other value as Auto by using the 
slide bar or typing in 

Extended Set
The Extended Settings option allows you access to the advanced functions 
of the scanners. Many settings are available from this option, and these are 
explained on the following pages. 

Several of these settings can affect the quality of the scanned image and 
they should therefore be used with caution! 

Option Description 

Automatic Page 
Suppression 

This function allows both scanners to ignore 
unwanted blank pages being scanned. This can be 
performed for the front and back of a scanned page. 
To switch this option on click on the relevant activate 

eckboxes. The levels at which a blank page can be 
ntified can be adjusted by the blackness threshold 

ch
ide
slide bar, this will help to identify pages with little 
surface coverage on the page and depending on the 
levels set will ignore those pages. 
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Drop Out Colour This function is only available for the DR-3080c and 
will disable the scanning of areas of the document of 
a particular colour. The settings are: 

• None: Disables Colour dropout 
ts of the document 

green parts of the 

• Blue: Will not scan blue parts of the document 

out can be disabled for a part of the 
document by setting values in the Disable Dropout 

• Red: Will not scan red par
• Green: Will not scan 

document 

 
Colour Drop

option. This is measured in millimetres, and is applied 
x mm from the top edge of the scanned image to x 
mm from the top edge of the image, where x is the 
value required. 

Edge Emphasis This can be used to emphasise contour lettering, as 
well as softening scanned images such as photos. 

1 to 5 and can be adjusted 
oving the slider bar, or using the arrow keys to 

increase or decrease the value. 

This has a valid range of 
by m

Canon DR-2050C & DR-2080C 
 DR-2080C are compact A4 workgroup scanner with 

 is 600dpi. 

The following picture shows the DR-2050C and DR-2080C Scanner setup 
screen.

The DR-2050C and the
a maximum scanning throughput of 20 pages per minute, or 39 images per 
minute when scanning double sided documents. They support black & white 
and 256 level greyscale scanning, and 24 bit colour. The maximum scanning 
resolution
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Setting Description 

Page Size The ScanF omatically detect the size of the 
page being scanned if Adjust option is selected. If it is 
not selected, the maximum scan size will be used, and the 
image may have a black border. 

ile driver will aut
 the 

Resolution The D 080C sup  resolutio from 1 o 
600dpi. The resolutions available will be dependent upon 
the scanning mode selected. 

• Black & White/Greyscale 200-600dpi 
• 24bit Colour 100-400dpi single/double sided 
• 600dpi single sided 
 

R-2 ports ns 00dpi t
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Compression ScanFile will store images in one of four ways:

• Group 4 Compressed TIFF 
• Jpeg 
• Lura Document 

 
The type of compression and file format you select is 
dependent upon several factors including the type of 
document to be scanned, and the type of output required 
of that document once stored. 

Uncompressed TIFF: This format will perform no 
compression on the image data produced from the 
scanne cument, and will res lt in large file size

Group 4 Compressed TIFF: This format will compress the 
scanned image data, normally by a factor of 10 to 15. This 
is only d for black & white scanned images. a 
'lossles ompression format hich means tha f 
the original scanned information is discarded. 

JPEG (JTIFF): ised e 
compr n me esig r 
compre g eith e im f 
natural, real-world sc
format, which means that data is discarded from the 
original scanned image data to achieve the levels of 
compression possible. It is possible to vary the amount of 
data to be discarded, and therefore the quality of the 
remain image. ScanFile ha various quality r 
Jpeg images which will determine how much data is 
'dropped' form the original scanned image, and will 
radically affect the size of the file produced. 

Lura Document: Lura Document is a standardised image 
compression ratio which is designed essentially for 
compressing either full colour or greyscale images to 
dramatically smaller files sizes. Lura document is also a 
‘lossy’ compression format, however, ScanFile includes 

termining levels of quality for Lura 
ges. 

 

• Uncompressed TIFF 

d do u s. 

 use
s' c

This is 
t none ow

JPEG is a standard
chanism, which is d

 imag
ned foessio

ssin er full-colour or grey-scal
enes. Jpeg is a 'lossy' compression 

ages o

ing s levels fo

extensive options for de
Document scanned ima

Rotation A document can be scanned and then rotated and saved. 
The available rotation options are 0°, 90°, 180° or 270°. 
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Mode This option is used to set the number of colours to be 
scanned. 

Black & White  

The black & white mode scans only in black & white. 

Greyscale 

Both scanners support 256 levels of Greyscale 

Colour 

Both scanner support 24 bit colour scanning. The larger 
the bit value selected, the more colour shades will be 
scanned. 

Please be aware that greyscale and colour scanning, 
especially at high resolutions, can result in very large file 
sizes. 

Pages You can select whether to scan single or double sided 
documents. 

Sensitivity 
Th se settings 
ea h side of a

e allow you to adjust the brightness and contrast settings for 
c  document to be scanned. Different settings will apply 
p  whether the document is to be scanned in Text mode or 
o oto mode applies error diffusion to simulate rescaling. 

d, the scanner will automatically sense the 

lue of 0 will select Auto 

de endent upon
Ph to Mode. Ph

Text Mode 
In this mode, only the Text Brightness setting can be adjusted. Both scanners 
have an automatic brightness function built-in, but this can be overridden and 
manually set if necessary. 

When the Auto is selecte
brightness setting required for each page as it is scanned. 

The Brightness setting can be any value between 1 and 255, with 1 being the 
darkest setting, 255 being the brightest. A va
brightness. To manually set a brightness value, untick the Auto checkbox 
and select any other value as Auto by using the slide bar or typing in a value 
between 1 and 255. 
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Photo Mode 

tions built-in, but 
these can be overridden and manually set if necessary. 

 setting is selected, the scanner will automatically sense the 
required for each page as it is scanned. 

 contrast. To manually set a brightness or contrast value, 
untick the Auto checkbox and select any other value as Auto by using the 

Canon DR-3020 

dustry 
standard SCSI-2 interface. The DR-3020 has a maximum resolution of 

To configure the DR-3020 scanning options, ensure that the DR-3020 is set 

In this mode, the Photo Brightness and Contrast settings can be adjusted. 
Both scanners have automatic brightness and contrast func

When the Auto
brightness and/or the contrast setting 

The brightness and contrast settings can be any value between 1 and 255, 
with 1 being the darkest setting, 255 being the lightest. A value of 0 will select 
auto brightness or

slide bar or typing in a value between 1 and 255. 

The Canon DR-3020 is a 40 page per minute black & white scanner with 
automatic paper thickness and size detection, with a maximum paper size of 
B4. Its automatic document feeder can take up to 100 sheets at a time, and 
these can be either single or double-sided documents. It has an in

300dpi. 

as the default scanner and then click on the Scanner Setup button. The 
following window will then be displayed 
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S ution
T  DR-3020 h ee sca olutio

•
• 
• 0x150dpi 

The selected scan reso  image, and also the 
scan speed. At a re nning single sided 
documents, the DR-3020 will scan at 40 p s pe inute t 3 0 x300dpi, 
scanning double-sided documents will slow the scanner to 11 sheets per 
minute. 

Page Size 
he DR-3020 can scan up to A4 size pages. The paper size can be selected 

from the drop down list. By selecting Maximum, and clicking on the Adjust 
option, the DR-3020 will auto detect the paper size. 

can Resol  
he Canon as thr n res ns 

 200x200dpi 
300x300dpi 

 30
 

lution will affect the quality of the
solution of 300 x 150dpi, sca

age r m . A 0

T
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View Options 
These options will affe  displayed. Standard 
doc ents ll nor lly be scanned using the Text Mo . Photo Mode 
scanning will enhance the document during scanning, and result in better 
quality scans of pictures. Pl se no that th Photo ode o ion result in 
larg  scan  file s es. 

Documents, by default, are displayed using black text on a white background. 
he Inverted option allows this to be reversed, so that the document is 
isplayed with white text on a black background. 

The DR-3020 scans documents in 'portrait' format. For landscape 
documents, select the Rota
c

W ont/ tore both 
sides of the scanned document. When not selected, only the front side of the 
document is scanned. 

Check Scanner 
ScanFile support several check scanners, which can read MICR Coded 
checks. The following check scanners are supported: 

• • TellerScan TS400ES 

Some of the described settings may only apply to certain scanner models. 

ct how the images are stored and
um wi ma de

ea te e  m pt  will 
er ned iz

T
d

te 90° option so that they will be displayed in the 
orrect orientation. 

hen selected, the Fr Back scanning option will scan and s

Brightness Controls 
The Canon DR-3020 has an automatic brightness function, which should 
work with most documents. Unticking the Auto option, and then selecting the 
required brightness setting by using the slider bar, or by typing in the 
brightness value, between 1-255, can override this. 

• • TellerScan TS200 
• • TellerScan TS300/350 

• • BUIC 1500 
 

Resolution 
The resolution can be 200x100 dpi or 200x200 dpi. Using 200x100 dpi 
scanning speed is bigger, but quality is less. The minor quality image is 
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interpolated to a 200x200 dpi image. Select the resolution which serves your 
application best. 

MICR 
The MICR code can be read and stored to index fields of ScanFile folders. 

ation will be displayed in 
the text fields below. For each of the different MICR information parts, you 

ion will then be stored automatically in these 
fields. 

Axis 7000 
0 is a network scan server box that will allow across network 
any scanner that is attached and supported by it. 

many options that can be selected for any scanners attached to 
the Axis 7000, and these are defined in the Scanner Setup. The most used 

The following screen dialogue shows the first screen displayed when 

Select the relevant MICR type between CMC7 and E13B. 

In order to store the MICR information to ScanFile index fields you have to 
perform a test scan first. Afterwards the check will be displayed in the test 
scan display window and the adjoining MICR inform

can select a ScanFile index field from a drop down list. When scanning 
checks, the relevant informat

The Axis 700
scanning with 

Scanner Configuration 
There are 

options are collected together on the first screen displayed when Scanner 
Setup is selected. 

choosing Scanner Setup for the Axis 7000. 
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Please note that any settings that are defined for the Axis 7000 are 
dependant on the scanner that is attached to it. It is not possible to define 
which scanner is attached to it so the Axis 7000 must only be setup with the 
settings that are specific to that scanner.  

Scanner SCSI ID 
To be able to recognise the Axis 7000 Scan Server you must enter its IP 
Address and the User Name and Password that have previously been 
configured on the Axis 7000. The correct configuration of the Axis 7000 can 
be verified using your web browser, please refer to the Axis user manual for 
details on how to do this. 

Page Settings 
Any scanners attached that are capable of scanning single or double sided 
documents can have different settings applied for each side of a double sided 
document. The first option to select is whether to scan single or double sided, 
by selecting Front or Front/back scanning from the Pages drop down. 

The Adjust option sets the scanner to automatically detect the size of each 
page scanned, and will adjust the page size to the actual size of the 
document. 
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For each side, or both sides of a document, the following options can be set: 

Setting Description 

Page Size You can select any Page Size that is supported by the 
scanner attached, please check the relevant sections of 
this manual to verify which Page Sizes are available for 
each scanner. 

Resolution You can select any Resolution that is supported by the 
scanner attached, please check the relevant sections of 
this manual to verify which resolutions are available for 
each scanner. 

Dither Use this setting when scanning in black and white mode. 
This applies error diffusion to simulate greys and halftones 
on the scanned document. This is useful when scanning 
photos.  

The Inverted option allows you to change from black on a 
white background, to white on a black background. 

Mode This option is used to set the number of colours to be 
scanned. You can select any colour mode that is 
supported by the scanner attached, please check the 
relevant sections of this manual to verify which colour 
modes are available for each scanner.  

Please be aware that greyscale and colour scanning, 
especially at high resolutions, can result in large file sizes. 

Rotation A document can be scanned and then rotated and saved.
The available rotation options are Portrait and Landscape 
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Compression ScanFile will store images in one of four ways: 

• Uncompressed TIFF 
• Group 4 Compressed TIFF 
• Jpeg 
• Lura Document 

 
The type of compression and file format you select is 
dependent upon several factors including the type of 
document to be scanned, and the type of output required 
of that document once stored. 

Uncompressed TIFF: This format will perform no 
compression on the image data produced from the 
scanned document, and will result in large file sizes. 

Group 4 Compressed TIFF: This format will compress the 
scanned image data, normally by a factor of 10 to 15. This 
is only used for black & white scanned images. This is a 
'lossless' compression format which means that none of 
the original scanned information is discarded. 

JPEG is a standardised image 
chanism, which is designed for 
r full-colour or grey-scale images of 

natural, real-world scenes. Jpeg is a 'lossy' compression 
format, which means that data is discarded from the 
original scanned image data to achieve the levels of 
compression possible. It is possible to vary the amount of 
data to be discarded, and therefore the quality of the 
remaining image. ScanFile has various quality levels for 
Jpeg images which will determine how much data is 
'dropped' form the original scanned image, and will 
radically affect the size of the file produced. 

Lura Document: Lura Document is a standardised image 
compression ratio which is designed essentially for 
compressing either full colour or greyscale images to 
dramatically smaller files sizes. Lura document is also a 
‘lossy’ compression format, however, ScanFile includes 
extensive options for determining levels of quality for Lura 
Document scanned images. 

JPEG (JTIFF): 
compression me
compressing eithe

Skew Correction 
This function is a software driver based skew correction facility that can be 
selected by a checkbox on the main scanner setup window. Should pages be 
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scanned at an an
viewing, this option

gle through the scanner, and not appear straight when 
 will straighten the page and justify it which will help when 

T
e
dependent upon whether the document is to be scanned in Text mode or 
Photo Mode. Photo mode applies error diffusion to simulate rescaling. 

Canon MS-300, 350 & 800 

al FS Controller III, where the scanner 

performing other actions such as OCR. 

Sensitivity 
hese settings allow you to adjust the brightness and contrast settings for 
ach side of a document to be scanned. Different settings will apply 

The Canon MS300, 350 and 800 microfilm scanners offers high speed and 
high resolution scanning and provide easy conversion and integration into 
existing digital environments. Full automatic search and retrieval/scanning 
functions are available via the option
supports it. 

Scanner Configuration 
The following screen shows the main settings screen displayed when 
choosing Scanner Setup for the MS-300, MS-350 or MS-800: 
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Page Settings 
A number of options can be set which will affect the size, quality and 
orientation of the documents being scanned. These are in the View section 
on the Scanner Setup screen.  

The tables below and on the following pages show the available settings. 

Setting Description 

Page Size Select one of the following document sizes: 

• Letter - 8.5 x 11 Inch 
• Legal - 8.5 x 14 Inch 
• A3 - 297 x 420 mm 
• A4 - 210 x 297 mm 
• A5 - 148 x 210 mm 
• A6 - 105 x 148 mm 
• B4 - 250 x 353 mm (ISO) 
• B4 - 257 x 364 mm (JIS) 
• B5 - 176 x 250 mm (ISO) 
• B5 - 182 x 257 mm (JIS) 

 
If Fit Image is enabled, this setting is disabled 

Window Page Size Setting: 

If you select the Window page size option, you can specify 
an area of the document to be saved. To do this, select 
Window as the page size, then perform a Test Scan on a 
sample document. A sizeable box will be overlaid on the 
image in the Test Scan window. Size the box over the area 
of the sample document, and the box size and location will 
then be saved. 

Please note that when this option is used, only the area of 
the document inside the box will be saved. All other parts 
of the scanned document will be discarded. 

Resolution You can select one of the following resolutions 200, 300, 
400 and 600 dpi (Dots per Inch) 

With the above settings the horizontal scan resolution is 
the same as the vertical resolution. 
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Mode The scanners support black & white and greyscale 
scanning 

Black & White  

The black & white mode scans only in black & white. 

Greyscale 

The scanners support 4, 16 & 256 levels of 

Greyscale 

Please be aware that greyscale scanning, especially at 
high resolutions, can result in extremely large file sizes. 

Dither Use this setting when scanning in black and white mode. 
This applies error diffusion to simulate greys and half-
tones on the scanned document. This is useful when 
scanning photos. 

Rotation A document can be scanned and then rotated and saved. 
The available rotation options are 0°, 90°, 180° or 270°. 
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Compression ScanFile will store images in one of four ways: 

• Uncompressed TIFF 
• Group 4 Compressed TIFF 
• Jpeg 
• Lura Document 

 
The type of compression and file format you select is 
dependent upon several factors including the type of 
document to be scanned, and the type of output required 
of that document once stored. 

Uncompressed TIFF: This format will perform no 
compression on the image data produced from the 
scanned document, and will result in large file sizes. 

Group 4 Compressed TIFF: This format will compress the 
scanned image data, normally by a factor of 10 to 15. This 
is only used for black & white scanned images. This is a 
'lossless' compression format which means that none of 
the original scanned information is discarded. 

which is designed for 
r or grey-scale images of 

natural, real-world scenes. Jpeg is a 'lossy' compression 
format, which means that data is discarded from the 
original scanned image data to achieve the levels of 
compression possible. It is possible to vary the amount of 
data to be discarded, and therefore the quality of the 
remaining image. ScanFile has various quality levels for 
Jpeg images which will determine how much data is 
'dropped' form the original scanned image, and will 
radically affect the size of the file produced. 

Lura Document: Lura Document is a standardised image 
compression ratio which is designed essentially for 
compressing either full colour or greyscale images to 
dramatically smaller files sizes. Lura document is also a 
‘lossy’ compression format, however, ScanFile includes 
extensive options for determining levels of quality for Lura 
Document scanned images. 

JPEG (JTIFF): JPEG is a standardised image 
compression mechanism, 
compressing either full-colou

Sensitivity 
These settings allow you to adjust the brightness and contrast settings for 
each side of a document to be scanned. Different settings will apply 
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dependent upon w
Photo Mode. Photo

hether the document is to be scanned in Text mode or 
 mode applies error diffusion to simulate rescaling. 

When the Auto is selected, the scanner will automatically sense the 
b

The Brightness setting can be any value between 1 and 255, with 1 being the 

brightness. To manually set a brightness value, untick the Auto checkbox 
and select a  the slide bar or typing in a value 
between 1 and 255. 

Photo M
In this mode, the Photo Brightness and Contrast settings can be adjusted. All 
three scanners have automatic brightness and contrast functions built-in, but 
these can be overridden and manually set if necessary. 

When the A s selected, the scanner will automatically sense the 
brightness and/or the contrast setting required for each page as it is scanned. 

The brightn s can be any value between 1 and 255, 
with 1 being the darkest setting, 255 being the lightest. A value of 0 will select 
auto brightness or contrast. To manually set a brightness or contrast value, 
untick the A elect any other value as Auto by using the 
slide bar or typing in a value between 1 and 255. 

The microfilm scanners MS300/350/800 can use the Canon FS Controller III 

ome countries. 

3 

Text Mode 
In this mode, only the Text Brightness setting can be adjusted. All three 
scanners have an automatic brightness function built-in, but this can be 
overridden and manually set if necessary. 

rightness setting required for each page as it is scanned. 

darkest setting, 255 being the brightest. A value of 0 will select Auto 

ny other value as Auto by using

 ode 

uto setting i

ess and contrast setting

uto checkbox and s

Feeder Selection 

for automatic film advancement while scanning. Additionally, an automatic 
fiche carrier is available in s

Scan Area Setting 
The MS300 and 350 have an A4 Portrait screen and the MS800 an A
Landscape screen. On the MS800, the screen can also be separated into two 
A4 portrait zones or a centred A4 portrait zone. This setting will affect how 
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the documents being displayed are scanned. There are four settings as 
follows: 

Setting Description 

Left This will scan the left A4 portrait zone 

Centred Scans the Centred A4 zone 

Separated Scans the left and right A4 portrait zones, and stores the two 
pages separately. 

Overlaid This mode can scan two A4 portrait halves and combines 
them in to one A4 portrait. Each half on the A4 Portrait is 
centred within the left and right A4 portrait zones. The scan 
from the right zone will be the top half of the page and the 
bottom half will be from the left zone. 

Extended Settings 

 FS 
Carrier III. A full description of this will be available in the FS Carrier III 

This option can be used to set whether to use the front panel of the scanner 
to control scanning, rather than ScanFile itself. E.g. if you selected the option, 
you have to start the scan process by pressing the green button on the front 
panel of the MS-800. 

FS Controller III 
This section describes the setup and initialisation of the scanner with the

manual. 

Blip Level Description 

1 Pageblip 

2 File – Pageblip 

3 Batch - File- Pageblip 

 

 1 Blip 2 Blip 3 Blip  

Shift + F +  Store    Return 
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Password    149 149 149 Return 

1 Search Mode    Return 

Mode # 5 2 3 Return 

Canon Return Meth No No No 

Ser Progr. 8 13 13 Return 

Std Blip Yes Yes Yes Return 

Neg. Blip Yes Yes Yes Return 

N/P Key on No No No Return 

Stand Slice Yes Yes Yes Return 

Count Splice No No No Return 

(Set)=#1 DOC Yes Yes Yes Return 

Enable (Auto) No No No Return 

Indexing --- No No Return 

Send Address No No No Return 

Input OK Yes Yes Yes Return 

8 X   Plus Key     

Exit    Return 

 

Mode Setting  

Film adjust vertical SHIFT +  or  Return 

Film adjust horizontal SHIFT + 4 then Yes or No Return 
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FS Controller III – Scanning with Batch- + File 
    

Shift + F  + Store   Return 

Password 149  Return 

1 Search Mode   Plus Key 

2 Machine setup   Return 

Trailer stop No  Return 

Mod F&C nstd No  Return 

E/M detect Yes  Return 

Key buffer No  Return 

Face U/D set No  Return 

Face down Yes Scan in ascending order Return 

Face down No Scan in descending order Return 

Adrs prt set No  Return 

Address prt No  Return 

Japanese MSG No  Return 

Input OK Yes  Return 

7 X Plus Key    

Exit   Return 

Canon MS400 & 500 

scanning. With automatic feed scanning, an FS 
 as well as blipped films. 

The maximum resolution of the MS scanners is 400dpi. 

Canon’s digital microfilm reader printers have an optional SCSI kit to enable 
them to be used as PC scanning devices. Two modes are supported – 
manual or automatic feed 
Carrier III will be required,
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Scan Resolution 
The MS400 & 500 have three scan resolutions 

0x300dpi 
400x400dpi 

View Options 
These options will affect how the images are stored and displayed. Standard 
documents will normally be scanned using the Text Mode. Photo Mode 

anning will enhance the document during scanning, and result in better 
. Please note that the Photo Mode option will result 

displayed with white text on a black background. 

The scanned documents can be rotated 90 degrees clockwise by selecting 
the Rotate 90° option so that they will be displayed in their correct 
orientation. 

• 200x200dpi 
• 30
• 

sc
quality scans of pictures
in larger scanned file sizes. 

Documents, by default, are displayed using black text on a white background. 
The Inverted option allows this to be reversed, so that the document is 
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Film Type 
Use this option to set the type of film loaded into the microfilm scanner. The 
Auto option will automatically detect the type of film loaded. 

Feeder 
This option allows you to set the type of feeder used on the microfilm 
scanner. It can be set for the Canon FS Carrier III, or Auto Fiche Carrier. For 
the Auto Fiche Carrier, the Communication port and baud rate being used 

o be scanned. Different settings will apply 

FS Carrier III. A full description of this will be available in the FS Carrier III 

must also be set. 

Please note that these feeder options may not be available in all countries. 
Please check with the supplier of the microfilm scanner for availability. 

Sensitivity 
These settings allow you to adjust the brightness and contrast settings for 
each side of a document t
dependent upon whether the document is to be scanned in Text mode or 
Photo Mode. Photo mode applies error diffusion to simulate rescaling. 

FS Controller III 
This section describes the setup and initialisation of the MS400/500 with the 

manual. 

Mode Description 

I Page 

II File - Page 

III Batch – File - Page 

VII File – Page 

 

 Mode I Mode II Mode III Mode VII  

Shift + F +  Store     Return 

Password    149 149 149 149 Return 
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1 Search Mode     Return 

Mode # 1 2 3 7 Return 

Canon Meth Yes No No No Return 

Serge Progr. 31 13 13 10 Return 

Ser. Level 1 --- --- --- Return 

Std Blip Yes Yes Yes Yes Return 

Neg. Blip Yes Yes Yes Yes Return 

N/P Key on No No No No Return 

Stand Slice Yes Yes Yes Yes Return 

Count Splice No No No No Return 

(Set)=#1 DOC Yes Yes Yes Yes Return 

Enable (Auto) Yes No No No Return 

Indexing --- No No No Return 

Send Address No No No No Return 

Input OK Yes Yes Yes Yes Return 

8 X   Plus  Key      

Exit     Return 

 

SW103 – with FS Controller III 

1 2 3 4 5 6 7 8  

x x x • x x x x On 

• • • x • • • • Off 
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SW103 – Without FilePrint 300 

1 2 3 4 5 6 7 8  

• x x x x x x x On 

x • • • • • • • Off 

 

Mode Description 

Film adjust vertical SHIFT +  or  then + or - 

Film adjust horizontal SHIFT + 4 then Yes or No then Return 

C

Canofile CF510S. 

anon Canofile 510/510S 
The Canofile 510 is a standalone electronic filing system with a built-in 50 
page per minute double-sided scanner. This has been discontinued by 
Canon. However, the CF510 has a SCSI connection which enables it to be 
attached to a PC and used as a scanner. Only certain CF510s can be used 
as scanners, so please check with Canon to ensure compatibility. 

The screen below shows the scanner setup for the Canofile CF510 and 
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Scan Resolution 
The CF510 has two scan resolutions 

• 200 x 100 dpi 
• 200 x 200 dpi 

View Options 
These options will affect how the images are stored and displayed. Standard 
documents will normally be scanned using the Standard Mode. Photo mode 
scanning will enhance the document during scanning, and result in better 
quality scans of pictures. Please note that the Photo Mode option will result 

. 

scanner, this can be set to scan the front of a 

ing Front/Back One Page will result in both 
sides of the document being stored as one image. 

in larger scanned file sizes

Each document scanned by the CF510 will have a Black border up to the 
maximum paper size of the CF510 scanner. Choosing the Crop Border 
option removes this border. 

The CF510 has a double-sided 
document only or both sides of a document. For double-sided scanning there 
are two options. Front/Back scanning will place each side of the document 
into a separate page. Choos
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Brightness Controls 
The scan brightness settings can be adjusted manually to suit the documents 

TWAIN 

t directly within the TWAIN 

When selecting Scanner Setup from the Options menu, the TWAIN setup 
ed. From this screen you can select whether the TWAIN 
ce will be displayed, and therefore whether you can 

ners have built-in image compression capabilities to 
reduce the amount of information sent between the scanner and the PC. If 

r has this capability, it can be selected by choosing the Use 
ed Transmission option. 

K

r the KOFAX scanner. 

being scanned. Alternatively, the Auto option can be used to allow the 
scanner itself to determine the optimum setting. 

ScanFile has support for TWAIN compliant devices. TWAIN is an open 
standard device driver for scanners, and any scanner supplied with a TWAIN 
device driver should work with software applications supporting the TWAIN 
standard. 

The scanner settings for TWAIN devices are se
device driver itself. The TWAIN interface will be displayed when scanning is 
started from ScanFile, whereupon the scanner settings can be applied. 

screen will be display
device driver interfa
change the current settings. If you choose not to display the screen the 
scanner will immediately start scanning. 

If the scanner is a double-sided device, choosing the Use duplex mode will 
set the scanner to double sided scanning. 

Some TWAIN scan

the scanne
Compress

ofax 
Kofax manufacture specialist image processing boards for PCs to allow them 
to support high-speed scanners from companies such as Bell & Howell and 
Kodak. A TWAIN driver is available fo
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Overview 
Built in to ScanFile are utilities that will assist you if you experience problems 
with any of your folders or libraries. For this case ScanFile offers following 
functions to maintain and repair folder and libraries.  

The functions do not replace a regular backup. You should always take 
regular backups of all your ScanFile folders and libraries to prevent loss of 
data. 

M

ords pointing to missing document 
files are found, a record of these will be written to the file Error.log, which is 

 

ed, and the 
documents rescanned. 

aintain Folder 
This utility is available from File -> Maintain Folder. ScanFile will check a 
folder for any errors within the database and for missing or corrupt document 
files. If any incorrect index records or rec

created in the PC’s TEMP directory.

Problems such as these can occur if the PC was switched off during 
scanning or deleting, if the hard disk became full or corrupt, or if document 
files have been deleted from the ScanFile folder from outside of ScanFile. 

Unfortunately, there is not a way to automatically correct such problems, and 
therefore the concerned index records will have to be delet

The Maintain folder utility may take some time to run but it is strongly 
recommended before writing a folder to archive write-once devices. 

Repair Folder 
 problem when trying to open a folder, you will be 

 utility. You can select this option from the 
If you experience a
prompted to run the Repair folder
File -> Repair Folder menu. This will attempt to repair and compact the 
folder database. Over time, the database may become fragmented on the 
hard disk, which will affect its performance. Compacting the database will 
rewrite it to a single area of the hard disk, and will also free any unused 
space in the database caused by deleted records. In most cases, running this 
utility should resolve problems with the folder. 
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R

ility. This option can be selected from the Libraries -> Repair 
library menu. This will attempt to repair and compact the library. The 

n to a single area of the hard disk, and will also free 
 database caused by deleted records. In most cases, 

epair Library 
Just like ScanFile folders, it may happen that you experience a problem 
when you are trying to open a library. You will be prompted to run the Repair 
library ut

database will be rewritte
any unused space in the
running this utility should resolve problems with the library. 
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 Remote Service Configuration Tool, which is used to 

Included in the ScanFile setup is a server-based application called Remote 
Services. In version 7 this application was a configuration tool and executing 
program in one. In Version 8 the Remote Services is in two parts: the 
Remote Service and the
configure the service. Once the Remote service has been configured the 
Configuration Tool doesn’t need to be running for the Remote Service to be 
active. 

If you wish to use the Remote Services a client installation has to be 
performed on the server to install the necessary components. 

The modules available, subject to the options that have been purchased, are: 

 
Import of Electronic Documents 

 
Import of Files & Index 

 
Import of Indexes Only 

 
Library Update * 

 
Import of COLD data * 

Document Routing * 
 

Audit Trail * 
 

 
TIFF Spooler ** 

 
Fulltext OCR reading * 

 
Zone OCR reading * 

 
Retention Control 

 

* Features marked with an asterisk are additional purchases to the ScanFile 
core application 

** depending on the tasks you want to carry out, you may need an OCR and 
Forms Recognition licence 
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Remote Services (Windows Service) 

rvices application will be installed and automatically 

rvice will be added 
to the list of server services. By default, this will be configured to use the local 

rmissions. The Remote Service will require full 
gram directory and to the ScanFile folders 

kstations acting as a server.  

ion and monitoring application for this can be 

The Remote Service is per default installed with the start type “Manually”. 
ve after installation and is not automatically started after a 
 to use the functionalities of the Remote Service, go to 

utomatically’. 
This way the service will be started right after a reboot. Close the Service 
Control Panel. With right Mouse -> Start you can now start the service. 

User Account 
ervice utilises the local system account to access its 

etwork resources, this should be a domain 
account.  

The Remote Service carries out the scheduled tasks. This application has 
been specifically designed to be run on Microsoft Windows NT4 and 2000 
Servers or NT4, 2000 and XP workstations that may act as a workgroup 
server. The Remote Se
started during the installation of ScanFile.  

When the Remote Services are installed, the Remote Se

system account for its pe
access to the ScanFile pro

If stopped, the Remote Services application will not perform its purpose, as 
the system process must continue to run for the duration of the required 
times and dates scheduled. For this reason it is intended to be run only on 
servers, or wor

In addition to the services mentioned above, if the optional ScanFile VNP has 
been installed, the configurat
started and stopped from within Remote Services Configuration Tool, from 
the ScanFile VNP menu option. ScanFile VNP is described later in this 
Guide. 

Configuration 

Therefore it is inacti
reboot. If you want
Start -> Settings -> Control Panel -> Administrative Tools -> Services. 
Select ScanFile Remote Service. With the right mouse button, select 
Settings to display the ScanFile Remote Service Properties. The tab 
General contains the start type. Change it from ‘manually’ to ‘a

The Remote S
resources. The access rights of the local system account are limited. You 
should assign a user account that provides the necessary access rights. 

We recommend to create a new user account for the Remote Service. If the 
Remote Service has to access n
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In case you are working with the ScanFile Account, please ensure that 
ScanFile and the Remote Service work with the same user account. 

Permissions 

The user you create must have Logon Locally rights and have permissions to 
change data on the following locations: 

• ScanFi
• ScanFi

le program directory 
le folders drive(s)/directories 

Remote Services Configuration Tool 
p and schedule the 

modules to run at set times and dates for their individual purpose. The 
e application to the main body of ScanFile but still 
folders and libraries created and maintained by 

E

lders. Any document saved or copied 

The days, time period and frequency of the Scheduler can be set by 
uler option at the left of the main screen. The values set 

be searched for new documents to be 

You can set the start and end period during the day for which the update will 
be performed by entering the start time and end time in the From and To 
fields.  

• ScanFile library drive(s)/Directories 

The Remote Services Configuration Tool is used to setu

program runs as a separat
requires information from 
ScanFile to be able to operate correctly. 

lectronic Document Service  
The Electronic Document Scheduler gives you the facility to automatically 
save documents to specific ScanFile fo
to a named directory will be archived into that directory’s designated ScanFile 
folder. In contrary to version 7, the amount of monitored directories is not 
limited. 

Update Schedule  

choosing the Sched
determine when the directories will 
added to the specified folders.  

To select the days for the update to be performed, tick the checkboxes 
alongside the days required.  
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You can then select how often during the selected time period the update will 
be performed, by putting a value in minutes in the Update every… field.  

Folder 
To select a ScanFile Folder to import documents from the Search directory, 
click on the Add button below the folder list. You can then select the folder 
from the available storage locations. Once you have selected the folder, it will 
be shown in the folder list. To specify the search and backup drive and the 
indexing options, the folder must be selected in the folder list, by clicking on 
the folder name. The name will then be highlighted.  

To remove a ScanFile Folder from the list, highlight the name by clicking on it 
and then click on the Delete button below the folder list.  

Search Drive 
The Search Drive should point to the location where documents are going to 
be saved or copied to. This can be a directory on a drive or a UNC path. After 
selecting the Folder you can specify the location by clicking on the three dots 
immediately after the field, which will then display a directory find screen. 
Once you have selected the location, click on the OK button, and the name 
of the location will be shown in the field.  

Backup Drive  
When the scheduler imports the files from the Search location to the 
specified ScanFile folder, the file(s) will be deleted from the Search location. 
To enable you to keep a copy of the file(s) outside of ScanFile, you can 
select a location to make a copy of the file(s) to.  

You can specify the location by clicking on the three dots immediately after 
the field, which will then display a directory find screen. Once you have 
selected the location, click on the OK button, and the name of the location 
will be shown in the field. 

Indexing Options  
Documents can be imported into a ScanFile Folder in one of two ways, and 
the file name can be used for automatic indexing of the documents.  

1) Postindex  

When the Postindex option is selected, all documents found to be archived 
will be placed in the selected ScanFile Folder’s Postindex pool for later filing.  
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Electronic Document Service 

Seit

2) Using the File Name  

The Direct Index option together with the Use filename as default index 
will save the documents directly to the folder, creating index records for each 
document saved, and placing the name of the file into the FIRST folder field.  

Separator 

If you also select a Separator, the name of the file can be delimited so that it 
can be placed into separate consecutive Folder fields. Valid separators are:  

, comma  ; semi-colon   . full stop 

- dash  _ underscore   ‘ quote 

When Direct Indexing is selected and Use filename as default index is not 
selected, the document’s file name can be used to fill selected index fields 
and to assign keywords. This is achieved by prefixing the index data in the 
file name with &I and the Folder field Number. 

K
&

 

Example: - using a semi-colon as the separator 

D Smith Ltd;Quotation;01/06/2000.doc 

Field 1 = D Smith Ltd  
Field 2 = Quotation  
Field 3 = 01/06/2003 

Selective Indexing & Keywords 

 

Seit
Example: 

&i1D Smith Ltd&i2Quotation&i401/06/2000.doc  

Note that there is no entry for Field 3  
e 298 • Remote Services 
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Separators and Prefixes are replaced by an underscore in the filename 
during the import. 

Example: 

&i1D Smith Ltd&i201/06/2003&kQuotation&ksoftware.doc  

Field 1 = D Smith Ltd  
Field 2 = 01/06/2003 
Keyword = Quotation, Software 

Update Now  
This functionality gives you the opportunity to import documents from the 

COLD Import Service  

matically save COLD data information to 
specific ScanFile folders using a pre-defined indexing template. Any COLD 
d
f
F ifferent location, 
and using a different COLD template.  

U
The days, time period and frequency of the document scheduler can be set 
by choosing the Scheduler option at the left of the main screen. The values 

be searched for new COLD files to be 
he specified folders.  

search drives fast and out of schedule. Pressing the Update Now button will 
cause the Remote Services to perform an update with the next update loop. 

This scheduler only works, if the option is licensed. The COLD Import 
Scheduler gives the facility to auto

ata saved or copied to a named location will be archived into the ScanFile 
older that the location is associated with. An unlimited amount of ScanFile 
olders can be specified, with each Folder pointing to a d

pdate Schedule  

set determine when the directories will 
added to t

To select the days for the update to be performed, tick the checkboxes 
alongside the days required.  
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You can set th
will be perform

e start and end period during the day during which the update 
ed by entering the start time and end time in the From and To 

F
To select a ScanF
button below the folder list. You can then select the folder from the available 
torage locations. Once you have selected the folder, it will be shown in the 

backup drive and the import template, 
t
T

T t, highlight the name by clicking on it 
and then click on the Delete button below the folder list.  

r a UNC 
path. You can specify the location by clicking on the three dots immediately 
after the field, which will then display a directory find screen. Once you have 

on the OK button, and the name of the location 

 be deleted from the Search location. 
To enable you to keep a copy of the file(s) outside of ScanFile, you can 

er 
the field, which will then display a directory find screen. Once you have 

 the OK button, and the name of the location 

ith the 
ScanFile Folder. The template will have been created in ScanFile previously.  

fields.  

You can then select how often during the selected time period the update will 
be performed, by putting a value in minutes in the Update every… field.  

older 
ile Folder to import the COLD data to, click on the Add 

s
folder list. To specify the search and 
he folder must be selected in the folder list, by clicking on the folder name. 
he name will then be highlighted.  

o remove a ScanFile Folder from the lis

Search Drive  
The Search Drive should point to the location where the COLD files to be 
imported are saved or copied to. This can be a location on a drive o

selected the location, click 
will be shown in the field.  

Backup Drive  
When the scheduler imports the files from the Search location to the 
specified ScanFile folder, the file(s) will

select a location to make a copy of the file(s) to.  

You can specify the location by clicking on the three dots immediately aft

selected the location, click on
will be shown in the field. 

Import Template  
You must specify the pre-defined COLD import template to be used w
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You can specify the import template by clicking on the three dots immediately 
after the field, which will then display a template list. Once you have selected 
the template, click on the OK button, and the name of the template will be 
shown in the field. 

Files and Index Import Service  
The Files and Index Scheduler gives the facility to automatically save files 
and ASCII or ANSI data files to specific ScanFile Folders. Any files and 
indexes saved together, and copied to a named directory, will be archived 
into that directory’s designated ScanFile folder, providing the information is in 
the correct format. In contrary to version 7, the amount of monitored 
directories is not limited. 

Update Schedule  
The days, time period and frequency of the document scheduler can be set 
by choosing the Scheduler option at the left of the main screen. The values 
set determine when the directories will be searched for new documents to be 
added to the specified folders.  

To select the days for the update to be performed, tick the checkboxes 
alongside the days required.  

which the update 

You can then select how often during the selected time period the update will 
be performed, by putting a value in minutes in the Update every… field.  

F
ents from the search directory, 

e folder, it will 
be shown in the folder list. To specify the search and backup drive and the 

Update Now  
This functionality gives you the opportunity to import COLD files from the 
search drives fast and out of schedule. Pressing the Update Now button will 
cause the Remote Services to perform an update with the next update loop. 

You can set the start and end period during the day during 
will be performed by entering the start time and end time in the From and To 
fields.  

older 
To select a ScanFile Folder to import docum
click on the Add button below the folder list. You can then select the folder 
from the available storage locations. Once you have selected th
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field, the folder must be selected in the folder list, by clicking on the folder 
name. The name will then be highlighted.  

To remove a ScanFile Folder from the list, highlight the name by clicking on it 
and then click on the Delete button below the folder list.  

Search Drive  
The Search Drive should point to the location where data to be imported is 
saved or copied to. This can be a location on a drive or a UNC path. You can 
specify the location by clicking on the three dots immediately after the field, 
which will then display a directory find screen. Once you have selected the 
location, click on the OK button, and the name of the location will be shown 
in the field.  

Backup Drive  
When the scheduler imports the files from the Search location to the 
specified ScanFile folder, the file(s) will be deleted from the Search location. 
To enable you to keep a copy of the file(s) outside of ScanFile, you can 

 you have 

 the search drives fast and out of schedule. Pressing the 
Update Now button will cause the Remote Services to perform an update 

select a location to make a copy of the file(s) to.  

You can specify the location by clicking on the three dots immediately after 
the field, which will then display a directory find screen. Once
selected the location, click on the OK button, and the name of the location 
will be shown in the field. 

Fields 
Enter the number of fields the index information contains along with the field 
separator and delimiter. Then select whether the index information is 
contained in an ASCII or ANSI format. 

Update Now  
This functionality gives you the opportunity to import files and index 
information from

with the next update loop. 
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In
he facility to automatically save ASCII or ANSI 

data files to specific ScanFile Folders as index information. Any indexes 
 will be archived into that directory’s 
e information is in the correct format. 

ave the correct information saved in one of the ten connect 
fields, this allows the information in the data file to be imported into the 
correct fields. You must select which format the data is in ASCII or ANSI and 
the number of fields, field separator and field delimiter.  

Update Schedule  
The days, time period and frequency of the document scheduler can be set 
by choosing the Scheduler option at the left of the main screen. The values 
set determine when the directories will be searched for new documents to be 
added to the specified folders.  

To select the days for the update to be performed, tick the checkboxes 
alongside the days required.  

You can set the start and end period during the day during which the update 
will be performed by entering the start time and end time in the From and To 
fields.  

You can then select how often during the selected time period the update will 
be performed, by putting a value in minutes in the Update every… field.  

selected the folder, it will be shown in the 
folder list. To specify the search drive, the connected field and the linked 

 be selected in the folder list, by clicking on the 
hen be highlighted.  

dex Import Service  
The Index Scheduler gives t

saved and copied to a named directory,
designated ScanFile Folder, providing th
In contrary to version 7, the amount of monitored directories is not limited. 

With the index only scheduler the folder that the index is being imported to 
must already h

Folder 
To select a ScanFile Folder to import index information into, click on the Add 
button below the folder list. You can then select the folder from the available 
storage locations. Once you have 

index fields, the folder must
folder name. The name will t

To remove a ScanFile Folder from the list, highlight the name by clicking on it 
and then click on the Delete button below the folder list.  
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Search Drive  
The Search Drive should point to the location where the index data file is 
located. This can be a location on a drive or a UNC path. You can specify the 
location by
t
d
s

, bar-coded documents 

ect field, and the additional index information will then be 

 clicking on the three dots immediately after the field, which will 
hen display a directory find screen. Once you have selected the location and 
ata file name, click on the OK button, and the name of the location will be 
hown in the field.  

Fields  
The Import Index function is used to fill index records in existing folder 
documents with additional information. As an example
may have been scanned, with the barcode representing a Project Number. 
An external file – MS Access or ASCII format – can have that number in it 
plus the Document Name, Document No etc. The Project Number can be set 
to be the Conn
imported to the appropriate records.  

 

The example text file shows 10 records, with the index information within the 
 The first field is the Project Number – 
 exist in the folder. The Import will use 

er fields will be displayed on the left, and the fields from the import 

T
t
will cause the Remote Services
update loop. 

records being delimited by commas.
the Connect field – which will already
this to search for matching records, and then fill the other folder fields with 
the additional information.  

The Fold
file can be matched to these. It is very important that the No. of fields, 
parameter is correctly set, as well as any field separators and delimiters  

Update Now  
his functionality gives you the opportunity to import index information from 

he search drives fast and out of schedule. Pressing the Update Now button 
 to perform an index update with the next 
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L

 screen, and then ensure that the Scheduler 
checkbox is ticked. Once this is done, press the Apply button.  

U
The days, time period and frequency of the library update scheduler can be 

 choosing the Scheduler option at the left of the main screen. The 
 set determine when the directories will be searched for libraries to be 

start time and end time in the From and To 

You can then select how often during the selected time period the update will 
be performed, by putting a value in minutes in the Update every… field.  

Library Directories 
To select a directory or path where libraries can be found on, click on the 
Add button below the folder list. You can then select the directory from the 
available storage locations. Once you have selected the directory, it will be 
shown in the library directory list. 

The scheduler will update any library with the Scheduler setting in the 
selected drives/paths. The system will check, if any of the imported folders 
has been updated since being imported into the library. In this case the data 
in the library is updated according to the folder data.  

Repeat this step for every directory or path you want to automatically update 
libraries on. 

ibrary Update Service  
This scheduler only works, if the option is licensed. On the contrary to version 
7, an unlimited amount of locations can be selected to check for libraries that 
are set to scheduled update. 

Setup Libraries  
The Scheduler will update only libraries that have been set for scheduled 
updating. To do this, open Setup library in ScanFile, select the library from 
the list on the left of the

pdate Schedule  

set by
values
updated.  

To select the days for the update to be performed, tick the checkboxes 
alongside the days required.  

You can set the start and end period during the day during which the update 
will be performed by entering the 
fields.  
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To remove a Sc
and then click o

anFile Folder from the list, highlight the name by clicking on it 
n the Delete button below the folder list.  

Folder Directories 
To select a directory or path where folders that were added to libraries can 
be found on, click on the Add button below the folder directory list. You can 
then select the directory from the available storage locations. Once you have 
selected the directory, it will be shown in the folder directory list. 

Repeat this step for every directory or path folders needed for the automatic 
update are located on. 

To remove a ScanFile Folder from the list, highlight the name by clicking on it 
and then click on the Delete button below the folder list.  

Update Now  
This functionality gives you the opportunity to update libraries located in the 
search drives fast and out of schedule. Pressing the Update Now button will 
cause the Remote Services to perform a library update with the next update 
loop. 

Document Routing 

ts, and if all 
the actions within a routing step have taken place for a particular document, 

re disabled. 

Documents that are currently In Progress within a route will be listed in the 

tory to date. This will include the date and time 
of a routing action, the type of action and the name of the user.  

This scheduler only works, if the option is licensed. The Document Routing 
Scheduler progresses documents through each step of a documents specific 
route. Every 5 minutes the service will check all routed documen

the document will be progressed to the next step within the route. Therefore 
the scheduler timer settings a

In Progress Documents  

service window and by double-clicking on one of the documents, further 
information about the document will be displayed, such as the index 
information, and it's routing his
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Update Now  
This functionality gives you the opportunity to route fast and out of schedule. 
Pressing the Update Now button will cause the Remote Services to perform 
an update with the next update loop. 

Audit Trail 
This scheduler only works, if the option is licensed. The Audit Trail service 
allows authorised users to maintain the audit database. Dependent upon 
what events you have decided to audit, and the level of activity within 
ScanFile, the audit database can become extremely large, and you may 
therefore decide that certain events can be deleted after a time period. The 
standard schedule, which is once every 24 hours from the time the service 
was started. Therefore the scheduler timer settings are disabled. 

If you do not wish to delete any audit events, do not run the Audit Trail 
service.  

Never Delete Automatically  
You can select which types of events will not be deleted automatically when 
the service is operating. When the event types are ticked, they will NOT be 
deleted.  

Deletion Period  
The number of days, after which events can be deleted, is in the range of 1 to 
999.  

Export Audit Trail Data  
Audit Trail Exportpath 

The Audit Trail Exportpath should point to the location where the export 
database should be saved to. This can be a location on a drive or a UNC 
path. You can specify the location by clicking on the three dots immediately 
after the field, which will then display a directory find screen. Once you have 
selected the location, click on the OK button, and the name of the location 
will be shown in the field.  

Export audit trail data 
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If you wish to export data, click on Export audit trail data. You will be given 
the opportunity to add a description to your export. Then the program 
automatically exports all records to a newly created database in the Audit 
Trail Export Path, named with the current date and time. 

In the ScanFile Audit Trail Report window you can then select from the 
exported databases and create a temporary Audit trail database to search in. 

Compact Database  
It is a good idea to periodically run the Compact database option, as this will 
check the database for any errors and compact it, removing deleted records.  

Update Now  
This functionality gives you the opportunity to delete events from 
SFAudit.mdb fast and out of schedule. Pressing the Update Now button will 
cause the Remote Services to perform an update with the next update loop. 

This service allows the automatic import and recognition of forms, and works 
in conjunction with the form templates created and configured within 
ScanFile. The forms to be imported must be Group 4 compressed TIFF 
format files or JPEG files.  

Update Schedule  
The days, time period and frequency of the document scheduler can be set 
by choosing the Scheduler option at the left of the main screen. The values 
set determine when the directories will be searched for new documents to be 
added to the specified folders.  

To select the days for the update to be performed, tick the checkboxes 
alongside the days required.  

You can set the start and end period during the day during which the update 
will be performed by entering the start time and end time in the From and To 
fields.  

Specify how often, in minutes, that the service will check the image storage 
path for new documents, by putting a value in minutes in the Update every… 
field. The valid range is 1-9999 minutes.  

TIFF Spooler Service  
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Folder 
To select a ScanFile Folder the forms will be imported and indexed to, click 
on the Add button below the folder list. You can then select the folder from 
the available storage locations. Once you have selected the folder, it will be 
shown in the folder list. To specify the image storage path, backup directory 
and the form database, the folder must be selected in the folder list, by 
clicking on the folder name. The name will then be highlighted.  

To remove a ScanFile Folder from the list, highlight the name by clicking on it 

rvice will check only this location for forms to import. Documents, 

Backup drive  
ler imports the files from the Image Storage path to the 
 folder, the file(s) will be deleted from the storage location. 

an 

ree dots immediately after 
irectory find screen. Once you have 

e location 

Form Database  
Select the database that contains the form templates. The default forms 

 the ScanFile program directory, although 

and then click on the Delete button below the folder list.  

Image Storage Path  
Select the location that the service will check for documents to import from. 
The se
which should be automatically imported and indexed must be placed here.  

When the schedu
specified ScanFile
To enable you to keep a copy of the file(s) outside of ScanFile, you c
select a location to make a copy of the file(s) to.  

You can specify the location by clicking on the th
the field, which will then display a d
selected the location, click on the OK button, and the name of th
will be shown in the field. 

database is default.sff, which is in
this can be changed.  

Create batch  
This setting is for documents created by ScanFile VNP archive printing. In 
this case documents with more than one page are stored as one document.  
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Update Now  
This functionality gives you the opportunity to import forms from the search 
drives fast and out of schedule. Pressing the Update Now button will cause 
the Remote Services to perform an import with the next update loop. 

Fulltext OCR Scheduler  

licensed. This 
ers. Any 
 on the 

To remove a ScanFile Folder from the list, highlight the name by clicking on it 
and then click on the Delete button below the folder list.  

Update Schedule  

duler option at the left of the main screen. The values 
set determine when the folders will be searched for new documents to be 

To select the days for the update to be performed, tick the checkboxes 
alongside the days required.  

ing the day during which the update 

Update every… field.  

Overview  
This scheduler only works, if option OCR is installed and 
service will automatically perform full text recognition on selected fold

R'd in the folders will be processedpages that have not been OC
selected days and time.  

Folder 
To select a ScanFile Folder to have the full text OCR performed upon, click 
on the Add button below the folder list. You can then select the folder from 
the available storage locations. Once you have selected the folder, it will be 
shown in the folder list. 

The days, time period and frequency of the fulltext OCR scheduler can be set 
by choosing the Sche

OCR'd.  

You can set the start and end period dur
will be performed by entering the start time and end time in the From and To 
fields.  

You can then select how often during the selected time period the update will 
be performed, by putting a value in minutes in the 
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Update Now  

Zone OCR Scheduler  

  

Update Schedule  
y of the zone OCR scheduler can be set 
t the left of the main screen. The values 

set determine when the folders will be searched for new documents to be 

ys required.  

You can set the start and end period during the day during which the update 
ring the start time and end time in the From and To 

This functionality gives you the opportunity to perform a fulltext OCR fast and 
out of schedule. Pressing the Update Now button will cause the Remote 
Services to perform an OCR reading with the next update loop. 

Overview
This scheduler only works, if option OCR is installed and licensed. This 
service will automatically perform zone recognition on selected folders. Any 
documents that have not been zone OCR'd in the folders will be processed 
on the selected days and time.  

Folder 
To select a ScanFile Folder to have the zone OCR performed upon, click on 
the Add button below the folder list. You can then select the folder from the 
available storage locations. Once you have selected the folder, it will be 
shown in the folder list. 

To remove a ScanFile Folder from the list, highlight the name by clicking on it 
and then click on the Delete button below the folder list.  

The days, time period and frequenc
by choosing the Scheduler option a

zone OCR'd.  

To select the days for the update to be performed, tick the checkboxes 
alongside the da

will be performed by ente
fields.  

You can then select how often during the selected time period the update will 
be performed, by putting a value in minutes in the Update every… field.  
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Update Now  
This functionality gives you the opportunity to perform a zone OCR fast and 
out of schedule. Pressing the Update Now button will cause the Remote 
Services to perform an OCR reading with the next update loop. 

R

e set for each document. This is specified in months 
 original creation or from the date of last updating. 

To select a ScanFile Folder to be monitored for retention action, click on the 
Add button below the folder list. You can then select the folder from the 

lected the folder, it will be 

Schedule  

settings assigned to them in ScanFile. 

etention Control 

Overview  
A retention period can b
and will apply either from
At the expiry of the forward period each document may be selectively moved, 
exported “off-line” or destroyed. 

Add a Folder to the Retention -Control 
The retention control will only monitor folders that are set for it. To add a 
folder to the retention control, select File – Setup folder in ScanFile. Select 
the folder in the folder list and switch to the tab Extended Settings. Select 
Retention control scheduler - Add Folder checkbox. 

Folder 

available storage locations. Once you have se
shown in the folder list.  

To remove a ScanFile Folder from the list, highlight the name by clicking on it 
and then click on the Delete button below the folder list.  

Update 
The days, time period and frequency of the Retention Control scheduler can 
be set by choosing the Scheduler option at the left of the main screen. The 
values set determine when the documents in the selected folders will 
processed according to their retention 

To select the days for the update to be performed, tick the checkboxes 
alongside the days required.  
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You can set the start and end period during the day during which the update 
will be performed by entering the start time and end time in the From and To 
fields.  

Y
be performed, by putting a value in minutes in the Update every… field.  

ou can then select how often during the selected time period the update will 

Update Now  
This functionality gives you the opportunity to perform the defined retention 
actions for the documents fast and out of schedule. Pressing the Update 
Now button will cause the Remote Services to perform an update with the 
next update loop. 
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Overview 

O

In most cases the VNP is used to archive external correspondences. 
ith a similar structure can be printed 
ith the Zone OCR Scheduler. Thus 

Installation 

ly be installed in conjunction with ScanFile. The Installation of the 
VNP will be cancelled if the setup program is not able to localise a licensed 
ScanFile version on the local system. In order to install the VNP you have to 
install ScanFile and license ScanFile as well as the VNP. 

osoft .Net Framework 1.1. It can be 

verview 
ScanFile VNP is a virtual network printer to print documents into a specified 
Location. The documents are stored as TIFF files and can be imported into 
any ScanFile folder. This can even be done automatically by using the 
ScanFile Scheduler. 

With the VNP a document can be archived from any program just by printing 
it via VNP. 

Typesets like invoices or delivery notes w
via the VNP and automatically indexed w
the indexing is very safe because the documents are finished electronically 
without the loss of quality through manual scanning. 

To install ScanFile VNP some necessary preparations have to be made. The 
VNP can on

ScanFile VNP also requires the Micr
downloaded from the Microsoft website for free. An installation guide is also 
available on the Microsoft website. 

Please note that Microsoft .Net Framework 1.1 is required to run ScanFile 
VNP. It is not included in later Versions of the Microsoft .Net Framework. 
The installation of Microsoft .Net Framework is insufficient. 

 

The ScanFile VNP Service based on Microsoft .Net can only be used with 
ScanFile version 8.0.3 and later. All earlier Versions have to use older VNP 
versions. 

Setup 
The ScanFile VNP is no longer installed during the ScanFile setup. The VNP 
has to be installed out of his own setup program. To install ScanFile VNP 
open the VNPSetup.msi in the Software\VNP folder on the ScanFile CD. 
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Location 
In the first step you will be asked to choose the drive and directory that 
ScanFile VNP will be installed into. A default of C:\Program Files\VNP will 
be offered, this can be changed to the server location you wish to install 
ScanFile VNP to. Once you have chosen the drive and directory, press the 
Next button. 

The folder that is used by ScanFile VNP to archive it’s files has to be shared 
in order to provide ScanFile Schedulers the opportunity to get the VNP 
archived files. 

 

Please make sure that in case of a network installation the folder bin\temp 
in the VNP installation path is shared with all Users to make the VNP 
accessible from every ScanFile client. 

VNP Service 
After finishing the installation a new service named VNP Manager appears in 
the Windows Services. This service is started automatically and runs the 
process VNPMan.exe. To use the VNP this service must be started. 

C

inters 

Every Port represents an archive path of ScanFile VNP. The number of Ports 
 not limited. After installing ScanFile VNP a Port named VNP_001 already 

fers to the Archive folder in the ScanFile VNP installation path. 

<Installation path>\Archive 

T a po
Configuration of Ports

To install a new virtual printer just open the Add Printer Wizard. Choose Start 
-> Settings -> Control Panel -> Printers and Faxes -> Add Printer. 

onfiguration 

Virtual Pr
The virtual printers are using so called Ports or VNP Forwarder. These ports 
can be set with the Configuration Tool. 

is
exists. It re

he path for rt can be changed in the Configuration Tool. The 
 is described later in this chapter. 
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P xt Button
in the following dialog
and install my Plug 

ress the Ne  and choose Local Printer attached to this computer 
. Please take care that the option Automatically detect 
& Play printer is not selected. 

 

Once you have chosen the needed settings, press the Next button. 

In the next step the printer port has to be selected. At this point you can 
decide either to use an existing port or creating an new one. To use an 
existing port choose the option Use the following port and select the 
preferred port. 

Seite 318 • ScanFile VNP 



ScanFile Benutzerhandbuch 
Configuration 

 

If you wish to create a new port choose the option and  Create a new port 
select VNP as Type of port. 
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As every Port represents an archive path it is recommend that ever virtual 
printer should use it’s own port. The archive paths can be set in the 
Configuration Tool later on. 

Click on Next to proceed with the installation. 

g selects the printer driver. This has two options. The next dialo

 

If you want to keep your documents as TIFF files select the HP LaserJet 5 
ess Next. If there is already an HP 
eep the existing driver. 

d output, which can then be imported to allow for Full text searching 
of the documents. 

Instead of using the HP LaserJet 5 click on the Have Disk… button open the 
Rapid folder that is located in the ScanFile directory. Select the INF file and 
when the printer list is displayed, select Rapid 32, and press Next. 

from the list of available printers, and pr
LaserJet 5 printer configured, choose to k

The other option uses the Rapid 32 printer driver supplied with VNP, and will 
convert printed output to TIFF files and create data files containing the text of 
the printe
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You can then give the printer a meaningful name that will identify it as a 
virtual printer used by ScanFile for importing documents. You can also 
choose whether the printer will be the default printer. Once you have done 
this press Next. 

If you are creating the virtual printer on a server, you can share the printer to 
network users. Once you have chosen whether to share the printer or not, 
press Next. 

As you were installing a virtual printer you do not need to print a test page, so 
select No and then press Next. 

The last dialog shows a summary of the chosen printer settings. Press 
Finish if the settings are correct. The new virtual printer is then created by 
the system. 

Start\Program Files\ScanFile\VNP and select the 

Configuration of VNP Ports 
To set up the configuration of an existing VNP Port use the VNP 
Configuration Tool. Open 
Interface tab. 
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Choose the Port to be configured from the list on the left. To change the 
archive  path into the Path field or click on the Button “…” 
to open an open d

n 
By using LPD the VNP gets accessible from workstations that do not use 
Microsoft Windows as operating system. If there are only windows 

 default port for printers on a linux or unix based system. 

 path type the new
ialog. 

With the option Print you will be able to set up a Printer to archive and print 
out the document within one step. 

LDP Configuratio

workstations within a network it is not necessary to make use of the LDP 
option. 

The LDP function can be set up and activated with the Configuration Tool. To 
start the tool open Start -> Program Files -> ScanFile ->VNP and select the 
tab Common. By default the option LDP is activated and works on Port 515. 
This is the
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Please make sure that the used port is open. Maybe it is necessary to 
reopen the port after installing a Service Pack (for example Windows XP 
Service Pack 2) because the port is blocked by the Windows integrated 
firewall. 

To set up the folder for LPD select the Interface tab and choose LPD from 
the list. The LPD settings can now be changed. The configuration is equal to 
the setup of the VNP Ports that are used by the virtual printers. Read the 
Configuration of VNP Ports for further information. 

Once you have set up the configuration you may test if all settings are 
correct. This can be done with the Command Prompt and a spool or print file 
(*.spl or *.prn). 

Open Start -> Program Files -> Accessories -> Command Prompt and 
chance to the folder where the spool file is saved. The following command 
sends a print job via LDP to the VNP: 

lpr S [IP address of the server] –P [queue name] –J [job name] 
[filename] 

Example: lpr –S 127.0.0.1 –P VNP_001 –J „Job001“ testspool.prn 

After committing this command the VNP will archive the printed date in the 
selected folder. 

ScanFile VNP • Seite 323 



ScanFile Benutzerhandbuch 
Configuration 

Portprintig Configuration 
The Portprintig makes the VNP accessible to systems that support neither 
Windows printer sharing nor LPD. In this case the files can be send via raw 
TCP/IP. 

The Portprinting can be set up and activated with the Configuration Tool. To 
start the tool open Start\Program Files\ScanFile\VNP and select the tab 
Common. By default the Portprintig is activated and works on the Ports 9100 
to 9103. 

Please make sure that the used ports are open. Maybe it is necessary to 
reopen the ports after installing a Service Pack (for example Windows XP 
Service Pack 2) because the ports are blocked by the Windows integrated 
firewall. 

To set up the Portprinting folder select the Interface tab and choose the used 

t data stream to the VNP. Therefore it is not 

ey to set a manual form feed: 

Online [Userlevel1] -> Enter (Button) -> Next -> Next -> Next [Normal-
 

Port from the list. The settings can now be changed. The configuration is 
equal to the setup of the VNP Ports that are used by the virtual printers. 
Read the Configuration of VNP Ports for further information. 

Portprinting sends a coheren
possible to set the beginning or the end of a file. This could lead to difficulties 
if a connection fails. In this case it might be helpful to set a manual form feed. 
This can be done in the Configuration Tool on the WebPanel tab. Use the 
following k

Print/FF] -> Enter (Button)

The Portprinting should only be used in exceptional cases. It does not 
support any functions to control the running process. Its is recommend to 
use the virtual Windows printer or the LPD option if possible! 

RIP 
The RIP option defines the memory or the virtual printers. The VNP uses a 
dynamic memory allocation. Printing large files or pages with a high 

An undersized memory could result in a lesser quality or even incomplete 
documents

The memo nfiguration Tool on the Common tab. 

resolution the memory should be at least 128 MB. 

. 

ry size can be set in the Co
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WebPanel 

 

The WebPanel can be used in exceptional cases to set up printer emulations. 
If you are using a printer that has no GUI print driver the WebPanel allows 
you to change the printer settings. When using windows print drivers the 

s not required. 

I

WebPanel i

The WebPanel is designed to allow you to set setting such as resolutions, 
page width etc. that can’t be configured as the printer driver has no GUI to 
set such settings. An example of this would be an AS400 printer. 

These features are not described in this manual. Please ask our support 
team for further information. 

mport scheduler 
The TIFF Spooler or other import scheduler can be used to automatically 
import VNP printed files into ScanFile. Please read the Remote Services 
chapter for more information. 
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O
rnet technologies, supporting remote 

and mobile users and implementing corporate intranets using the web 
browser as the universal desktop client application. As this trend continues, 

ers and partners, are demanding 
ositories. ScanFile WebServer is 

nyone, anywhere in the world 

ScanFile, you have everything to store and reference 

F

downloaded. 

B

4/2000/XP 
and Microsoft Internet Information Server. 

rnet/intranet servers are separate to a company’s main 

verview 
Companies are rapidly embracing Inte

internal and external users, such as custom
Internet access to corporate document rep
uniquely positioned to deliver the vast benefits of Internet technology to 
users. 

With ScanFile WebServer, you can give a
access to your document libraries. ScanFile WebServer is an Internet server 
based application that allows the retrieval of documents using just a web 
browser. Whether you wish to make documents available over the Internet or 
an intranet, ScanFile WebServer is the fast, secure, reliable and easy way to 
do it.  

Used together with 
your documents, and then retrieve them no matter your location. 

eatures 
• Full search, display and download options on ScanFile document 

libraries, including full text search 
• Users only have access to authorized libraries 
• Fully automatic update of libraries 
• No additional client software required - just use a web browser 
• Any type of document stored in ScanFile can be displayed or 

• Complete audit trail report on accessed documents 

efore Installing 
ScanFile WebServer requires that the person installing and configuring 
WebServer is fully conversant with both Microsoft Windows NT

As the majority of inte
server, links between the servers will have to be established with the 
appropriate rights given to those links to allow users of WebServer access to 
libraries and documents. The default user account created for Internet 
Information Server (IIS) – IUSR_<machine name> - will have insufficient 
permissions to allow ScanFile WebServer to function correctly. As changing 
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the permissions for the default user could cause security problems for other 
applications you may be running via IIS, or the server running IIS is not the 
same server as that running ScanFile or where the folders/libraries reside, 

ollowing locations: 

 the default) 

The type of permissions you can apply will be dependant upon the location of 
d data, and what format of partition they reside on. You 
e user account and permissions for the ScanFile program 

In
To install WebServer, select Run… from the Windows Start menu and then 

erver to be in. 
Choose the desired language and press OK. 

rver. Select the ScanFile program directory 

the best course of action is to create a new user specifically for use with 
ScanFile WebServer. 

Permissions 
The user you create should be a Local User, not a Domain user. If the 
ScanFile location, or the folders/libraries are on a separate server then you 
will need to create a local user on each server, using the same name and 
password. This user requires permissions to the f

• ScanFile WebServer program directory and subdirectories 
• WebServer image cache directories (if different from
• ScanFile program directory 
• ScanFile folders drive(s)/directories 
• ScanFile libraries drive(s)/directories 
 

the programs an
should create th
directory and data locations prior to installing WebServer. After WebServer 
has been installed, the permissions to the WebServer program directory can 
be applied. 

stallation 

choose SetupSWS.exe from the Software directory on the ScanFile CD. 
Press the OK button. 

The first step is to choose the language that you wish WebS

ScanFile Location 
ScanFile WebServer must have access to a Licensed installed copy of 
ScanFile. It needs this to enable it to use the User security information when 
users access libraries via WebSe
and then press the Next button.  

The ScanFile path can also be entered as a UNC path 
Example: \\<machinename>\path. 
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Location 
You must then choose where ScanFile WebServer is to be installed. The 

ory, can be used, but this assumes that WebServer is not being 
he same server as ScanFile. Please ensure that WebServer is 

not installed as a sub directory of the ScanFile program directory, as no 

llback to the previous version if necessary. If 

I 

now ready to be installed. Pressing the Next button 
on the screen shown right will install WebServer into the selected directory. 

s completed, the Internet Server must be configured. 

I

are for Microsoft Internet Information Services supplied with Microsoft 
Windows 2000. 

o do this, right-click on 

default direct
installed on t

users require direct access to the WebServer directory. Once you have 
chosen the location to install WebServer, press the Next button to carry on 
with the installation. 

Backup 
If you are updating an existing copy of WebServer, you can choose to 
backup any files that are replaced during the installation. If you select Yes, it 
will be possible to perform a Ro
you choose No, the previously installed copy will be overwritten, and a 
rollback will not be possible. 

WebServer AP
WebServer has an API that allows you to integrate it's functionality into your 
own web sites. You can select whether you want to install the API or not. 
Contact your supplier on how to obtain a full description of the WebServer 
API. 

ScanFile WebServer is 

After this ha

IS Configuration 
After installing ScanFile WebServer your Internet Server must be configured 
to allow users access to WebServer. The following installation instructions 

Virtual Directory 
After you have started Internet Services Manager, you must create a new 
Virtual Directory for WebServer in your web site. T
your web site and then select New -> Virtual Directory. 
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A welcome screen will then be displayed. Click on Next and you will then be 
prompted for the name that you wish to give to the ScanFile WebServer part 

 a short name is more useable. After 
me and pressing Next, you must then enter the path to the 

ScanFile WebServer Directory for the content of the site. You can either type 

from the default 
permissions. Once you have set the permissions, the WebServer setup is 

ount for WebServer to use in IIS, this must 
igured. To do this open the Properties screen for the WebServer 

virtual directory, and select the Directory Security tab. You must then edit 

at you 
previously created from WebServer to allow access to ScanFile libraries. 

Y to control password option. Once you 
have done this, the WebServer configuration within IIS is complete. 

Configuring WebServer 
e Virtual Directory, you can then log 
 created by opening your browser 

software and typing in the name of the site together with the alias you 

.com, entering http://www.scanfile.com/sfweb will display the 

of your site. This can be anything, but
typing in a na

in the location or use the Browse button to locate the directory. 

The next part to configure is the Access Permissions. This will determine 
what rights users will have when they access the WebServer site. For 
standard access, you do not normally need to change 

complete. 

WebServer user 
If you have created a user acc
also be conf

the Anonymous access and authentication control properties. Click on 
the Edit button, and the Authentication Methods screen will open. 

You must then edit the Account used for anonymous access property. This 
can be done by clicking Edit. This will then open the Anonymous User 
Account screen, which allows you to select the user account th

ou must also disable the Allow IIS 

Once you have created and configured th
on to the WebServer site you have just

selected for the WebServer Virtual Directory.  

Example: 

If the Virtual directory has been called SFWeb, and the site is called 
scanfile
ScanFile WebServer login screen. 

To access ScanFile libraries via WebServer, each user must log in. The user 
names, passwords, and the libraries the users are allowed access to is 
defined within the Security setup of ScanFile.  
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The first time you use WebServ
see the WebServer section in 

er, it will report that it is unlicensed. Please 
the Licensing chapter on how to license 

WebServer. 

To licence and configure WebServer, you must login as using the ADMIN 
user. 

Library Drives 
The first time you load WebServer, no libraries will be displayed in the Open 
Library list box. This is because WebServer does not yet know where to look 
for the ScanFile libraries. To configure WebServer, press the Settings 
button. The different settings are described below. 

Settings 
other 

users are only able to set their language and JPEG quality threshold, along 
with a download password. 

Only Administrator users will get this Settings screen displayed. All 
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The WebServer application can search up to 8 drives for ScanFile libraries. 
 Library Drives section of the Settings screen. 
respond to the drives the WebServer is able to 

manage. 

 separate server and no drive mappings exist, the 
Universal Naming Convention (UNC) can be used. The format for this is: 

Library Drives also includes other 

These can be specified in the
The drive references must cor

If the libraries are held on a

\\<servername>\<sharename> 

The Settings page used to configure the 
settings, which are described below: 
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Option Description 

JPEG Quality This is a user specific setting that determines the quality 
of JPEG images that WebServer will display. The lower 
the setting, the lower the quality of the displayed image. 
This can be useful for viewing large JPEG’s over a slow 
modem link. 

Language This is another user specific setting, which allows you to 
select the language that the page text will be displayed 
in. The available languages are English, German, French 
and Japanese. Please note that you will have to be 
running a Japanese version of Windows to view 
Japanese text correctly. 

LuraDocument The LuraDocument settings allow you to specify how 
documents saved in the LuraDocument format are 
displayed and downloaded. To display Lura format 
documents in Lura format, you will need the Browser 

g-in loaded. This is available for download from 
w.scanfile.com, on the Updates page. Alternatively, 

plu
ww
you can select to have them converted to GIF/JPEG form 
before display or downloaded, in which case, your 
standard browser will be able to display the documents. 

Session Timeout This allows you to specify the period of inactivity after 
which a user will be required to log in again. This also 
frees the user license. 

Logout Page You can set a URL that WebServer will go to when a 
user logs out of ScanFile. You must specify a page 
location. 

 

Image Cache 

 
nt drive 

and directory by typing the location into the Cache path   

Each time a user views a document using ScanFile WebServer, a copy of 
that document is made in the Image Cache. This can significantly enhance 
document retrieval times. 

The location of the image cache will, by default, be set as a subdirectory off
the WebServer program directory. You can however choose a differe

 setting box.
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The Cache URL is the name of the directory you have selected to set for the 
cache, following by a forward slash. 

The maximum size that the image cache will be allowed to reach can be 
dictated by entering a value in Megabytes into the Cache Size settings box.  

ache reaches its predefined size, it will make room for new When the C
documents by deleting documents held in the cache. You can choose the 
criteria by which the documents to be deleted are selected. The Delete Mode 
has two options: 

Option Description 

Least Accessed 
Out removed from the cache 

The documents that have been accessed least will be 

Oldest Out The documents that have not been accessed for the 
longest period will be removed from the cache 
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E
cached, a record of the retrieval is also written into a log file, called 
CACHE.MDB

ach time a user retrieves a page of a document, not only is the page 

, which will be in the IMGCACHE directory of the selected 
Image Cache location. The time that a retrieval record is kept can be set by 

Hold log data (days) field. 
t value is 90 days. 

Opening WebServer 

typing in the number of days it is to be kept in the 
The defaul

If you wish to remove all cached documents, selecting Purge cache images 
now and pressing the OK button will do this. 

To access WebServer, the address of the WebServer site needs to be 
entered in the browser software, which will then display the WebServer login 
page. 

 

Enter a valid ScanFile user name and password and then press the Login 
button. If the details are correct, the Open Library page will then be 
displayed. 
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Open Library Page 

highlighting the Library name in the list, which only shows the 
ScanFile user is allowed access to. 

From the Open Library Page, you can select the ScanFile Library you wish to 
open by 
Libraries that the 

 

You can also choose to set your user preferences by clicking on the Settings 
button, which will then display the Settings page. 

Settings 
The screenshot below shows the setting page with the options a normal user. 
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Option Description 

JPEG Quality The JPEG Quality setting will affect the time taken to 
view colour images, and can be set from 1 to 100 with 
100 being the best quality. 
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Language This is another user specific setting, which allows you 
to select the language that the page text will be 

will have to be running a Japanese version of Windows 
to view Japanese text correctly. 

displayed in. The available languages are English, 
German, French and Japanese. Please note that you 

LuraDocument The LuraDocument settings allow you to specify how 
documents saved in the LuraDocument format are 
displayed and downloaded. To display Lura format 
documents in Lura format, you will need the Browser 

g-in loaded. This is available for download from 
es page. Alternatively, 

m before display or downloaded, in which case, your 
standard browser will be able to display the documents.

plu
www.scanfile.com, on the Updat
you can select to have them converted to GIF/JPEG 
for

 

L
en a Library, the Library Search page will open. This allows you 
earch criteria for the documents you wish to retrieve. The fields 

associated with the library will be displayed as well as the keyword list, if any. 

 
matching documents. 

ibrary Search 
When you op
to enter the s

The list of folders imported into the library will also be displayed. 

Wildcard and range searches can be performed, and you can also choose to 
search across all folders in the library, or just a specific folder. Multiple 
keyword selections are also supported. When you have entered your search 
criteria, click on the Search button, which will then produce a Hitlist of
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The Clear Fields button will clear any search information previously entered. 
You can return to the Open Library page by press the Library button, or 
logout by pressing the Logout button. 

OCR Search 
You can also perform full text searches on the library, if full text OCR 
recognition has been performed on the folders within the library. Clicking on 
the Full text search/Index search button at the top of the Search page will 
display the search page. 

You can search on multiple words, or a phrase, and this can be an AND or 
an OR search. 

Search Results Page 
The results of a search will be displayed on the Hitlist page, with up to 13 hits 
displayed on a page. For a standard search, each hit will refer to a complete 
document whereas for a full text search, each hit refers to a page within a 
document, so there may be several hits that reference the same document. 
The Hitlist can be sorted by any of the fields, by clicking on the Field name at 
the top of the Hitlist. 
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If more than 13 hits are found, you can page though the hits by using the 
navigation buttons at the bottom of the Hitlist. 

 

FastPics 
By default, the Search results page will display thumbnail representations of 
the pages of a record at the bottom of the page. You can choose whether 
these are displayed or not by pressing the FastPics on/off button at the top 
of the page. If there are more pages in the document that can be displayed in 
the FastPics frame, a scrollbar will appear on the right of the frame. 

Memos 
If a document has had a memo attached to it from within ScanFile, this will be 
indicated in the memo column by a tick. Clicking on the tick will then show 
the contents of the memo. You can return to the Search Results page by 
pressing the Back button. 

Download 
Clicking on the Disk icon at the end of each record, will allow you to 
download the document to your PC. As complete documents can consist of a 
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mix of file types, such as
etc, these will be bundled 

 scanned images, MS Word and Excel documents 
together within a ZIP file. 

Viewing Documents 
When you select a document for viewing, the first page of the document 
selected will be displayed, or the page selected from the FastPics or Full text 
search. 

 

Seite 342 • ScanFile WebServer 



ScanFile Benutzerhandbuch 
Open Library Page 

How a document is viewed will be dependent upon the type of document 
being viewed, and which browser software you are using. All black & white 
and scanned documents can be viewed directly within the Document View 
page.  

Electronic format documents such as MS Word & Excel documents require 
that the source application be present. Applications such as Microsoft Word 
and Excel can be opened within Internet Explorer, and therefore these format 
documents will be viewed with the Document View page. For Netscape, 
these applications will be opened independently of the browser. 

Document Viewing Tools 
On the left of the Document View page are a number of tools that allow you 
to alter how a document is viewed, and to select the document, or page of a 
document to be viewed. 

Rotate Page 180° Rotate Page 270° 

 View Previous Page 

age Go to Last Page 

Rotate Page 0° Rotate Page 90° 

Enlarge Page Size Reduce Page Size 

View Next Page

Go to 1st P

Go to Previous 
Document on the 

Hitlist  

Go to Next Document 
on the Hitlist 

In addition to the tools above, you can select the page number to view and 
the zoom level using the options at the top of the Document View Page. You 
can choose which page to view, and its zoom level by typing the page 
number and clicking on the Show button. The zoom level can be selected 
from the drop down list. 

 

The Download button will download, in ZIP format the currently displayed 
page. 
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You can return to the Hitlist or the S
button on the left of the Document V

earch pages by pressing the appropriate 
iew page, or you can Logout by pressing 

Logout. 
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Introduction 
ScanFile RemoteStation is a client-server application that allows you to store 
documents to a central ScanFile store from any location. Using TCP/IP 
connectivity, combined with ScanFile security, client workstations can send 
documents to the RemoteStation Server, which will then store them to the 
selected ScanFile document folders. In addition, the RemoteStation Client 
can be used for retrieval from your ScanFile document store. RemoteStation 
is an ideal application for centralised scanning workstations and to allow 
remote offices access to your ScanFile document store. 

An advanced function of RemoteStation Server is it's ability to act as a 
master server, allowing users to store documents to slave RemoteStation 
Servers, therefore allowing a central user access point for storing documents, 
which can then be distributed to ScanFile document stores located 
elsewhere. 

RemoteStation features include the scheduled sending of documents to the 
RemoteStation server, support for TWAIN scanning devices and the sending 
of electronic format documents, and when scanning, to select between single 
and multi page file scanning. 

This chapter explains how RemoteStation Server is installed and configured, 
and also covers the installation and configuration of the RemoteStation 
Client. 

Key Features 
The Key Features are: 

• TCP/IP based Client/Server architecture 
• Scan or Send Documents directly to: 

Remote ScanFile Document Stores 
ScanFile registered users 
Email 
Networked Printers 
Local printers 

• Support for the following Canon scanners: 
DR-3020 DR-3060 
DR-3080c DR-5020 
DR-5080c DR-5060F 
MS300 MS350 
MS400 MS500 
MS800 
TWAIN Devices 
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• Comprehensive Security 
Logon by username/password 
Full Audit log of all activity 
Encrypted document transmission 
IP Range Restrictions 

Requirements 
RemoteStation Server and Client are 32bit applications that have been 
designed to use a minimum amount of server/workstation and network 
resource.  Special attention should be paid to ensuring that the specification 
of any Client workstation is sufficient to meet the requirements of any 
attached scanner, and the types of documents being scanned and/or viewed. 
Further details on these are given below. 

RemoteStation Server 
RemoteStation Server must be installed on a Microsoft Windows 2000 or 
2003 Server with TCP/IP protocol loaded. Please ensure that the latest 
service packs for the operating system have been applied.  RemoteStation 
Server will require access to the ScanFile program directory and to the 
location of your ScanFile folders. 

Clients 
The specification of RemoteStation Client workstations is very important, and 
if incorrectly configured can affect the scanning and retrieval performance. 
The specification is dependent upon which operating system you run, what 
other applications you may be running and which scanners you may have 
attached to the workstation and what type of scanning you are performing. 
Much of this will also apply to workstations that are only used for retrieval 
purposes. 

If colour scanning and viewing is a requirement, you must also ensure that 
the graphics adaptor and monitor are suitable for viewing the documents, and 
that the workstation has sufficient RAM to allow for data to be processed. If 
there is insufficient RAM in the workstation, the operating system will use the 
hard disk as virtual memory. This however will dramatically affect the 
performance of the workstation. 
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The minimum recommended specification for a workstation is as follows: 

• Personal computer using a 400Mhz Pentium II Processor 
• 128MB RAM 
• 17” Display 
• CD-ROM Drive 
• 4GB Hard Disk Drive. 
• MS Windows 2000 Professional 

Before Installing 
RemoteStation server consists of a server service that utilises the local 
system account to access its resources. If the server running RemoteStation 
Server is not the same as that running ScanFile or where the folders/libraries 
reside, you must create a new user specifically for use with RemoteStation. 
This is also necessary if you intend to use the Printing option which allows 
Clients to scan & print documents to printers that the RemoteStation server 
has permissions for. 

Permissions 
The user you create must have Logon Locally rights and have permissions to 
the following locations: 

• ScanFile RemoteStation Server directory and subdirectories 
• ScanFile program directory 
• ScanFile folders drivea(s)/directories 
• Printers 
 
The type of permissions you can apply will be dependant upon the location of 
the programs and data, and what format of partition they reside on. You 
should create the user account and permissions for the ScanFile program 
directory and data locations prior to installing RemoteStation. After 
RemoteStation has been installed, the user account can be applied to the 
service and the RemoteStation server program directory. 

Server Installation 
To install RemoteStation Server, select Run… from the Start Menu and then 
choose SetupSRSServer.exe from the Software directory on the ScanFile 
CD. Press the OK button. 

The first step is to choose the language and press OK. 
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ScanFile Location 
RemoteStation server must have access to a Licensed installed copy of 
ScanFile. It needs this to enable it to use the User security information when 
users access folders using the RemoteStation Client. Select the ScanFile 
program directory and then press the Next button. 

The ScanFile path can also be entered as a UNC path 
Example: H\\<machinename>\path H. 

Location 
After you have chosen the language, you will be asked to choose the drive 
and directory than the RemoteStation Server software will be installed into. A 
default of C:\ScanFile\SRS will be offered, however, this assumes that 
RemoteStation is not being installed on the same server as ScanFile. Please 
ensure that RemoteStation is not installed as a sub directory of the ScanFile 
program directory, as no users require direct access to the RemoteStation 
directory. Once you have chosen the drive and directory, press the Next 
button. 

Backup 
You will then be asked whether the install program should backup any files 
that the installation process will replace. These can be older versions of 
RemoteStation components - if you are installing over an existing installation 
- and common Windows components held in the Windows or 
Windows/System directories. If you choose to backup these components, 
you will be offered a default location of <Installation path>\Backup. 

Please note that the installation process will only replace older versions of 
common Windows components.  

RemoteStation Server is now ready to be installed. After this has completed, 
the application must be configured. At the completion of the installation you 
will be asked to reboot the server. 

RemoteStation Service 
When RemoteStation Server is installed, the ScanFile RemoteStation service 
will be added to the list of server services. By default, this will be configured 
to use the local system account for its permissions. However, if the ScanFile 
and/or the ScanFile folders it requires access to are on a different server, the 
use of the local system account will be inapplicable. The RemoteStation 
service will require full access to the ScanFile program directory and to the 
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ScanFile folders to be used with RemoteStation. Please see the Before 
installing section above. For information about creating a user account for the 
service to utilise. 

Server Configuration 
When RemoteStation server is first started, it will report that it is not licensed. 
Please see the RemoteStation section of the Licensing chapter in the manual 
for instructions on RemoteStation licensing. 

RemoteStation Server is in two parts; the RemoteStation Service, which will 
be automatically loaded, and the RemoteStation Server application, which is 
used to configure the RemoteStation Service and can also be used to 
monitor the service activity. Once the RemoteStation service has been 
configured the server application need not be running for the RemoteStation 
server to be active. 

When starting the RemoteStation Server application a screen with 5 tabs will 
be displayed. To configure the server service select the Configuration tab. 

Identification 
This section is used to set the IP address and the Port to be used by 
RemoteStation Server. The server Computer name will be automatically 
shown, and the IP can be selected by choosing from the available server IP 
addresses shown in the drop down list. The default Port is 2042, but this can 
be changed if required. If the IP address is changed from the default value, 
the RemoteStation server service will have to be stopped and restarted. 

Pressing the Advanced… button allows you to enter some descriptive 
information concerning the RemoteStation Server.  

The Description entered will be the one used by all RemoteStation Clients 
connecting to this server to identify the server. 

Contact details for the support of the server, consisting of Telephone and 
Fax numbers, and an email address can also be entered. 

Local Settings 
RemoteStation Server holds a log of transmissions from clients, and the 
Days field under Hold Transmission log determines the period that this log 
can be held for. If a client fails to complete a transmission to the server, 
details of this are held within the log. You can select whether this information 
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is kept, even though the transmission log is cleared by selecting the 
Preserved Failed Transmissions option. 

Pressing the Advanced… button will open a settings screen, from which you 
can set the location of the ScanFile folders and configure SMTP mail 
settings.  

RemoteStation Server needs to know the location of the ScanFile folders to 
be made accessible to RemoteStation Clients.  The entries can refer to local 
drive paths or to UNC paths. Pressing the Add button will allow you to enter 
the appropriate path. Please note that the network user account used by the 
RemoteStation service (default: local system account) must have 
permissions to the drives and or UNC locations. 

The location of the ScanFile 2003 program directory is shown in the 
ScanFile Path field, and can be amended if required. 

The SMTP settings of your mail server can be entered to enable 
RemoteStation Client users to email non-ScanFile users. You will need to 
enter the Domain name, Host name and the Port (default: 25). 

Server List 
RemoteStation servers can be linked to one another, allowing users to store 
and retrieve documents from more than one ScanFile document store. When 
a user logs on to a RemoteStation server, the server will attempt to validate 
the user name and password using the local security database. If the user 
name is not found locally, the server will then attempt to validate the user 
name on one of the additional servers defined within the server list. If it is 
successful, then the permissions that have been assigned to the user on that 
server will be applied. 

For each additional server, a user name and password must be created on 
that server to be used as the Share user, which enables users who are not 
registered on that server to store and retrieve documents from the server 
depending upon the permissions assigned to the share user. 

To create an additional server, press the Server list button and then select 
Add. You can then assign the additional server a Description, which is used 
to identify the server to users. 

You must then enter the IP Address and Port being used by the additional 
RemoteStation server, as well as the name of the Share User of that server 
and the share users Password. 

Additionally, contact details for that server may be added, which consist of 
Telephone number, Fax number and Email address. 
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The additional RemoteStation server's details can be edited by choosing the 
Edit option on the Server list, or deleted by choosing the Remove option. 

Security 
Specific IP Addresses or IP ranges can be added to the Security option to 
either allow or not allow them access to the RemoteStation server. Each time 
a RemoteStation Client attempts to connect to a RemoteStation server, the 
IP address of the Client will be checked against the entries in this list. 

You can select whether the IP addresses added to the list will be Granted 
access or Denied access, by choosing the appropriate option. 

To add an IP address to the list, select the Add option, and then enter a valid 
IP address and subnet mask. 

The entries in the list can be edited by selecting the Edit option, and 
removed using the Remove option. 

Connections 
The list of users currently logged on to the RemoteStation server can be 
monitored using the Connections option. Additionally, a Session Timeout 
period can be set (default: 20 minutes) which will automatically log out users 
which have been inactive for the timeout period, and therefore freeing up a 
license for other users. 

Events 
The Events display will list all activity that occurs on the RemoteStation 
server, such as connection requests, searches, and document transmissions. 
The number of Events that the list will hold at any one time can be selected 
by entering a number between 1 and 999999 into the Events to hold field. 
The Events display will also show the number of concurrent licences the 
server is licensed for and the number currently being used. 

RemoteStation Client 
The RemoteStation Client allows users to connect to RemoteStation servers 
and retrieve and store documents to those servers.  

To install RemoteStation Client, select Run… from the Start Menu and then 
choose SetupSRSClient.EXE from the SOFTWARE directory on the 
ScanFile CD. Press the OK button. 



ScanFile Benutzerhandbuch 
Client Configuration 

ScanFile RemoteStation • Seite 353 

The first step is to choose the language and press OK. 

Location 
After you have chosen the language, you will be asked to choose the drive 
and directory than the RemoteStation Client software will be installed into. A 
default of C:\Program Files\SrsClient will be offered and this should normally 
be accepted. However, if you wish to install it on a different drive and 
directory, then you can browse or type in the required path. 

The Destination directory selection dialogue will also display the available 
disk space on the chosen drive, as well as the space available after 
RemoteStation has been installed. Once you have chosen the drive and 
directory, press the Next button. 

Backup 
You will then be asked whether the install program should backup any files 
that the installation process will replace. These can be older versions of 
RemoteStation components - if you are installing over an existing installation 
- and common Windows components held in the Windows or 
Windows/System32 directories. If you choose to backup these components, 
you will be offered a default location of <Installation path>\Backup. 

Please note that the installation process will only replace OLDER versions 
of common Windows components.  

RemoteStation Client is now ready to be installed. After this has completed, 
the application must be configured. At the completion of the installation you 
may be asked to reboot the workstation. 

Client Configuration 
Selecting the option created in the ScanFile program group can start the 
RemoteStation Client. When the Client is started for the first time you will be 
asked to enter a password to be used to access the configuration options. 
Once you have entered this password, the Configuration screen will be 
shown 

Whenever you wish to configure the client, you can access the configuration 
screen by just entering the password you created above into the password 
field on the Client Login screen, without entering a user name. If the correct 
configuration password is entered, the configuration screen will be displayed. 
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Local Station settings 
The Client configuration will automatically detect the workstation Computer 
name and it's IP address and subnet mask. The subnet mask can be 
amended if required. 

Server Settings 
To enable the client to access a RemoteStation server it needs to know the 
computer name or IP address of the server. For private networks, either 
setting may be used, but for connections via the Internet, the IP address of 
the RemoteStation server must be entered. 

The Port the RemoteStation server uses must also be set. This will default to 
Port 2042. 

Once you have entered the server details, press the Tick icon at the bottom 
of the window, and the RemoteStation Client configuration is complete. 

Starting RemoteStation 
To start RemoteStation, select the RemoteStation Client from the ScanFile 
program group. You will then be required to login using a valid ScanFile user 
name and password. Once logged in the main RemoteStation menu will be 
displayed, showing 3 options: 

• View Protocol 
• Search 
• Scan/Send 

Keyboard 
If the RemoteStation does not have a keyboard attached, and is using a 
touch screen, a screen based keyboard can be used anywhere within 
RemoteStation by pressing the Keyboard picture at the bottom left of the 
RemoteStation screen. 

Tools 
RemoteStation uses standard icons throughout to navigate through the 
application. The main tools are described below. 
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Tool Beschreibung Tool Beschreibung 

 
Logout 

 
Search 

 Previous screen  Next screen 

 
Single Page Scan 

 
Mutli Page Scan 

 
Server or Workstation 

 
Internet Email 

 
Scan Document  

 
Select Document Source 

 
Send Document to 
Queue   

 

View Protocol 
This option can be used to monitor the status of scanning jobs waiting to be 
sent to a server, and also the history of specific types of jobs sent to the 
server. 

The time taken for scanning jobs to be sent to the server can be affected by 
several factors, the main one being the speed of the connection between the 
client and the server. 

Local Sending State 
This will show any documents queued locally that are waiting to be sent to 
the RemoteStation server. 

Serverside 
This option will show the job history for a user on a RemoteStation. All the 
jobs sent by a user to the Server can be listed. If there is more than one 
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RemoteStation server available to a user, you must first select the server you 
want to view the history on. You can then select the user. 

On the Settings screen, you can select to view the history for each of the four 
Send option: 

• Folder 
• User 
• Email 
• Printer 
Select one of these, and optionally add a single date or date range and then 
press the Forward button, and the send history will then be displayed. 

Search 
The Search option from the main RemoteStation menu will display the list of 
folders that the currently logged in user has rights to access. 

If there is more than one RemoteStation Server registered, then you will need 
to select the server that holds the folder you wish to search first. 

Search Screen 
Selecting the folder will display the Folder Search screen that will show the 
folder fields. Searching within RemoteStation gives the option to perform 
range searches within the selected folder, the first value being entered in the 
first field alongside a field name, and the second value in to the second field 
alongside the field name. 

You can also choose whether the search is to be an AND search or an OR 
search.. The AND search will result in producing a list of documents that 
match the search criteria entered into ALL fields. The OR search will list 
those documents that match the criteria entered into ANY of the folder fields. 

Once the search criteria has been entered, pressing the Search button will 
show the list of matching documents. 

Hitlist 
The Hitlist will show all documents that matched the search criteria entered. 
Each documents complete index information will be shown within its own 
separate 'box'. To view a specific document, click on the box. If a document 
has more than one page, FastPics of the pages will be displayed, but if the 
document only has one page, it will be immediately displayed. 
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You can return to the Search screen by clicking on the Back button. 

FastPics 
The FastPics display allows you to view in thumbnail format all the pages of 
the selected document, and then to select the page to view by clicking on the 
thumbnail. 

Viewing a Page 
The image viewing page can display one page of a document at a time. The 
page can be zoomed up or down, rotated or made to fit the display window. 

Scan/Send 
The Scan/Send option allows you to scan documents and then send them to 
one of four destinations: 

• Printer 
• Folder 
• User 
• Email 

Printer 
This option enables you to scan documents and have them sent to a local 
printer or a printer that the RemoteStation server has access to. The 
available server printers will be dictated by the configuration of the 
RemoteStation server. 

Printer List 

When selecting the Printer option, you must first select the location of the 
printer. This can be on the local workstation or on a RemoteStation server. 
Once selected, the available printers will be shown. If there is only one printer 
configured on the selected location, the Printer List will be skipped. 

Document Header 

After selecting the printer, you will be able to create a print header sheet onto 
which you can enter the following information: 

• Recipient 
• Originator 



ScanFile Benutzerhandbuch 
Scan/Send 

Seite 358 • ScanFile RemoteStation 

• Message 
 
Once this information has been added, press the Scan button to open the 
Scan screen 

Folder 
The Folder option allows you to scan documents to ScanFile folders that the 
currently logged in user has permissions to. If there is more than one 
RemoteStation Server registered, then you will need to select the server that 
holds the folder you wish to scan to first If the logged in user only has access 
to one folder on the server, a folder list will not be displayed. 

Folder Fields 

Once the folder has been selected, press the forward button to show the 
Folder fields, If the user only has access to one folder, the fields will be 
displayed automatically, without having to select the folder. 

From this screen you can enter the index information related to the document 
you wish to scan. You can also select the date and time that the document 
will be scheduled for sending to the RemoteStation server. This can be set at 
the bottom of the Folder fields display. Once this has been done, press the 
appropriate Scan button to open the Scan screen. 

You can select to scan single or multi-page documents. Selecting the Single 
page option will create a folder record for each page scanned. Selecting the 
Multi-page option will create a single folder record for all scanned pages. 

User 
This option allows you to send a scanned document to a registered ScanFile 
user. The documents will be sent to a users personal hitlist so that they can 
be accessed from within ScanFile. If there is more than one RemoteStation 
Server registered, then you will need to select the server that the user is 
registered on first  The list of users on the server will be displayed, and you 
can select one or more users to send the document to. Once you have 
selected the users, press the Forward button to show the index screen. 

Index Screen 

As the index data is not related to any ScanFile folder, the field names will be 
called Field 01 to Field 10.Any information entered will be shown in the users 
Personal Hitlist. Press the Forward button to open the Scan screen once you 
have entered the index information. 
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Email 
The Email option will send the scanned document to an internet email 
address. 

ScanFile Users 

When a user is created in ScanFile, an email address can be entered as part 
of the user information. This gives the option to send a document to a 
registered ScanFile users email address rather than to that users ScanFile 
Personal Hitlist. 

If there is more than one RemoteStation Server available, then you will need 
to select the server that the user is registered on first  The list of users on the 
server will be displayed, and you can select one or more users to send the 
document to. Once you have selected the users, press the Forward button to 
show the Email message screen. 

Internet Email 

This option will display the Email message screen, which will allow you to 
send a document to any valid internet email address. 

Email Message Screen 

On this screen, you can enter email addresses to send the document to. If 
you are sending to a ScanFile user, the Email field will be automatically filled. 
You can also select to copy the document to another user by entering the 
email address into the CC field. 

A Subject and email message can be added by typing them into the 
appropriate fields. 

Once you have completed the email message, press the Scan button to open 
the Scan screen. 

Scan Screen 
There are several options that can be set prior to scanning or importing, 
relevant to the type of document being scanned, and the source of the 
documents. Once these options have been selected, press the Scan button 
to scan the documents. 
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Document Source 
If you have a Canon DR range scanner attached to the workstation, this will 
be automatically detected, and you can start scanning immediately. If you 
wish to use a TWAIN device as the scanning source, you must first configure 
this. Pressing the Document Source button allows you to select whether the 
source is a Canon DR scanner, a TWAIN device, or an electronic document 
located on the workstation, such as an MS Word document. 

Canon DR Scanner 

If the selected source is a Canon DR range scanner, this scanner model is 
automatically detected, and the scan options available will be set accordingly. 

TWAIN Source 

When selecting the TWAIN source option, you will then have to select the 
device from the displayed list. You must ensure that the TWAIN driver for the 
device is installed correctly. When this option is used, pressing the Scan 
button in the RemoteStation Scan Screen will display the TWAIN source 
scan settings screen. 

EDOC 

This option allows you to select an electronic document from a storage 
device on the workstation. These can then be added to the current queue to 
be sent to the selected destination. 

Colour 
Three settings are available: 

• Black and White 
• Greyscale 
• Colour 

Resolution 
Three settings are available, and these will be dependant upon the attached 
scanner. The setting are Low, Medium and High resolution, which for the 
Canon DR5020/80c scanners would be 200, 300 and 400dpi. 

Brightness 
The scan brightness can be set from 1 to 255. for greyscale & colour, and 1 
to 7 for black & white 
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Text-Photo 
The Text option should be selected if the scan is black and white and it is not 
important as to the quality of any graphic elements contained on the 
document. 

The Photo option should be used when the documents contain graphic 
elements, such as photographs. This will scan the graphics at a higher 
quality than the Text option. 

Simplex-Duplex 
This option allows you to set whether the documents to be scanned are 
single or double-sided. 

Priority 
The Priority option allows you to set a level between 1 and 3 for a document. 
If many documents are waiting to be sent to the RemoteStation server, the 
documents with the highest priority will be sent first. 

Preview 
Any documents scanned can be previewed on the Scan screen before 
sending them to the RemoteStation server. They will be shown on the left 
side of the screen, and display tools are available to allow you to rotate and 
zoom the displayed image. If more than one page has been scanned, you 
can move between the pages by using the Up and Down arrows under the 
Documents option. The X under documents will delete the displayed page.  

Send Document 
Once you are happy with the scanned document, press the Send button, 
which will queue the document locally before sending it to the RemoteStation 
Server. Whilst sending, if the connection between the client and the server is 
broken, once it is re-established the document will once again be sent. The 
documents are queued locally until a successful transmission message is 
received from the server. 
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Scheduled Sending 
When scanning or importing documents to a ScanFile folder, you can select 
the date and time that the documents are to be sent to the RemoteStation 
server for adding to the folder. 

At the bottom of the Folder indexing screen, the current date and time will be 
displayed. You can amend this to the date and/or time that you wish the 
documents to be sent. Once you have completed the scanning and/or 
importing of documents, they are held in a queue locally until the scheduled 
date and time is reached, when the RemoteStation Client will attempt to send 
them to the server. 

You do not have to be logged into the RemoteStation Client for the 
documents to be sent, but the RemoteStation Client must be open. 
Additionally, if you are using a Dial Up connection to the RemoteStation 
server, this must be connected prior to the Client sending. 
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ScanFile Connector for 
ShareScan 
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Introduction 
With the ScanFile Connector for ShareScan, any eCopy enabled device can 
be used to scan and send documents to ScanFile Folders. Using TCP/IP 
connectivity, combined with ScanFile security, ScanStation can send 
documents to the RemoteStation server, which will then store them to the 
selected ScanFile document folders. RemoteStation Server with the ScanFile 
Connector for ShareScan is an ideal application for centralised scanning 
stations and to allow remote offices access to your ScanFile document store. 

An advanced function of RemoteStation Server is it's ability to act as a 
master server, allowing users to store documents to slave RemoteStation 
Servers, therefore allowing a central user access point for storing documents, 
which can then be distributed to ScanFile document stores located 
elsewhere. 

Please refer to the previous chapter on RemoteStation for instructions on 
how to install and configure the RemoteStation Server. 

Installing the Connector 
The ScanFile Connector for ShareScan is an add-on to the main eCopy 
ScanStation application. This must be installed and running correctly prior to 
the installation of the ScanFile Connector. 

To install the Connector on the ScanStation, select Run from the Start menu, 
and select setupScanFileConnector.exe from the Software directory on the 
ScanFile program CD. If the ScanStation does not have a CD drive, the 
installation program  can be copied to a network location and run from there. 

You will be asked to select the language and the installation location for the 
Connector, and then the program files will be installed. 

Once installed, the Connector can be configured. 

Connector Configuration 
Before the ScanFile Connector can be used, it must be configured by using 
the eCopy Administration application. For ShareScan, this can be accessed 
by running the ShareScan Administration program from the eCopy 
Applications program group. 
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In the Categories list select the Scan to ScanFile category, and the 
Connector Preferences will be shown. 

IP & Port 
The IP address and Port settings should be set to those that the 
RemoteStation server has been configured to use. If these are not set 
correctly, the Connector will not be able to communicate with the 
RemoteStation server. 

Login 
The Connector requires a valid ScanFile user name and password to be able 
to login to the RemoteStation server. The users must have permission for 
RemoteStation and the ScanFile Folders that documents will be saved to 

If the Automatic Login feature is not enabled, each user of the Connector will 
have to enter a user name and password each time they use the Connector 

With Automatic Login enabled, users of the ScanFile connector will not have 
to login. You can enter a user name and password that will be used by all 
users of the Connector, which will have been set with permissions for 
RemoteStation and ScanFile Folders. 
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Enable Scan to ScanFile 
The ScanFile Connector can be enabled or disabled with this option. If the 
Connector is enabled, the Send to ScanFile button will be available on the 
ScanStation. If disabled, the button will not be shown. 

Using the Connector 
On the ScanStation main screen, select the Scan to ScanFile button, after 
placing the document in the scanner feeder. 

 

Preview Screen 
Once the document has been scanned, the preview screen is displayed, 
where you can review the scanned pages, scan more pages, delete the 
document or select to Send to document to ScanFile. 
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Login 
If the Automatic Login feature is disabled, each user will have to login using a 
valid ScanFile user name and password. If the ScanStation being used only 
has a touch screen, a screen based keyboard is available. Pressing the ESC 
key will close the keyboard 

 

Destination 
You can select to send the scanned document to either a ScanFile user or a 
ScanFile folder. When you select to send to a ScanFile Folder, the following 
screen will be displayed, which allows you to select the folder you want to 
send to document to. 
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Index and Send 
Once you have selected the ScanFile Folder, the index fields for that Folder 
will be displayed, allowing you to type in the document details prior to 
sending. If the ScanStation being used only has a touch screen, a screen 
based keyboard is available  

 

Once you have entered the index information, the document can be sent to 
ScanFile by pressing the Send button, and the Connector will then close. 
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